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Introduction BimQS

PROFESSIONAL

Overview

PointOS Professional is a Point Of Sale (POS) software specifically designed to give any size bar,
club, or restaurant al of the toolsit needs in a bar POS or restaurant POS at an affordable price.
With integrated credit cards, inventory tracking, customer tracking, full reporting, and an easy-to-
use interface, PointOS is atouchscreen POS that will save you time and money.

Features

Professional Main Features

* Runson Windows XP or Vista
* Touch Screen Operated

e EasytolLearnand Use

» Food/Liquor Inventory Control
* Free Tech Support

Works With QuickBooks®

Point Of Sale Features

» Simple Order Entry Screens

* Délivery with Cdler ID

* Integrated Credit Cards

* Gift Cards and Personal Checks

* Multiple Servers on One Station

* Print to Kitchen or Service Bar

*  Order, Transfers, Splits and Combines
* Employee Time Card System

» UPC Bar Code Scanning

» Server Cash Accountability

» Item and Check Discounting

e Automatic Happy Hour Pricing

* Preset, Forced, and Custom Modifiers
» Customer Tabs and Order Tracking
» Server/Cash Drawer Stations

» Employee Email System

* Employee/VIP Discounting

» Categorized Payouts

*  Print Item Recipes from Order Entry
o Cash Drawer Transfers

* Room Setup with Table Layout

* Open and Closing Reports

* Incident Reports

* Manual Customer Info/Email Entry
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Features

Back Office Features

e System Dashboard

* Integrated Online Help

* Auto Archiving And Maintenance
» Customizable Security Settings

» Tax Reporting

» Export Reports To Excel

* Auto Email Reports

*  Online Reporting

» Customer Maintenance

» Credit Card Batch Scheduling

» Employee/Entertainment Scheduling
» Payroll Reports

* Inventory Shopping List

* Par Inventory Recommendations
» Send Customer Newsdletter

Integrated Music System

» Touch Screen Music Player

* Request Songs From Any Station

* Windows Media Player Integration
* Multiple Playlists

» Customer Songs Auto Added

* Auto Find Music

* Print Song Lists

Optional 1D Scanning

» Driver’sLicense Scanning For Age Verification
* Customer Song Lists

e  Quick Customer Adding

» Customer Sales Tracking

* AgeAppropriate Order Entry Screen

» Pictures on Customer Tabs

» Customer ProfilessNotes

PointOS Manager Manual
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System Requirements

System Requirements

Minimum Requirements

* Windows XP SP3 or Vista
e 256 MB Ram

Multi-Sation Server Requirements
* Do Not Use XP Home/VistaHome Basic

Recommended Har dwar e (optional)

* Touch Screen Monitor
* Receipt Printer
e MMF Cash Drawer

For Bar Code Scanning (optional)
» Bar Code Reader

For ID Verification (optional)
» Scan Shell (hardware only)

For Credit Cards (optional)

*  Merchant Warehouse Account
* Magnetic Strip Reader

Softwar e (optional)
QuickBooks® (Not QB POS)

Manager Manual Conventions

This manual provides information on using the screensin the Manager Dashboard and Manager

Menus of PointOS Professional.

The conventions include using bold face for interactions with menus or fields on a screen. The

manual also usesitalicsto indicate screen names.
The Manager Manua is organized by menu from the Manager Dashboard.

PointOS Manager Manual
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Getting Started Biniﬁg

PROFESSIONAL

Overview of Installation and New Install Process

After you download the PointOS software, you will install the software. The Installation Process
issimplified by the Install Aware Wizard.

Then, the PointOS software will guide you through the following steps of the new install process:
» Select Database (optionally Create New or Choose one from the server, depending on type of

install)
* Name Station
* Printer Setup

* Main Setup (for server install)
* Create Employees (for server install)

After you have completed these steps, you can begin using PointOS Professional .

NOTE:You can install multiple stations of PointOS. Refer to “ Setting Up Multiple Stations’ on
page 163 for more information.

Installation

When you begin theinstallation process, the system begins the PointOS Professional Install Aware
Wizard. Follow the on screen promptsto install PointOS Professional. As part of the installation,
the system prompts you to select the Setup Type.

=1 Point0S Professional - Installiware Wizand

Setup Type -
Choose the setup type that is best for vour needs. In

PointOS Professional poink of sale software

Every sekup needs one server to run, IF you installing on
yaur server, ot if this is a single computer install, choose
Client &nd Server,

() Client Only If connecting to an external database, choose Client Only,

PointOS Door Manager membership, id scanning, cover charge software

[] Add DoorMan Client Choose if wou are installing Door Manager onto a computer,
Point05 Professional will also be installzd.

Chaoose which program Features wou want installed, (Advanced Users)

O Custom Install scanner drivers here,

[ < Back ” Mext = I [ Cancel l

Figure 1: InstallAware Wizard Setup Type

» For the computer station that will act as your server, select Client and Server.
» For al other stations, select Client Only.

PointOS Manager Manual Getting Started - 4



Select A Database

To install PointOS Door Manager, check the Add Door Man Client box.

Continue to follow the on screen prompts to complete the installation and registration process.

Select A Database

When you start PointOS Professional for the first time on the computer station being used as a
server, the system prompts you to select a database.

Point0OS Professional: Select & Database

oINtOD

PROFESSIONAL

Please Choose Your Database

[ Sample/Testing Database l l Restore Backup Database

‘ Choose Database | l Hew Database

l Quit Program l

PointOS Copyright G2009

Figure 2: Select a Database
Select one of the following options or select Quit Program to close PointOS:

» Sample/Testing Database - a sample database in the Demo version of the software to try out
the software

» Choose Database - to select an existing database from the server

* New Database - to create a new database

Choose Database and New Database are discussed later in this chapter.

You can also select Restore Backup Database. Refer to “ Restore Database” on page 28 for more
information.

NOTE: Restoring the database is intended for emergency recovery of data only.
Select Quit Program to close PointOS.
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Choose Database

Choose Database

When you start a station installed as Client Only for the first time, the system prompts you to
choose a database.

PointOS Professional: Select A Databasel

[Bint)S PROFESSIONAL

Please Choose Your Database

- e

-

Pick Your Server Name

Database Name

/| Set As Default Database

‘ Test Connection |

‘ Quit Program | | Select Database |

Make Sure All Computers Are On The Same Workgroup
And The Administrator User Name And Passwords Are The Same

Point0§ Copyright ©2009

Figure 3: Select A Database - Choose Database

1. First, select the computer used as a server on your network from the Pick Your Server Name
drop down list. If the computer names are not listed, select Refresh.

2. Select the database name from the Database Name drop down list.

NOTE:AIl stations can access the same database.

3. Check the Set as Default Database box to use this database as the default database.

4. Select Test Connection to check the connection to the selected database.

5. Select the Select Database option to continue or select Quit Program to close PointOS.

Troubleshooting
If the computer name does not appear on the list of servers, try the following:

* Reboot al network computers.

* Make sureall computers are on the same workgroup.

»  Setup al the computers with the same login name and password and make sure those accounts
have administrative rights.

* Makesureyou are not running any antivirus programs that would block your computers from
seeing SQL Server on the shared database computer.

PointOS Manager Manual Getting Started + 6



New Database

New Database
1. To start anew database, select New Database from the Salect a Database screen.
The system displays the Choose New Database screen.

Point0S Professional: Choose New Database

[Bint)S PROFESSIONAL

Create A New Database

New Database Name

Launch Keyboard

Quit Program Create New Database

PointOS Copyright ®2009

Figure 4: Choose New Database

2. Enter the New Database Name. To use the touch-screen keyboard, select Launch Keyboard.
3. Select Create New Database or select Quit Program to close PointOS.

The system continues with the new station setup process.
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Name Station

Name Station

When you open PointOS Professional on a station for the first time, the system prompts you to
name the station.

PointOS Professional: Starting Up

IB' ® Please Name This New Station
TIEON

PROFESSIONAL

Q w E R T ¥ u 1 Q H P

A E] 1] F G H J K L Delete
CAPS z = C L B H M Space

This Appears To Be A New Station Install « Done
Please Name This Station In 8 Characters Or Less

Figure 5: Name Sation

1. Enter the name for this station. The station name must be unique on the network, but can be
anything you like. It should be descriptive of where the station islocated, such as Upfront,
Back Bar, or Office. It must be 8 characters or less.

NOTE: The system automatically adds a station number.
2. Select Done.

Printer Setup
After you name the station, the system prompts you to choose your attached receipt printer.

PointOS Professional: Starting Up

oINt

PROFESSIONAL
Please Choose Printer

Installed Printer v

Printer Profile v
v OK

L Printer Has An AutoCutter

Figure 6: Choose Printer
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Main Setup

1. Fromthelnstalled Printer drop down list, select the printer that matches your attached
receipt printer.
NOTE: The printers listed are those setup in Windows Printers. Refer to “ Setting Up a Generic
Driver for Receipt Printing” on page 164 for more information.

2. If your printer isnot on the list, select Generic.

3. If you have no printer attached, select No Printer. You can aways add one later using the
Sation Settings area of the Manager Dashboard.

NOTE:If you choose the incorrect printer driver or generic driver, you maybe unable to pop an
attached cash drawer or cut the paper.

If your printer is not on the list and the generic driver does not work, you can try other
drivers by the same manufacturer or contact us at support@pointos.com and we can help
you find a compatible driver.

4. Select the Printer Profile for the attached printer from the drop down list.
5. Check the Printer Has An AutoCutter box, if applicable.
6. Select OK.

Main Setup
The system displays an alert guiding you to complete the Main Setup next.

This Appears To Be
A New Install

Please Complete Main Setup
And Create An Employee

OK, Lets Start

Figure7: New Install Alert
1. Select OK, Lets Sart.
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Main Setup

The system displays the Main Setup screen.

File Edit Setup Menu-Inventory  Activities  Reports  Sales Reports Maintenance  Help
| Main Setup O |
Change Main Options
Company Information Company Contact Information Menu Page Graphic

Company Name Phone Number
| | No
IStreet Address Eax Number Graphic

| Selected
Address 2
I Email Address
City I Appearance Settings
I Website Menu Page Graphic

Choose
State Zip Code I I
I J I Background Color
Other Settings Receipt Message Il | j

Measurements I
[Standard (USA) =

I Total Stations Licensed
Day Start Time .

y 1 Station

[12:00 P =

| | Upgrade For More Stations |

[~ Enable No ID Prompt
¥ Enabled Void ltem Control I
| Cancel ‘ | Save ‘

Figure 8: Main Setup Screen

Company Information and Company Contact | nformation
1. Enter your Company I nfor mation:

* Company Name
o Sreet Address

e Address?2
* City

e Sate
 Zip Code

2. Enter the Company Contact I nformation:

» Areacode and Phone Number (numbers only)
* Fax Number

» Contact Email Address (optional)

* Website address (optional)
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Main Setup

Other Settings and Receipt M essage
1. From the Other Settings area, select either Standard (USA) or Metric from the
M easurements drop down list.

2. From the Other Settings area, set the Day Sart Time. You should select atime when your
bar, club, or restaurant is not operating to provide a breaking point between operating days.
Refer to “ Setting the Time” on page 165 for more information about using the system clock.

3. Check the Enable No ID Prompt box if desired. Thiswill require an ID scan for orders. If no
ID is scanned, the system displays the No ID Reason screen.

Reason For No ID Check

Over 21 But No ID Scanned

Visually
Seen

Damaged

Bracelet X
License

Over 35

Passport

¢ over21 |

Under 18 i Explained |

Under 21

‘ Cancel ‘

Figure 9: Reason for No ID Check

NOTE: These reasons can be edited in Report Setup. Refer to “ Report Setup” on page 63 for more
information.

4. Check the Enabled Void Item Control box to ask why the item was voided. Thiswill track
whether a voided item was taken out of inventory or not. If you have Enabled Void Item
Control, then when you void an item, the system displays the Item Inventory screen. If you
select No, the order is voided with no affect on inventory. If you select Yes, then theitemis
removed from inventory even though the order was voided.

Point0S: Ttem Inventory

Was ltem Taken Qut
Of Inventory

Yes H No ‘

Figure 10: Item Inventory
5. Enter aReceipt M essage to use as afooter for all printed sales receipts.

PointOS Manager Manual Getting Started - 11



Main Setup

Menu Page Graphic and Appear ance Settings

1. Make sure you have saved your graphic in jpg format with an image size of 740 x 240 in the
Backgrounds folder of your database.

2. Select Choose Graphic from the Appearance Settings area of the Main Setup screen.

The system displays an aert notifying you to make sure your graphic isin the right format and in
the correct location. All graphics must be in the shared (network) PointOS Database folder.

3. Select OK.
The system opens the Choose Main Menu Graphic dialog box, open to the correct location.
4. Choose your graphic and select Open or select Cancel to return to the Main Setup screen.

The system displays the selected graphic in the Menu Page Graphic area of the Main Setup
screen.

5. Select acolor to use on the background of the Menu Page from the Background Color drop
down list.

Total Sations Licensed

The system displays the number of stations you currently have licensed with PointOS.

NOTE: The license is concurrent connections to the database. The software can be installed on as
many computers as you like, but if you try to connect more the system displays the Sa-
tions Manager screen with awarning instructing you to shut down another station. Refer
to “ Stations Manager” on page 151 for more information.

1. Select Upgrade For More Sations.
The system displays the Upgrade screen.

Please Enter Your PointOS Professional
Upgrade Code Below And
Press Enter Upgrade Number

Current License

1 Station
Upgrade Number
Cancel Purchase Enter Upgrade
Upgrade Upgrade Number

Figure 11: Upgrade

2. Either enter your Upgrade Number, select Purchase Upgrade to go to the PointOS website
Purchase page, or select Cancel Upgrade to close the Upgrade screen.

3. After you have entered avalid Upgrade Number, select Enter Upgrade Number.
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Employee Setup

The system displays the new number of stations licensed in the license area.

Save Main Setup

1. Select Saveto save your Main Setup selections, or Cancel to close the Main Setup screen
without saving changes.

The system displays an alert notifying you that Main Setup options have been saved.

Employee Setup
The system displays the Employee Setup screen next.

Point05 Professionak Manager Tools

File Edit Setup  Menu - Inventory  Activities  Reports  Sales Reports  Maintenance  Help
| Employee Setup Q |
Employees Change Options

‘ Add New Employee ‘

‘ Point0§ Administrator

Plck Employee

|Select Employee Name -

[~ Show Inactive Employees

All Stations Need To Be Restarted To Activate Employee Changes

Close Employee Setup

Figure 12: Employee Setup

You can add new employees or change the settings for the default employee - PointOS
Administrator. Once you have added other employees, you can also change their settings. For all
three options, you will use the Change Employee Options screen.

1. Select Add New Employee from the Change Options areato open the Change Employee
Options screen to create a new employee in the system. Once you have added employees, they
are listed in the Employees list of the Employee Setup screen.

2. Select PointOS Administrator from the Employees list to open the Change Employee
Options screen for the PointOS Administrator and change the employee settings. Once you
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Employee Setup

have saved the information, the PointOS Administrator is listed by employee name in the

Employees list.

3. Select an employee’s name from the Employees list to open the Change Employee Options
screen for that employee and change the employee settings.

The employees are listed in the Employees list in alphabetical order. Use the Up or Down arrows
to scroll through along list of employees. For a quick method to scroll to the employee, select the
employee's name from the Pick Employee drop down list.

4. Check the Show | nactive Employees box to include inactive employees in the Employees

list.

NOTE: You will have to restart all stations to see changes to the Employees list.

5. Select Close Employee Setup when you have finished.

Change Employee Options

The Change Employee Options screen allows you to add new employees or change information
for employees you have already added to PointOS.

When you select Add New Employee or an employee name, the system displays the Change

Employee Options screen.

Point0S Professionak Manager Tools

Job Title

Hourly Wage

Default Payroll Salary

IND Default Salary Level

[~ Prompt For Salary

=

File Edit Setup Menu - Inventory  Activities Reports  Sales Reports  Maintenance  Help
| Employee Setup O |
Change Employee Options
Employee Information Employee Address Employee Photo

First Name Last Name Street Address

Date Of Birth Apartment Number No Photo

| il Scanned

Social Security Number City

I I Security Settings

Hire Date State Zip Code Security Level Add 1D

| - | Set As Now IChuuse State 7] I |Seu:urity Level x| | card

Termination Date Employee Contact Infomation Access Code  Employee Color
- [ I

| | Home Phone Number I I J

I Set As Customer

Cell Phone Number

Email Address

Select Employee Name

IFincI Employee From Custumersj

v Employee Is Active

| Cancel ‘ ‘Deactnrate| ‘ Save ‘

Figure 13: Change Employee Options
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Employee Setup

. Enter or update the Employee Information:

» Enter the employee's First Name.

» Enter the employee's L ast Name.

» Enter the employee's Date of Birth. You can also use the drop down arrow to select the
date from the calendar.

* Enter the employee'sHire Date. You can also use the drop down arrow to select the date
from the calendar. Select Set as Now to select today’s date.

* When the employee is terminated, enter the employee’s Termination Date. You can also
use the drop down arrow to select the date from the calendar. Select Set as Now to select
today’s date.

* Enter the employee's Job Title.

» Enter the employee’'s Hourly Wage. This information will show up on payroll reports.

* Touseadefault salary level, select the Default Payroll Salary drop down arrow. These
items are set up on the Payroll Setup screen. Refer to “Payroll Setup” on page 62 for more
information.

» Check the Prompt for Salary box to enable multiple job descriptions and hourly rates for
this employee. When the employee clocksin, he or she will need to select the appropriate
job description, as defined in the Payroll Setup screen.

. Enter or update the Employee Address.

Enter the employee’s Street Address.

Enter the employee’s Apartment.

Enter the employee’s City.

Select the employee’s State from the drop down list.
Enter the employee's Zip Code.

. Enter the Employee Contact Information:

* Enter the employee’'s Home Phone Number.

» Enter the employee's Cell Phone Number.

» Enter the employee’s Email Address. If the employee has an email address, he or she can
receive messages from the Message Center.

. The Employee Photo displays a photo scanned for this employee, if applicable. You must
first entered the employee as a customer on the front end Order Entry - Sart New Tab - New
Customer screen and scanned his or her picture.

. Select the employee's security level from the Security L evel drop down list. The security
level allows or prevents the employee from entering certain areas of the system, as defined in
the Security Setup options. Refer to “ Security Settings’ on page 71 for more information.

. Toscan anew ID card for the employee, select Add ID Card.

* The system displays the Add Employee ID Card screen.
* Swipethe card in the card reader or select Do Not Swipe ID Card to close the Add
Employee ID Card screen.

. Enter the employee's Access Code. The access code is afour-digit number, usually the last
four digits of the employee's social security number. This number must be unique for use on
the system. If the employee’s email address is on the system, and you have set up email, the
system will email the employee his or her access code.
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Register PointOS

8. Select an Employee Color from the drop down list. This color will surround all that
employee’'s tabs on the Open Tabs screen to allow quick identification of the correct orders.

9. By default, the Employee is Active box is checked. Uncheck the Employee is Active box to
deactivate the employee, or select Deactivate. If you are updating an inactive employee,
check the Employee is Active box to re-activate the employee or select Activate.

10. If you have scanned the employee’s ID and entered him or her as a customer first, select the
employee’s name from the Select Employee Name drop down list.

11. Select Save to save the employeeinformation, or select Cancel the Change Employee Options
screen without saving the information.

Register PointOS

When you have finished your trial of the PointOS Professional System, you must enter your serial
number from your purchase to continue using PointOS Professional.

PointOS Professional: Enter Senal Numberl

Please Enter Your Company Name
And Your PointO S Professional
Serial Number Or Choose Trial Mode

Company Name

Enter If You Have Purchased

Serial Number Otherwise Select Trial Mode

Exit
Program

Purchase

Trial Mode Point0S

‘ Launch On-5Screen Keyboard ‘

Figure 14: Enter Serial Number

1. Enter your Company Name. This must be exactly the same as when you downloaded the
software.

2. Enter your Serial Number. Thisis case sensitive.
3. Select Enter Serial Number.

NOTE:If you have not yet purchased PointOS Professional, select Purchase PointOSto go to the
website to complete your purchase.

You can aso select Trial Mode to continue your trial. Trial Mode isafully functional, one
station license good for 30 days. When you decide to purchase PointOS, you will not lose any
datayou set up from the trial mode.

Select Exit Program to close the program.
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Manager Dashboard

RBint)S

PROFESSIONAL

This chapter provides an overview to the activities available on the Manager Dashboard, as well
as a description and introduction to each item. Most activities are described in detail in other

chapters.

Accessing the Manager Dashboard
1. From the PointOS Main screen, select M anager.
The system displays the Enter Manager Code screen.

Enter Manager Code

1 2 3
4 5 6
7 8 9
Delete 0 Cancel
Enter
aire O

Figure 15: Enter Manager Code

2. Swipeyour card or enter the default Manager code and press Enter.

The system displays the Manager Dashboard.
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Overview of the Manager Dashboard

Overview of the Manager Dashboard

The dashboard provides a quick look at what is going on with the system. It also provides fast
access to some of the most commonly used featuresin PointOS Professional. Think of it asthe
manager’s home base for al that’s going on with your bar, club, or restaurant.

File  Edit Setup Menu-Inventory  Activities  Reports  Sales Reports  Maintenance  Help
Manager Dashboard ':J |
Manager Dashboard Station 1 Activities
Recent Reports Current Closed Sales , :
Station Setti
Closi Cash Sales Credit Card Sales ‘ s L ‘
osing
$0.00 s0.00
. Total Orders Total Sales [ Setup Additional Printers ]
Incidents
0 $0.00
[ omeermon
Schedules System Statistics [ Revert Cashier Out ]
Last Music Last Employee Drawers Cashed In Connected Stations
/2812009 12812009 No Open Drawers 1 [ T — ]
Employee Schedule Requests Total Customers Total Songs
1 New Request 3 No Songs
View Musi — Disconnect Refresh [ Credit Card Refund ]
Requests [t Tpayee Stations B
Credit Card Batch Database Sunday
Last Batch Result Current Database Computer Sunday, June 28, 2009
No Batches Not Batched Sample_Company Wichele-Laptop 5:13:16 AM
Messge Last BackUp Database Size
Not Batched 5/24/2009 11:56 AM ZMB
l Select l [Compact — l [ Return To PointOS

Figure 16: Manager Dashboard

The left side of the screen provides a quick view of the following information, with links to
related activities:

* Recent Reports

e Schedules

e Credit Card Batch

e Current Closed Sales
* System Statistics

e Database

Theright side of the screen includes links to additional commonly used features in PointOS
Professional.
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Recent Reports

Recent Reports

Recent reports gives you aquick way to view reports that have been submitted by your bartenders
or servers. Servers can run aclosing report to let you know what has gone on during their shifts.
This report includes information about inventory problems, damage, or other information.

A server can also submit areport to describe an incident. This can include fights or medical
issues. These reports are valuable for documenting issues and may be avital tool if you ever end
up in court.

View Recent Reports- Closing

1. Toview arecent closing report, select the closing report you want to view from the list of
reports on the Manager Dashboard in the Recent Reports area.

2. Select View Report.

The system displays the Closing Reports screen. Refer to the “ Closing Reports’ section on
page 142 for more information.

View Recent Reports- Incident

1. Toview arecent incident report, select the incident report you want to view from the list of
reports on the Manager Dashboard in the Recent Reports area.

2. Select View Report.

The system displays the Incident Reports screen. Refer to the “Incident Reports’ section on
page 144 for more information.

Schedules

PointOS allows the manager to create weekly reports for employee and entertainment scheduling.
Thisareawill remind you if aweekly report has not been made for one of these two areas. This
area also notifies you of any employee schedule requests.

View Schedule Requests

1. To open the Schedule Requests screen, select View Requests from the Schedules area of the
Manager Dashboard.

The system displays the Schedule Requests screen. Refer to the “ View Schedule Requests’
section on page 107 for more information.

View Entertainment Schedule

1. To open the Entertainment Schedule screen, select M usic from the Schedules area of the
Manager Dashboard.

The system displays the Entertainment Schedule screen. Refer to the “ Entertainment Schedule’
section on page 127 for more information.
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Credit Card Batch

View Employee Schedule

1. To open the Employee Schedule screen, select Employee from the Schedules area of the
Manager Dashboard.

The system displays the Employee Schedul e screen. Refer to the “ Employee Schedule” section on
page 106 for more information.

Credit Card Batch

If you are using PointOS for credit card batches, this area displays the results of the last credit
card batch attempt. Additionally you can perform a one click manual batch from this area.

If you are using Merchant Warehouse, this areawill let you know if there are any connection
problems.

Batch Now

1. To open the Batch Credit Cards screen, select Batch Now from the Credit Card Batch area of
the Manager Dashboard.

The system displays the Batch Credit Cards screen. Refer to the “Batch Credit Cards’ section on
page 133 for more information.

Current Closed Sales

This gives you alive snapshot of your current sales for the day, not including open orders or
voids.

1. Torefresh the current closed sales information, select Refresh from the Current Closed Sales
area of the Manager Dashboard.

The system updates the display with the most recent information.

NOTE:Refer to the“Main Setup” section on page 34 for more information on setting the day start
time.

System Statistics
This area shows you several valuable pieces of information about the system:

e Drawerscashed in
e Number of stations connected
* Number of customers

e Number of songsin the system

1. To update the statistics, select Refresh.

Disconnect Sations
This areaallows you to quickly disconnect all stations.
NOTE: You must disconnect al stations before you can compact or backup a database.
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Database

1. Todisconnect all stations, select Disconnect Stations from the System Satistics area of the
Manager Dashboard.

Database

This area gives you information about your database. You can view the database name, size, and
when it was compacted and backed up.

NOTE: We recommend that you backup and compact your database at |east once a week.

Sdlect Database

1. If you need to select a new database (for example, if you have atraining database setup for
new employees), select Select from the Database area of the Manager Dashboard.

The system displays a warning to make sure you want to select a new database.
2. Select Yes.

The system restarts PointOS Professional to alow you to select a new database. Refer to “ Select
A Database” section on page 5 for more information.

Compact Database
If your system is running slow, you can speed it up by compacting the database.

1. To compact the database, select Compact from the Database area of the Manager
Dashboard.

Backup Database

1. To backup the database, select Backup from the Database area of the Manager Dashboard.
Refer to “Backup Database” section on page 153 for more information.

You can also set thisto be done automatically. Refer to “ Database Setup” section on page 40 for
more information.

Station Activities
The Sation Activities area of the Manager Dashboard includes the following activities:

Station Settings

Setup Additional Printers
Delete Pay Out

Revert Cashier Out
Receive Physical Inventory
Credit Card Refund

Return to PointOS
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Sation Settings

The Sation Settings are specific to the current station. You can setup or change the station
printer as well as other settings specific to the current station.

1. Toview or edit the station settings, select Sation Settings to from the Sation Activities area
of the Manager Dashboard.

The system displays the Sation Settings on the right side of the Manager Dashboard.

Station 1 Settings
Station Mame
Station

Installed Printer

HP LaserJet 1020 -
Printer Profile

Epson M188D -
Bar Codes (Compatible Models)

Do Not Print Bar Code -

Receipt Logo
Do Not Print Receipt Logo

4

Printer Has An AutoCutter
Auto Print Timer Print Width
60 40

Test Printer

/| Enable Credit Cards On This Station
No Tabs Screen (Stay In Order Entry)

Multi-5erver Mode (Ho Cash Drawer)

Keyboard ‘Cncel H Save |

Figure 17: Sation Settings

2. Enter the Sation Name. To use the touch-screen keyboard, select Keyboard.
3. Toadd areceipt printer, select the printer from the I nstalled Printer drop down list.

NOTE:If your printer is not on the list, you will need to add the printer in Windows. Refer to
Windows Help for more information on adding a printer. Refer to “ Setting Up a Generic
Driver for Receipt Printing” section on page 164 for more information on adding ageneric

printer.
4. Select the printer name from the Printer Profile drop down list. If your model is not on the
list, either select Generic Printer or aprinter with asimilar make and model number to the one
you have. Newer printers by the same manufacturer often have similar settings.

NOTE: The model isimportant when using a cash drawer or auto cutting. If you select the incor-
rect model, your cash drawer may not open. If you cannot find a printer model that works
for you, try the advanced printer setup or contact us.

5. If you are using bar codes, select the compatible model from the Bar Codes drop down list.
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6. To print the company logo on receipts, select the compatible model from the Receipt L ogo
drop down list.

NOTE:Refer to the documentation that came with your printer for more information about
uploading alogo to your printer.

7. Check the Printer Has An AutoCutter box, if your printer auto cuts the paper after printing.

8. Thedefault Auto Print Timer is 60 seconds. You can changeit if necessary.

9. Thedefault Print Width is40. You can changeit if necessary. You should make it aslarge as
possible without the test <-------- > breaking to anew line.

10. Select Test Printer print atest page using the current printer settings.
11. Check the Enable Credit Cards box to allow credit card sales for this station.

NOTE: Credit cards must be enabled in two places: on the Payment Setup screen, and on EACH
station where credit cards are accepted (some stations may be cash only).
12. Select which mode to use for PointOS.

» Check No Tabs Screen to keep this station in order entry mode. It will not show the Tabs
screen.

» Check the Multi-Server Mode box if there is not a cash drawer attached to this station. This
will alow multiple servers to use the station for entering orders. When using Multi-Server
mode, there is no cash drawer, payouts, or station lock.

13. Select Save to save the station settings or select Cancel to return to the main view of the
Manager Dashboard.
Setup Additional Printers

The Setup Additional Printer s button allows you to setup other printers. Thisis necessary if you
want to send order tickets to a service bar or akitchen.

NOTE: These printers must be defined from each individual station.

1. To set up additional printers, select Setup Additional Printersfrom the Sation Activities
area of the Manager Dashboard.
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The system displays the Additional Printer Settings on the right side of the Manager Dashboard.

Additional Printers Settings

Kitchen Printer 1

-

No Large Font - Enabled

Kitchen Printer 2

-

No Large Font - Enabled

Service Station 1

-

No Large Font - Enabled

Service Station 2

-

No Large Font - Enabled
Other Printer

-

No Large Font Enabled

1

Cancel ‘ ‘ Save

Figure 18: Additional Printer Settings

You can define the settings for five additional printers:

» Kitchen Printer 1
» Kitchen Printer 2
e Service Station 1
* Service Station 2
e Other

To set up each printer, complete the following steps:
1. Select the printer from the drop down list.

NOTE:If your printer is not on the list, you will need to add the printer in Windows. Refer to
Windows Help for more information on adding a printer. Refer to “ Setting Up a Generic
Driver for Receipt Printing” section on page 164 for more information.

2. Select the compatible model from the second drop down list, or leave the setting as No L arge
Font.

3. Check the Enabled box to enable this printer.

4. Select Save to save the additional printer settings or select Cancel to return to the main view
of the Manager Dashboard.

Delete Pay Out
Pay Outs are away of tracking the cash payments for the cash drawer attached to that station.
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The Delete Pay Out button allows you to delete a pay out made on that station. The station must
have an open cash drawer.

NOTE:Deleting or modifying payouts may adversely effect the accuracy of previous reports.

1. Todelete apay out, select Delete Pay Out from the Sation Activities area of the Manager
Dashboard.

The system opens the Del ete Payout screen.

Delete Pay Out Station 1 Activities

Date Time: Category Pay Out To Anmount

‘ Station Settings ‘

‘ Setup Additional Printers ‘

‘ Delete Pay Qut ‘

‘ Revert Cashier Out ‘

‘ Receive Physical Inventory ‘

‘ Credit Card Refund ‘

Pay Qut To Description
Amount Sunday
Sunday, June 28, 2009
Lol 6:06:11 AM
Fay Outs Can Only Be Deleted From The Station ‘ Return To Point05
They Were Made On That Has An Open Drawer Delete Pay Qut | ‘ Done ‘

Figure 19: Delete Pay Out

The Delete Pay Out area lists the date, time, category, pay out name, and amount of any existing
pay outs for the selected station.

2. Highlight the pay out you want to delete from the list.
The system displays the Pay Out To, Amount, Payout By, and Description of the selected pay out.

3. Select Delete Pay Out to delete the pay out.
4. Select Doneto close the Delete Pay Out screen and return to the Manager Dashboard.

Revert Cashier Out

The Revert Cashier Out button alows you to cancel a cash out for the last cash drawer cashed
out on that station for that day.

1. To cancel acash out action for the selected station, select Revert Cashier Out from the
Sation Activities area of the Manager Dashboard.
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NOTE: Thiswill only let you revert the last cashier out, from that station, if it was made within the
last 24 hours.

The system displays a warning to make sure you want to return the cash drawer.
2. Select OK.
The system displays a message notifying you that the cashier out has been successfully reverted.

Receive Physical Inventory

The Receive Physical I nventory button in the Sation Activities area of the Manager Dashboard
allows touch screen access to control your inventory. Thisis designed to be used from atouch
screen and can be used when inventory comes in without having to enter itemsin the office, or
when an item has been broken and needs to be removed from inventory.

1. To open the Receive Physical Inventory screen, select Receive Physical | nventory from the
Sation Activities area of the Manager Dashboard.

The system displays the Receive Physical Inventory screen. Refer to the “ Inventory Count”
section on page 101 for more information.
Credit Card Refund

If you have credit cards enabled on your system, the Credit Card Refund button allows you to
issue a credit card refund. The refund will not be available until you batch your credit cards.

1. Toissueacredit card refund, select Credit Card Refund from the Sation Activities area of
the Manager Dashboard.

The system displaysthe Credit Card Refund screen. Refer to the “ Credit Card Refund” section on
page 133 for more information.
Return to PointOS

Select the Return to PointOS button to close the Manager Dashboard and return to the Main
screen.
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Overview

The File Menu includes options related to the database, printers, and navigation back to the Main
screen.

Select Database

The Select Database option allows you to restart PointOS and select a new database. You might
use thisif you have set up atraining database for new employees.

1. Choose Select Database from the File menu.
The system displays an alert asking if you want to select a new database.

PointD5: Select New Database

Are You Sure You Want To
Select A New Database?

Figure 20: Select New Database Alert
2. Select Yes.
The system displays another alert, notifying you that PointOS will restart.

Point05S: Manager Alert

PointOS Will Now Be Restarted
Please Select Your New Database

Figure 21: PointOS Restarting Alert
3. Select OK.
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Restore Database

The system displays the Select a Database screen.

PointDS Professional Select A Database

oINS

PROFESSIONAL

Please Choose Your Database

Default Database SampleTesting Restore Backup
Sample_Company Database Database
Choose Database Newr Database Quit Program

PointDS Copyright ©@2009

Figure 22: Select A Database
Select one of the following options:

» Default Database - the database you have previously created

» Sample/Testing Database - a sample database in the Demo version of the software to try out
the software

* New Database - to create a new database

» Choose Database - to select an existing database from the server

Refer to the “ Getting Started” Chapter on page 4 for more information about the Choose
Database and New Database options.

You can also select Restore Backup Database. Refer to “ Restore Database” on page 28 for more
information.

Select Quit Program to close PointOS.

Restore Database
NOTE: Restoring the database is intended for emergency recovery of data only.

The Restore Database option allows you to restore your database to a previously backed up
version in case of dataloss.

NOTE: You can restore only on acomputer that is running the server portion (SQL) and not from
astation running client only.

1. Select Restore Database from the File menu.
The system displays the Windows Open dialog box to select the appropriate backup file.

2. Highlight the backup file you want to use. Backup databases have the file extension .bak.
3. Select Open or select Cancel to close the dialog box.
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Restore Database

The system displays adialog box to Name Your Restored Database.

Mame Your Restored Databas x|

Please Name Your Restored D atabase

Ok, I Cancel |

Figure 23: Name Your Restored Database

4. Enter the name for your restored database.
5. Select OK or select Cancd to close the dialog without restoring the database.

The system displays a message while it restores the database.

Restoring
Database

Please Wait

Figure 24: Restoring Database
The system displays an alert to restart the database and select your restored database.

6. Sdlect OK.

7. To complete the restore database process, restart PointOS and select the restored database.
Refer to “Restart PointOS’ on page 32 and “ Select A Database” on page 5 for more
information.
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Report Printer Setup

The Report Printer Setup option allows you to select a printer to use for printing reports.
1. Choose Report Printer Setup from the File menu.

The system displays the Set Report Printer screen.

Set Report Printer

Microsoft XPS Document Writer
HP LaserJet 1020
Adobe PDF

Printer Set To
HP LaserJet 1020

Select Prfnter| ‘ w Done

Figure 25: Set Report Printer
2. Highlight one of the printers installed on the station.

NOTE:If your printer is not on the list, you will need to add the printer in Windows. Refer to
Windows Help for more information on adding a printer. Refer to “ Setting Up a Generic
Driver for Receipt Printing” on page 164 for more information.

3. Choose Select Printer.
4. Select Doneto close the Set Report Printer screen.

Advanced Printer Add
The Advanced Printer Add option allows you to add a new or change existing receipt printers.
NOTE:This option is only for advanced users.

Refer to http://www.pointos.com/printercodes.html for some pop/cut codes. If these do not work,
you may need to contact the manufacturer.

1. Choose Advanced Printer Add from the File menu.
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Advanced Printer Add

The system displays an alert notifying you that this option is only for advanced users.

2. Select OK.

Point0%: Manager Alert

This Sets Up New Receipt Printers
Or Changes Existing Ones
This Is For Advanced Users Only

Figure 26: Advanced Printer Alert

The system displays the Add New Printer Type screen.

Add New Printer Type

Manufacturer

Printer Model

Drawer Pop Code

Cutter Code

Print Width

|40 " Has An Auto Cutter

‘ X Cancel ‘ ‘ Edit Existing ‘ = Save

Figure 27: Add New Printer Type

3. Toadd anew printer type:

* Enter the printer Manufacturer.

» Enter the Printer Model.

» Enter the Drawer Pop Code.

» Enter the Cutter Code.

* If necessary, change the Print Width.

* Check the Has An Auto Cutter box, if applicable.
» Select Save or select Cancel to close the add New Printer Type screen.

NOTE: Editing existing printer profilesis NOT recommended.
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Restart PointOS

Restart PointOS

After completing some tasks, you will need to restart PointOS before the changes take effect in
the system. The Restart PointOS option alows you to quickly restart PointOS.

1. Choose Restart PointOS from the File menu.

The system displays an alert asking if you want to restart PointOS.
2. Select Yesto restart, or select No to return to the previous screen.

The system restarts and opens to the Main screen.

Return to Point OS

The Return to PointOS option allows you to quickly return to the Main screen.
1. Select Return to PointOS from the File menu.

The system immediately returns to the Main screen.

Exit

The Exit option closes PointOS.

1. Select Exit from the File menu.
PointOS closes immediately.
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Overview

The Edit Menu includes options related to filling out text fields. You can also use the standard
Windows shortcuts for these options.

Cut

Highlight the text you want to remove and copy and select Cut from the Edit menu.

Copy
Highlight the text you want to copy and select Copy from the Edit menu.

Paste

Place your cursor where you want to paste the copied or cut text and select Paste from the Edit
menul.

Delete

Highlight the text you want to delete and select Delete from the Edit menu.

Select All

Place your cursor in the field and choose Select All from the File menu. The system highlights all
of the text in that field.
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PROFESSIONAL

Overview

The Setup Menu provides access to al of the options you will need to set up to maximize your
use of PointOS Professional.

Main Setup
The system opens the Main Setup screen as part of theinitial startup when you install PointOS.
If you need to change any of the following information, you can return to the Main Setup screen:

* Company Information

» Company Contact Information

* Measurements or Day Start Time

* Receipt Message

» Menu page graphic or background color
» Upgrade for additional stations

1. To open the Main Setup screen, select Main Setup from the Setup menu.

The system opens the Main Setup screen. Refer to “Main Setup” on page 9 for more information
on this screen.

Door Manager Settings

NOTE: This screen isonly available if you are using PointOS DoorMan as one of your licensed
stations.

The Door Manager Settings screen allows you to set your Door Manager settings.

1. To open the Door Manager Settings screen, select Door Manager Settings from the Setup
menul.
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The system displays the Door Manager Settings screen.

Point05 DoorMan: Manager Tools

File Edit Setup Menu-Inventory  Activities  Reports  Sales Reports Maintenance  Help

| Door Manager Settings Q |
Change Door Manager Options Door Manager Options
Main Settings
[~ Add Cover Charge
When Adding Customers .
From The Customer Screen I Prompt For Membership
Choose The Options That Wil " Members Pay Cover Charge
Automatically Occur When [ Show Customer Notices
Customer Is Added To A Tab
[T Add Customer Music
Cover Charge 1 Cover Charge 2
Minimum Age |18 Years Old v[ Minimum Age |18Years Old v|
Menu ltem IND ltem j Menu ltem IND ltem j
[T Enable Cover Charge 1 [” Enable Cover Charge 2
Cover Charge 3 Cover Charge 4
Minimum Age |18 Years Old v[ Minimum Age |18Years Old v|
Menu ltem IND ltem j Menu ltem IND ltem j
[" Enable Cover Charge 3 [” Enable Cover Charge 4

S Door Ma Setti ‘
‘ e ‘ Close Door Manager Options

Figure 28: Door Manager Settings

2. The Main Settings area controls additional information that will automatically occur when
you add a new customer to atab. Check one or more options to include those activities.

3. You can set up to four different cover charges. Complete the following steps for each cover
charge:
* Select the Minimum Age from the drop down list.
» Select the associated M enu Item for the cover charge from the drop down list.
» Check the Enable Cover Charge box.

4. Select Save Door Manager Settings to save the information.

5. Select Close Door Manager Options when you have finished.

Employee Setup

The system opens the Empl oyee Setup screen as part of theinitial startup when you install
PointOS.

You can return to the Employee Setup screen later if you need to:

Add new employees
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1.

Terminate employees

Inactivate employees or reactivate inactive employees
Change employee information or security settings

To open the Employee Setup screen, select Employee Setup from the Setup menu.
The system opens the Employee Setup screen. You can access the Change Employee Options

screen from the Employee Setup screen. Refer to “ Employee Setup” on page 13 for more
information either screen.

Payment Setup
The Payment Setup screen allows you to set al of your payment options and information.
1. To open the Payment Setup screen, select Payment Setup from the Setup menu.

The system displays the Payment Setup screen.

Point0S Professionak Manager Tools

If ¥ou Do Not Have A Merchant VWarehouse
Account But Would Like To Begin To Take
Credit Card Transaction, Click Below And Get
A Free Merchant Warehouse Credit Card Account

Get A Merchant Warehouse Account ‘

Auto Batch

[ Auto Batch Daily Charges

Daily Batch Time
12:00 pm -

r Do Mot Batch With Open Drawers
That Have Credit Card Transactions

" Close Credit From This Computer
[ Do Not Batch, Just Clear Pre-Auths

File Edit Setup Menu - Inventory  Activities Reports  Sales Reports  Maintenance  Help
| Payment Setup O |
Change Payment Settings
Merchant Warehouse Settings Payments Accepted Auto Gratuity

Site Na.me ~ American Express Auto Gratuity Percent

|Test Site ) o
v Discover

Site ID Add For Number Of Guests
¥ MasterCard

|12335 ) Iﬂny Number Of Guests j
¥ Visa

|f2"33 Key I Gift Cards ™ Add Auto Gratuity
¥ Personal Checks

Time Out Seconds Enable Credit Cards

30 . .

I Create Gift Card Security Level v Enable Merchant Warehouse

Receipt Co Printed . =

|1 Cop:: e j ILEVEI 2: Server J Each Credit Card Station Must

Also Have A Constant Connnection

[~ Enable External Terminal

To The Internet

OR

Credit Cards Must Be Enabled
In Each Station's Settings

Cancel | ‘ Save

Figure 29: Payment Setup Screen

PointOS Professional integrates with Merchant Warehouse for credit card processing. Merchant
Warehouse is available FREE with nothing to install.

You must have a Merchant Warehouse account to accept credit cards and gift cards through
PointOS. All tech support for Merchant Warehouse is offered by them, and is included with your
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merchant account. Refer to “ Setting Up a Merchant Warehouse Account” on page 166 for more
information.

Complete the following stepsto fill out the Payment Setup screen:

1. Tointegrate PointOS with Merchant Warehouse, enter the following information related to
your Merchant Warehouse account:

« SiteName
« SitelD
o SiteKey

NOTE: Thisinformation must be EXACTLY the same as the information from the email from
Merchant Warehouse. It is case sensitive. You may want to copy and paste from the email.
If you have been incorrectly given a Site Namewith a' or & init, please contact Mer-
chant Warehouse to get a new Site Name. Site Names with apostrophes or ampersands
will not work.

2. If you are using a modem instead of a high speed connection, you may want to increase the
amount of timein the Time Out Secondsfield (for example, to 30 seconds). The default is 15
seconds.

3. Select the number of receipt copies to print from the Receipt Copies Printed drop down list.
Some printers print two copies of all printouts using two ply paper. If you do not have this
feature on your printer, set this to two copies.

4. You can select which forms of payments that you will receive. In addition to the various credit
card types, you can choose to take gift cards or personal checks. Check the payment options
accepted boxes to indicate which types of payments are accepted.

NOTE:A Merchant Warehouse account is required to accept credit cards or gift cards as pay-
ment.

Credit cards must be enabled in two places. on the Payment Setup screen, and on EACH
station where credit cards are accepted (some stations may be cash only).

5. To set the security for activating and issuing gift cards to customers, select the security level
from the Create Gift Card Security L evel drop down list. The default level isthe same asthe
security level for taking orders. Gift cards must be added to the menu before they can be sold.
Refer to “Menu Setup” on page 74 for more information.

6. You can set up the system to auto batch all credit card sales each day. While you can also use
the Merchant Warehouse interface to auto batch, using PointOS provides more control over
batching and allows you to see the daily batch result on the Manager Dashboard. To setup
auto batch:

* Check the Auto Batch Daily Char ges box.

» Select thetime to perform the daily batch. Refer “ Setting the Time” on page 165 for more
information on using the clock to set the time.

* Check the Do Not Batch with Open Drawers That Have Credit Card Transactions
box to postpone batching if any open drawers have credit card transactions. This means
that if aserver forgetsto do closeout, he or she will not lose the gratuity.
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» Check the Close Credit From This Computer box to indicate that this computer only
should be used to perform the daily batch.

» Check the Do Not Batch, Just Clear Pre-Auths box to clear credit card pre-
authorizations without batching.

NOTE: Inthe rareinstance that you are running different databases with the same Merchant
Account, you may not want both accounts to batch, but need to clear the pre-authorization
on the account that does not batch. If you are using pre authorizations on credit cards, you
must batch from PointOS. Pre authorizations do a $.01 sale, and if they are not closed,
they will be cleared when batching.

You can aso batch credit cards manually. Refer to “Batch Credit Cards’™ on page 133 for more
information.

7. You can set the system to automatically add a percent gratuity to all checks for a selected
number of guests. This gratuity amount will be added to cash, personal check, gift card, and
credit card sales.

* Check the Add Auto Gratuity check box.

» Enter the percent to add automatically in the Auto Gratuity Percent box.

» Select the number of guests for which to automatically add gratuity from the Add For
Number of Guests drop down list.

8. To activate Merchant Warehouse on your system, check the Enable M erchant War ehouse
box.

9. Instead of using Merchant Warehouse, you can check the Enable External Terminal box.
PointOS will track and report on credit card charges, but there is no integrated processing.

10. Select Save button to complete the Payment Setup or select Cancel to close the Payment
Setup screen without saving.

Taxes Setup

The Taxes Setup screen allows you to set several different types of taxesthat are on itemsyou sell.
Some areastax different items at different rates. You can set these items to include the price or
have them as an add on. Included taxes do not show up on a customer’s tab.

1. To open the Taxes Setup screen, select Taxes Setup from the Setup menu.
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The system displays the Taxes Setup screen.

File Edit Setup Menu-Inventory  Activities  Reports  Sales Reports Maintenance  Help
| Taxes Setup Q |
Tax 1 Tax 3 Taxes Options
Tax 1 Name Tax 3 Name
|Tax 1 |Tax 3 Taxes Are Entered As A Percent
Tax 1 Percent Tax 3 Percent Example: For A 5% Tax, Enter 5
[0 % [0 % In The Tax Percent Field
[” Tax 1 Included In Price [” Tax 3 Included In Price
Tax 2 Tax 4 Taxes That Are Included In Price
Will Be Calculated But Will Not
Tax 2 Name Tax 4 Name Be Shown On The Check
|Tax 2 |Tax 4
Tax 2 Percent Tax 4 Percent
[0 % [0 %
[~ Tax 2 Included In Price [~ Tax 4 Included In Price
[~ Show Taxes On Every Ordered Item On Printed Receipt
| Save Taxes ‘
All Stations Meed To Be Restarted
To Activate Menu Changes | Close Taxes Setup ‘

Figure 30: Taxes Setup

You can define up to four different tax rates for different items. For each tax rate, complete the
following steps:

1.

Enter the name of the tax rate in the Tax Name field. You can choose to |eave the default
names, if desired (i.e., Tax 1, Tax 2, Tax 3, or Tax 4).

Enter the number for the percent in the percent field. For example, enter 5 for a 5% tax rate.
If you want to include the tax in the price of the selected items, select the Tax Included in

Price box. If you check this, the tax will be calculated, but it will not be shown as a separate
item on the check.

Check the Show Taxes On Every Ordered Item On Printer Receipt box to include the
taxes on the printed receipt.

Select Save Taxes to complete the Taxes Setup and close the screen. The system displays an
alert notifying you that all stations must be restarted before the new tax information can be
used. Select OK. To close the screen without saving changes, select Close Taxes Setup.
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Database Setup

The Database Setup screen contains tools that allow you to keep your database running quickly
and efficiently.

1. To open the Database Setup screen, select Database Setup from the Setup menu.
The system displays the Database Setup screen.

Point0S Professionak Manager Tools

File Edit Setup Menu - Inventory  Activities Reports  Sales Reports  Maintenance  Help

| Database Setup Q |

Auto Maintenance Database Options

How Often Auto Backup Name | Restore From Backup Database ‘

IDain j ISample_CUmpany_NE‘u"u’_bacl-cup

Auto Backup Location | Zelectuley Lamias ‘

Day Of The Week
I'\'\M ICHELE-LAPTOP\PointOS Database\Bac
|Everyday j
. . ‘ Choose Location |
Maintenance Time
|12:UU:UU PM j | Cleanup Database ‘

" Auto Backup From This Computer
[~ Force Station Restart Backup

| Compact Database ‘

(7)) How To Set PointOS Up For Remote Backup

| Backup Database ‘

Auto Maintenance Will
Compact And Backup The

Current Database Automatically I Enable Auto Maintenance

| Save Auto Settings ‘

All Stations Meed To Be Restarted |

To Activate Changes Close Database Setup ‘

Figure 31: Database Setup

Auto Maintenance

The auto maintenance feature allow you to archive and backup the database automatically. During
auto maintenance, items and orders will be archived and credit card pre-authorizations will be
deleted. To set up auto maintenance, complete the following steps:

1. Select how often you would like to archive and backup the database automatically from the
How Often drop down list.

NOTE:We recommend that you perform maintenance at least once aweek. However, for higher
volume locations, maintaining the database daily will give you optimal performance.

2. Select when to perform the maintenance. The options change, depending on what you selected
in How Often:
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» If you selected Daily, the only option under Day of the Week is Everyday.
» If you selected Weekly, select the day you choose from the Day of the Week drop down

list.

» If you selected Monthly, select the day of the month you choose from the Day of the

Month drop down list.

NOTE: Choose atime when no one else will be using PointOS, but when the database station will

be running.

Enter the time to perform the maintenance in the Maintenance Time field. Refer “ Setting the

Time” on page 165 for more information on using the clock to set the time.

Enter the name of the backup file in the Auto Backup Namefield.
Select an Auto Backup Location.

» Select Choose L ocation. The system opens a Select Directory dialog box.

Directory Mame:

Select Directory

Directories:

IE: W szers\MichelehD ocumentshFoint0S Professional

Files: [*%]

kS

= T
(= Users
(= Michele

i PontdS

£ Backup

== Documents

Compary_ABC. mdf
Compary_ABC_|og.Idf
Sample_Compary. rmdf

Sample_Compary_Log. |df

LI Drives:

Profezzional

£ Backgrounds

Sample_Company_ & 23 092 mdf
Sample_Compary_E_29 032 |og Idf

|EI  [os]
Ok I

Figure 32: Select Directory

» Select the location for the backup file. The default backup location is c:/program files/
PointOS Professional/Database/Backup. However, we recommend that you back up to
removable media such as aexternal drive, in case something happens to your computer.

» Select OK to choose the selected |ocation, or select Cancel to close the dialog.

Check the Auto Backup from This Computer box from the computer you want to use for
backing up the database. It must be running as the PointOS server (database). Only one station
can be set to auto backup. Be sure that computer is running at the time you choose for the auto
backup.

Check the Force Sation Restart Backup box to require other stationsto restart after backup.
Thisis not necessary. However, restarting PointOS Professional regularly can keep it running
faster.

Check the Enable Auto M aintenance box.

. Select Save Auto Maintenance or select Close Database Setup to close the screen without
saving the settings.

|

Cancel | Help |
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Manual Database Options

The Database Options area alows you to perform many database functions manually from one
common screen.

1. Select Restorefrom Backup Database to restore the database using a backup file. Refer to
“Restore Database” on page 28 for more information.

NOTE: Restoring from a backup database is only for emergency data recovery.
2. Choose Select New Database to restart PointOS using a different database. Refer to “ Select
Database” on page 27 for more information.

3. To clean up the database, select Cleanup Database. Refer to “ Database Cleanup” on
page 154 for more information.

4. To compact the database, select Compact Database. The system takes afew moments to
compact the database.

5. You may want to perform a manual database backup when you have made alarge change to
the system (i.e., you just added a large amount of menu items). First, you may want to
disconnect all stations. (Refer to “Disconnect Stations’ on page 153 for moreinformation.) To
perform amanual backup of the database, select Backup Database. Refer to “Backup
Database” on page 153 for more information.

Back Up Remote Computer

Select How to Set PointOS Up for Remote Backup for alink to the Microsoft website for
instructions to enable backups to network drives.

Customer Data Setup

NOTE:This screenisonly available if you are using PointOS DoorMan as one of your licensed
stations.

The Customer Data Setup screen allows you to indicate the required fields when entering a new
customer and to define two additional custom fields.

1. To open the Customer Data Setup screen, select Customer Data Setup from the Setup menu.
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The system displays the Customer Data Setup screen.

Point05 DoorMan: Manager Tools

File Edit Setup Menu-Inventory  Activities  Reports  Sales Reports Maintenance  Help
| Customer Data Setup Q |
New Customer Data Entry Fields Customer Data Options

Select Required Fields

: f Customer First Name,
r J:E g?i:i?j'ljr:::srmatmn [~ Email Address Last Name, And Birthday

Are All Required Fields

™ City [~ All Phone Numbers By Default
[~ State [ Main Phone
[~ Zip/Postal Code [ Mobile Phone
Custom Field 1 Custom Field 2
Field Name Field Name
‘Select Field Type | |Select Field Type =l

‘ Save Customer Data Options ‘

I~ Active " Required ™ Active " Required ‘ Close Customer Data Setup ‘

Figure 33: Customer Data Setup

2. The Customer’sfirst name, last name, and birthday are required fields when entering a new
customer. To require additional information, check the box(es) next to the fields to require
them.

3. To define a custom field, complete the following steps:

* Enter the Field Name.
* Choose an option form the Select Field Type drop down list.
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» If you select Drop Down, you must add the itemsfor thelist. Enter the name of theitemin
the field above the Add and Remove buttons and select Add. You can remove an item by
highlighting it in the list and selecting Remove.

Field Name

|Test

|Drop Down

=l

[tem One

[tem Two

4 Add || ¥ Remove |

[~ Active

" Required

Figure 34: Custom Field Drop Down List Definitions

» Check the Active box to include the field on the Customer Activities screen.
» Check the Required box to make the field required.

4. Select Save Customer Data Optionsto save the changes.

5. When you have finished defining the customer data, select Close Customer Data Setup.

Customer Notice Setup

The Customer Notice Setup screen allows you to set up notices to your staff about customer sales
milestones or automatic birthday emailsto customers. You must have email setup to send emails.
Refer to “Email Setup” on page 49 for more information.

1. To open the Customer Notice Setup screen, select Customer Notice Setup from the Setup

menu.
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The system displays the Customer Notice Setup screen.

Point05 Professionak: Manager Tools

File Edit Setup Menu-Inventory  Activities  Reports  Sales Reports Maintenance  Help

| Customer Notice Setup © |
Customer Notice Setup Notice Options
Customer Sales Alerts Email Motification

Alert At | I~ Send Email On
Customers Birthday

Alert At |
[~ Send Email From

Alert At I This Computer

Alert At |

Alert At | Save Notice Settings

Customer Birthday Email

Dear Customer Name,

We just wanted to send you a quick email to wish you a very happy =
birthday.

We know birthdays are very special, and this is just a little thank you for
your business.

From Your Friends At Abc Bar And Grill

Save Birthday Email Close Customer Notice Setup

Figure 35: Customer Notice Setup

To set up notices to your staff when a customer reaches selected sales milestones, compl ete the
following steps:

1. Ineach Customer Sales Alertsfield, enter the sales amount at which you want to notify your
sales staff. You can enter the amount in dollars or dollars and cents. You do not need to enter
the dollar sign.

2. Select Save Notice Settings.
To setup customer birthday emails, complete the following steps:

NOTE: You must have email setup to send emails. Refer to “Email Setup” on page 49 for more
information.

Edit the Customer Birthday Email as desired.
Select Save Birthday Email.

Check the Send Email on Customer s Birthday box.
Check the Send Email from this Computer box.

Eal A
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Once you setup birthday emails, they will be sent from the selected computer at 6am every
morning.

NOTE: The computer sending the automatic emails must be running at the time you select.
When you have finished using the Customer Notice Setup screen, select Close Customer Notice
Setup.

Delivery Setup

The Delivery Setup screen allows you to set up PointOS to take Delivery Orders. You will want to
set up one computer with a phone line to capture the caller 1D from your customers.

NOTE: You will not be able to enter delivery orders unless you have a phone line attached collect-
ing the customer’s Caller ID.

1. You will need to plug a phone line into that computer’s fax/modem port. If your computer
does not have a phone port, you can purchase an external modem which can be hooked up by
USB.

2. To open the Delivery Setup screen, select Customer Notice Setup from the Setup menu.
The system displays the Delivery Setup screen.

Point05 Professionak: Manager Tools

File Edit Setup Menu-Inventory  Activities  Reports  Sales Reports Maintenance  Help

O

| Delivery Setup

Change Delivery Settings

Caller ID Settings Enable Delivery
Select A Phone Device: Device Media Mode
"RAS PPPOE Line0000 ~| Data Mode M I~ Enable Delivery Mode

Phone Device's Capabilities: Enabling Delivery Mode
Caller ID - UNAWAILABLE =] Select Device Will Allow You To Take
Delivery Orders

From All Stations

LI Advanced Settings
Even If They Are
Not Connected To
[ Enable Caller ID From This Computer A Phone Line
It Is Recommended That You Only Delete Caller ID Log
Have One Caller ID Station
When In Delivery Mode
Make Sure The Phone Line Is
Hooked Up And The Correct
Phone Device Is Selected
Cancel | ‘ Save

Figure 36: Delivery Setup
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3. Check the Enable Delivery M ode box to add a Delivery areato your Main screen.

4. On the computer you will use for deliveries, check the Enable Caller 1D From This
Computer box.

5. Select your phone device from the Select A Phone Device drop down list. Make sure you
choose a device that has Caller ID capabilities.

6. Select thetype of orders (Data, Fax, or Voice) you will take from the Device Data M ode drop
down list.

7. Choose Select Device.
8. Select Save to save your Delivery Setup options or select Cancel to close the Delivery Setup

without saving the changes.
Delete Caller ID Log
The Delivery Setup screen aso allows you to clear the caller ID log.
1. Select Delete Caller 1D Log.
The system displays an aert asking if you are sure you want to delete the caller ID log.
2. Select OK.
The system displays an alert notifying you that it has deleted the caller ID log.

Discount Setup

The Discount Setup screen allows you to define discounts for various reasons. Thereis a
maximum of seven different types of discounts.

1. To open the Discount Setup screen, select Discount Setup from the Setup menu.
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The system displays the Discount Setup screen.

Point05 Professionak: Manager Tools

File Edit Setup Menu-Inventory  Activities  Reports  Sales Reports Maintenance  Help

| Discount Setup @ |
Discount Setup Report Options

Discounts Edit Discounts

Comp (100% OFF) Discount Name
Employee (50% OFF) I
Good Customer (25% OFF) :
Spill (100% OFF) Discount Percent

[ %

| Delete ‘ ‘ Update |

There Is A Maximum | Add New Discount |
Of 7 Discounts

Special Price Name Discount Prompt Question

Good Customer |Reason For This Discount?

‘ Update Special Discount

Close Discount Setup

Figure 37: Discount Setup
To define a new discount, complete the following steps:
1. Enter aname for the discount in the Discount Name field.
2. Enter the percentage off in the Discount Percent field.
3. Select Add New Discount.
To edit or delete one of the defined discounts, complete the following steps:
1. Highlight the name of the discount you want to edit in the Discounts area.
2. Edit the Discount Name, if desired.
3. Edit the Discount Percent, if desired.
4. To update the discount, select Update. To delete the discount, select Delete.

You can include one special price. Thislinksto the Special Priceiteminthe Menu Setup. Refer to
“Menu Setup” on page 74 for more information.

1. Enter the Special Price Name (i.e., ITB).

2. Enter question to include in the prompt when giving the discount in the Discount Prompt
Question field.
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When you have finished using the Discount Setup screen, select Close Discount Setup.

Email Setup
The Email Setup screen allows you to define email for several different features:

* Emailing daily, weekly, and monthly sales reports
» Allowing employeesto email each other
» Emailing customers for their birthdays

1. To open the Email Setup screen, select Email Setup from the Setup menu.
The system displays the Email Setup screen.

Point0S Professionak Manager Tools

File Edit Setup Menu - Inventory  Activities Reports  Sales Reports  Maintenance  Help

| Email Setup C) |
Auto Report Email Email Options
Email Daily Sales Report Email Monthly Sales Report
N I Message Center
INB"'B" j INever j Security Level To Send Email
Day Of The Week Day Of The Week |Employee =l
Mever - Mever - )
I J I J ¥ Enable Employee Email
Email Weekly Sales Report Email Settings
How Often SMTP Server Port
INeuer j I |25 Reports Are Emailed In
. Microsoft Excel Format
Day Of The Week SMTP User Name (Optional) And Cannot Be Created
INeuer j I Unless You Have Excel

Installed On This Computer

SMTP Password (Opticnal)

Time To Send Auto Emails I

|12:0[] pm j The above information should be
from your Internet Service Provider

¥ Send From This Computer Company Email Address |
¥ Enable Auto Emails I

Save Email Settings ‘

All Stations Meed To Be Restarted |

To Activate Changes Close Email Setup ‘

Figure 38: Email Setup
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Email Settings
Before you can email reports, customer birthday emails, or enable employee emails, you must
setup the email settings.

1. Enter the SMTP Server information (Server and Port). Thisinformation is available from
your internet service provider. Your ISP, or internet service provider, isthe company that
provides your internet service. It isNOT AOL, Google, or Yahoo.

Here are afew common SMTP server addresses:

NOTE: These are subject to change, and many providers have multiple smtp depending on your
geographical location and the type of service you have through them (i.e.,, DSL vs. Cable
modem). Also, some require a certain port, and some require user name and password.

Internet Service Provider SMTP Address
Adelphia smtp.blk.adel phia.net
AT& T Worldnet mailhost.att.net
BellSouth smtp.blk.adel phia.net
Adelphia mail.rdu.bellsouth.net
Comcast smtp.comcast.net
Time Warner RoadRunner smtp-server.nc.rr.com
AT&T smtpl.attglobal.net
Bellatlantic.net smtpout.bellatlantic.net
Charter Pipeline smtp.charter.net
Cox Communications smtp.cox-internet.com
Verizon outgoing.verizon.net

2. If your internet provider requiresit, enter your User Name to access your internet account.
3. If your internet provider requiresit, enter your Passwor d to access your internet account.
4. Enter the Company Email Address. Thisiswhere any repliesto automatic emails are sent.

Auto Report Email

You can have the Daily, Weekly, and Monthly Sales reports sent to you automatically. The sales
reports are in Microsoft Excel® format. You must have Microsoft Excel® installed on the
computer that sends the sales reports.

To have the sales report emailed to you, complete the following steps:

1. For each type of report, select an item from the How Often drop down list. Select Never if
you do not want to receive that sales report, but you want to enable automatic emailing of the
other reports.
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2. Depending on whether you selected Daily, Weekly, or Monthly as How Often, select an item
from the Day of the Week or Day of the Month drop down list to indicate when to email the
report.

3. Select what time to email the reportsin the Time to Send Auto Emails drop down list. Refer
“Setting the Time” on page 165 for more information on using the clock to set the time.

4. Check the Send from This Computer box to indicate which computer to use to send the
emails. The computer must have Microsoft Excel® installed to send sales reports.
5. Check the Enable Auto Emails box to send automatic emails of sales reports as you have

indicated.
M essage Center

You can allow employees to email each other through the system. These emails are sent to the
email addresses used in the Employee Setup. The email addresses remain hidden from the sender
and the recipient, and all addresses have the company return address to protect the privacy of your
employees.

To setup employee email, complete the following steps:

1. Select therequired Security Level to Send Email from the drop down box to indicate who
can send employee emails.

2. Check the Enable Employee Email box to activate the employee email functionality.

Save Email Settings
When you have finished with the email settings, select Save Email Settings.

The system displays a message notifying you that the settings have been saved. Then it returns to
the Manager Dashboard.

If you want to close the Email Settings screen without saving changes, select Close Email Setup.

Happy Hour Setup

The Happy Hour Setup screen allows you to control automatic pricing of items during happy hour
times. During the times you set, the menu items will be automatically discounted.

1. To open the Happy Hour Setup screen, select Happy Hour Setup from the Setup menu.
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The system displays the Happy Hour Setup screen.

Point05 Professionak: Manager Tools

File Edit Setup Menu-Inventory  Activities  Reports  Sales Reports Maintenance  Help

| Happy Hour Setup C) |
Change Happy Hour Options

Sunday Monday Tuesday Wednesday Thursday Friday Saturday
Start Time Start Time Start Time Start Time Start Time Start Time Start Time

12:00am ~ |12:[}Uam - |12:m}am - |12:[}Dam - |12:m}am - |12:tmam - |12:m1am -

End Time End Time End Time End Time End Time End Time End Time

|12:15am - |12:15am - |12:15am - |12:15am - |12:15am - |12:15am - |12:15am -

0 Hours 0 Hours 0 Hours 0 Hours 0 Hours 0 Hours 0 Hours
15 Minutes 15 Minutes 15 Minutes 15 Minutes 15 Minutes 15 Minutes 15 Minutes
[~ Enabled [~ Enabled [~ Enabled [~ Enabled [~ Enabled [~ Enabled [~ Enabled
Update All Days
Start Time End Time
12:00 am ~ |12;15 am v Update All ¥ Print Happy Hour On Menu ltems

All Stations Need To Be Restarted To Activate Happy Hour Changes e | ‘ —

Figure 39: Happy Hour Setup

2. To set al days to the same happy hour:

» Select the Sart Time. Refer “ Setting the Time” on page 165 for more information on
using the clock to set the time.

» Select the End Time. The End Time can be the next day (i.e., happy hour runsfrom 9 p.m.
to4am.).

» Select Update All.

The system updates each day with the selected Start and End times and checks the Enabled box.

3. To update the individual day happy hour times:

» For each day, select the Sart Time. Refer “ Setting the Time” on page 165 for more
information on using the clock to set the time.

» For each day, select the End Time.

» For each day, check or uncheck the Enabled box to indicate whether the happy hour isin
effect for that day.

4. Select Print Happy Hour on Menu Items, if desired.
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5. Select Save to save the changes to the happy hour schedule. The system displays a message
notifying you that the settings have been saved. Then it returns to the Manager Dashboard. If
you want to close the Happy Hour Setup screen without saving changes, select Done.

Membership Setup

NOTE:This screen isonly available if you are using PointOS DoorMan as one of your licensed

stations.

The Membership Setup screen allows you to set up memberships.

1. To open the Membership Setup screen, select M ember ship Setup from the Setup menu.

The system displays the Membership Setup screen.

Point05 DoorMan: Manager Tools

Memberships

Edit Memberships

Membership Name

Price

e —

File Edit Setup  Menu - Inventory  Activities  Reports  Sales Reports  Maintenance  Help
| Membership Setup Q |
Membership Setup Membership Options

Setup ID Card Printer

Add New
Membership

Delete
Membership

Taxes

Length Of Membership

| =

Security Level To Choose

I Days

|DD Mot Check Security

=l

Security Level To Add Guests

|DD Mot Check Security

=

There Can Only Be

[~ This Is The Free Guest Membership

One Set

™ Tax 1{3%)
™ Tax 2 (0%)
™ Tax 3 (0%)
I~ Tax 4 {0%)

Set The ID Card

Printer As The

Default Printer
In Windows

[~ Allow Guests
[” Require ID Card
[” Discountable

| Update Membership Settings

[~ Enable Id Card Printing

[” Enable Membership Card
Magnetic Stripe Reading

Save Membership Settings

Close Membership Setup

Member ships

Figure 40: Membership Setup

The left side of the screen lists all of your memberships.

Define a New M ember ship

To define a new membership, complete the following steps:
1. Select Add New Membership.
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Enter the M ember ship Name.

Enter the Price for the membership.

Select the Length of Member ship from the drop down list.
Select a Security Level to Choose from the drop down list.
Select a Security Level to Add Guests from the drop down list.

For one membership, you can create a free guest membership. Check the Thisisthe Free
Guest Member ship box if applicable.

8. Select thetax rate for the membership.

9. Check the Allow Guests box to indicate whether members may bring guests.
10. Check the Require ID Card to require the ID card.

11. Check the Discountable box to indicate the membership may be discounted.
12. Select Save New M ember ship.

The system displays a message notifying you that the membership has been added.

N o o~ DN

Change a M ember ship

To change a membership, complete the following steps:

Highlight the name of the membership you want to edit in the Member ships area.
Enter the M ember ship Name.

Enter the Price for the membership.

Select the Length of M ember ship from the drop down list.

Select a Security Level to Choose from the drop down list.

Select a Security Level to Add Guests from the drop down list.

For one membership, you can create a free guest membership. Check the Thisisthe Free
Guest Member ship box if applicable.

8. Select thetax rate for the membership.

9. Check the Allow Guests box to indicate whether members may bring guests.
10. Check the Require ID Card to require the ID card.

11. Check the Discountable box to indicate the membership may be discounted.
12. Select Update Member ship Settings.

N o g s~ NP

Delete a M ember ship
To delete a membership, complete the following steps:

1. Highlight the name of the membership you want to delete in the Member ships area.
2. Select Delete Member ship.

Member ship Options
The Membership Options control the membership ID cards.
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1.

Check the Enable 1D Card Printing box to enable ID card printing at this station.

NOTE:Make sure your ID card printer is the default printer in Windows for this computer.

2.
3.

Check the Enable Member ship Card Magnetic Stripe Reading to enable your card reader.
To open the Membership ID Card Settings, select Setup 1D Card Printer.

The system displays the Membership ID Card Settings settings.

Point05 DoorMan: Manager Tools

File Edit Setup Menu-Inventory  Activities  Reports  Sales Reports Maintenance  Help

Membership Setup Q |
Membership Setup Membership Options
Membership Card Text
[ Enable Customer Name Text Left IEU Top |2[] H Zeiup L Doend Bt I
[ Enable Membership Start Text Left IQU Top |120
Set The ID Card
[ Enable Expiration Date Text Left IEU Top |220 Printer As The
Default Printer
™ Enable ID Number Text Left |700 Top |20 In Windows

‘ Test Print ID Card ‘

[” Enable Id Card Printing

General Settings
[ Enable Membership Card

Price Per Card Font Name Magnetic Stripe Reading
|$U'UU |Aria| j| ‘ Save Membership Settings ‘
Font Size
10 =l
Save ID Card Settings ‘ ‘ Close ID Card Setup ‘ ‘ Close Membership Setup ‘

Figure 41: Membership ID Card Settings

To include the customer name on the membership card, check the Enable Customer Name
Text. Enter the number of pixels from the L eft and the Top of the card to print the customer
name text.

To include the membership start date on the membership card, check the Enable
Member ship Start Text. Enter the number of pixels from the L eft and the Top of the card to
print the membership start date text.

To include the membership expiration date on the membership card, check the Enable
Expiration Date Text. Enter the number of pixelsfrom the L eft and the Top of the card to
print the expiration date text.

To include the ID Number on the membership card, check the Enable ID Number Text.
Enter the number of pixels from the L eft and the Top of the card to print the ID Number text.
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8. Enter the price of the membership card, if applicablein the Price Per Card field.

9. Select the Font Name from the drop down list to indicate which font to use for printing the
membership card.

10. Select the Font Size from the drop down list to indicate which size to use for printing the
membership card.

11. Select Save ID Card Settings to save the settings.

12. To print atest membership card to test the settings, select Test Print 1D Card.

13. When you have finished setting the membership card settings, select Close ID Card Setup.
14. Select Save M ember ship Settingsto save the settings for the selected membership.

15. When you have finished setting up your memberships, select Close Member ship Setup.

Music Setup

The Music Setup screen controls how music is played, requested, and found.

1. To open the Music Setup screen, select Music Setup from the Setup menu.
The system displays the Music Setup screen.

Point0S Professionak Manager Tools

File Edit Setup Menu - Inventory  Activities Reports  Sales Reports  Maintenance  Help

| Music Setup Q |

Remote Requests Music Options

I Allow Other Stations To Request Songs | Defete All Music ‘

I~ Auto Add Requests From Other Stations

Add New Songs To Playlist I Do Not Add If Requested | Update Music ‘
As Last Song j Song Is Already In Playlist
Add Song If Requested Song | Reset All Damaged Songs ‘
Is Mot In Playlist's Next
||Zi=: Mot Check j

¥ Check For New Music On Startup
¥ Make This A Music Station

| Save Music Settings ‘

All Stations Meed To Be Restarted |

To Activate Changes Close Music Setup ‘

Figure 42: Music Setup
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Music Options

There can only be one music station. You must have a music station for some of these options to

work.

1. Check the Make Thisa Music Station box to indicate the computer to use as the music
station and DJ for music requests.

2. Toautomatically add new music when the system starts up, select the Check For New Music
On Sartup box. The system will add any new music from Windows Media Player
automatically, each time you start PointOS.

NOTE:Make sure any playlists intended for use with PointOS begin with a +. Refer to “ Setting
Up Music” on page 167 for more information.

3. To delete music from PointOS so that you can start over with new music, select Delete All
Music.

4. To manually update new music from Windows Media Player, select Update Music.

5. When a song will not play, the system tags it as damaged. PointOS does not delete or change
the song, but the song will no longer come up in searches or playlists. Select Reset All
Damaged Songs to reset the songs. However, we do not recommend using this setting. As
you use the system, the damaged songs will cycle out of PointOS.

Remote Requests
To allow other cash register stations to make song requests, complete the following steps:

1. Check the Allow Other Sations To Request Songs box to enable remote requests.

2. Check the Auto Add Requests From Other Sations box to set the music station to serve as
automatic D.J. for music requests.

3. For automatic requests, where to add the requested song in the current playlist by selecting
either First Song or Last Song from the Add New Songs to Playlist drop down list.

4. Check the Do Not Add If Requested Song Is Already in Playlist box to avoid duplicates of
asong in the playlist.

5. If theDo Not Add If Requested Song Is Already is Playlist box is UNCHECKED, you can
select where in the playlist to add the song (either the next song or the last song on the list).
Select an option from the Add Song If Requested Song IsNot In Playlist’s Next drop down
list.

Save Music Setup

When you have finished with the music setup, select Save M usic Settings.

The system displays a message notifying you that the settings have been saved. Then it returnsto
the Manager Dashboard.

If you want to close the Music Setup screen without saving changes, select Close Music Setup.
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Online Reporting Setup

The Online Reporting Setup screen allows you to set up online reporting. Online reporting isa
useful tool to check your sales and other reporting from home or anywhere in the world. It gives
you the control to stay on top of your business, even when you are not there.

NOTE:No sales or customer datais stored by our servers. All datais stored on your database, and

only you will be able to accessiit.

1. To open the Online Reporting Setup screen, select Online Reporting Setup from the Setup

menul.
The system displays the Online Reporting Setup screen.

Point05 Professionak: Manager Tools

File Edit Setup Menu-Inventory  Activities  Reports  Sales Reports Maintenance  Help

| Online Reporting Setup

@]

Online Login Information

Login ID
Iabcbarandg 10 Characters Or Less With No Spaces
Password Re-Enter Password

Online Reporting Terms And Conditions

Online Reporting Options

ShakenSoft, LLC's Online Terms and Conditions ﬂ
Terms of use
1. Your agreement to these terms of use

Use Online Reporting At
WWW.mypointos.com

Pleaze read these Terms of Use carefully before accessing or using PeintOS online reporting.

By accessing or using this website you signify your understanding of and agreement to
these Terms of Use. The information, services and materiale on this website are provided by
the ShakenSoft, LLC, subject to your agreement to the following Terms of Use.

2. Accessing our website

Access to this website iz permitted on a temperary basis, and ShakenSoft, LLC rezerves the
-

™ 1 Accept Your Online Terms And Conditions Agreement

Sign Up Now For
To Begin Using
PointOS Professional
Online Reporting

Sign Up Now Close Online Reporting Setup

Figure 43: Online Reporting Setup Screen 1

1. Enter an online reporting Logln ID. ThisID must be unique to your company. If you select
one that is aready taken, the system prompts you to enter a different Login ID.

Re-enter the password in the Re-Enter Password field.
Read the Online Reporting Terms and Conditions.

o k> N

Enter a password to use with online reporting in the Password field.

Check the | Accept Your Online Terms and Conditions Agreement box.
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6. Select Sign Up Now. Or select Close Online Reporting Setup to close the screen without
signing up for online reporting.

The system displays an alert notifying you that your account has been created. The aert contains
your site ID. You will also receive an email with your user name and registered email address.

The system displays additional options for the Online Reporting Setup.

Point05 Professionak Manager Tools

File Edit Setup  Menu - Inventory  Activities  Reports  Sales Reports  Maintenance  Help

| Online Reporting Setup @ |

Online Login Information e E

| Setup Your Port ‘

Login ID

I | Setup Your Firewall ‘

| Email Me My Password ‘ | Setup Your Router ‘

| Change My Password ‘

| Test Your Connection ‘

| Cancel My Online Account ‘

Use Online Reporting At
www_mypointos.com

| Review The Terms And Conditions

¥ Send Online Beacon To PointOS From This Computer UserlD:

Site 1D: »o00t

| Send Beacon To Server Now ‘ Close Online Reporting Setup

Figure 44. Online Reporting Setup Screen 2

Check Connection to Server

Once your account is setup, you will need to setup a computer to allow connections with the
reporting server.

1. Select Test Your Connection to seeif the computer can communicate with the server using
your current settings.

Setup Connection to Server

To set up the computer to communicate with the reporting server, complete the following steps:

1. Setup your port. Refer to “ Setting Up A Port” on page 168 for more information.

2. Setup your firewall. Refer to “ Setting Up Your Firewall for Online Reporting” on page 170
for more information.
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3. Setup your router. Refer to “ Setting Up Your Router” on page 171 for more information.

Send Beacon to Server

1. To have the information sent automatically, check the Send Online Beacon to PointOS
From This Computer box.

2. Select Save.

When you do not have a constant 1P, you will need to send the beacon manually to send an update
to the server with your current | P address.

1. To send the beacon manually, select Send Beacon To Server Now.

OnlineLogin Information

The Online Login Information area displays your Login ID.

If you have forgotten your online reporting password, select Email Me My Password.
To change your password, complete the following steps:

1. Select Change My Password.

The system displays the Change Online Password area.

Point05 Professionak Manager Tools

File Edit Setup  Menu - Inventory  Activities  Reports  Sales Reports  Maintenance  Help

| Online Reporting Setup O |

Online Login Information e E

| Setup Your Port ‘

Login ID
|mb-.',- edemer | Setup Your Firewall ‘
Email e My Password | Setup Your Router ‘

| Change My Password

| Test Your Connection ‘

Change Online Password

Use Online Reporting At
www_mypointos.com
Old Password
0Old Password (Re-Enter) New Password
I I UserlD: mbwiedemer
Site 1D:1056
“ Cancel Password Change I ‘ Change My Password
Send Beacon To Server Now Close Online Reporting Setup

Figure 45: Change Online Password
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Enter your Old Password.
Re-enter your Old Password.
Enter the New Password.

Select Change My Passwor d to save the changes or select Cancel Password Change to
close the Change Online Password area.

a b~ DN

Cancel Online Reporting Account

You also have the option to cancel your account.
1. Select Cancel My Online Account.

Read Termsand Conditions

To read the Terms and Conditions of online reporting, complete the following steps:
1. Select Review the Termsand Conditions.

The system displays the Online Reporting Terms and Conditions area.

Point0S Professionak Manager Tools

File Edit Setup Menu - Inventory  Activities Reports  Sales Reports  Maintenance  Help

| Online Reporting Setup C) |

Online Login Information LD REPRT B

| Setup Your Port ‘

Login ID
Imb'.'-; edemer | Setup Your Firewall ‘
| Email Me My Password ‘ | Setup Your Router ‘

| Change My Password ‘

| Test Your Connection ‘

Online Reporting Terms And Conditions

Use Online Reporting At
www.mypointos.com

ShakenSoft, LLC's Online Terms and Conditions ﬂ
Terms of use

1. “our agreement to these terms of use

Please read these Terms of Use carefully before accessing or using PeintOS enline reporting.

By accessing or using this website you signify your understanding of and agreement to

these Terms of Use. The information, services and materials on this website are provided by

the ShakenSoft, LLC, subject to your agreement to the following Terms of Use. UserlD: mbwiedemer
2. Accessing our website Site ID:1056

Access to this website is permitted on a temporary basis, and ShakenSoft, LLC reserves the
-

Close Terms And Conditions Close Online Reporting Setup

Figure 46: Online Reporting Terms and Conditions
2. When you have finished, select Close Terms and Conditions.
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Close Online Reporting Setup
When you have finished setting up online reporting, select Close Online Reporting Setup.

Payroll Setup

The Payroll Setup screen alows you to define multiple job descriptions for various hourly rates
for an employee to use when he or she clocksin. It aso defines the default salary levels used in
the Employee Setup screen.

1. To open the Payroll Setup screen, select Payroll Setup from the Setup menu.
The system displays the Payroll Setup screen.

Point0S Professionak Manager Tools

File Edit Setup Menu-Inventory  Activities Reports  5ales Reports  Maintenance  Help

‘ Payroll Setup Q |
Payroll Setup Payroll Options
Sl Hourly Rates # No Clock In For Owners
Salary Name

| [ Prompt Employees For

Salary Level At Clock In
Hourly Rate

I |

| Delete ‘ ‘ Update |

Save Settings

‘ Add Hew Salary |

Close Payroll Setup

Figure 47: Payroll Setup
To define anew job description pay rate, complete the following steps:

1. Enter aname for the salary in the Salary Name field.
2. Enter the hourly rate in the Hourly Rate field.
3. Select Add New Salary.

To edit or delete one of the defined salaries, complete the following steps:
1. Highlight the name of the salary you want to edit in the Salary Names area.
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2. Edit the Salary Name, if desired.
3. EdittheHourly Rate, if desired.
4. To update the salary, select Update. To delete the salary, select Delete.

Once you have created your salaries, check the Prompt Employees For Salary At Clock In box
to have employees select from multiple applicable salaries at clock in. To use employees default
salary levels, leave the box unchecked.

If desired, check the No Clock In For Owner s box so that the system does not use time clock
features for owners.

Select Save Settings to save the new or updated payroll settings.
When you have finished using the Payroll Setup screen, select Close Payroll Setup.

Report Setup

The Report Setup screen allows you to define locations in your establishment, weather conditions
specific to your area, and reasons for not scanning an ID specific to your needs. Theseitems
appear on incident, opening, and closing reports.

1. To open the Report Setup screen, select Report Setup from the Setup menu.
The system displays the Report Setup screen.

Define Report L ocations
L ocations are used throughout reporting and with menu items and inventory items.
1. Select Location Areas under Report Options.
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The system displays the Change Location Areas information.

Point05 Professionak: Manager Tools

File Edit Setup Menu-Inventory  Activities  Reports  Sales Reports Maintenance  Help

| Report Setup ’:) |
Change Location Areas Report Options
‘ Location Areas ‘
Location Areas Location Area : ]
Bar I ‘ Weather Conditions ‘
Storage
| Delete ‘ ‘ Update | ‘ No ID Reasons ‘

| Add New Location |

¥ Prompt For Daily Conditions
On Cashier In

‘ Save Setting

Close Location Areas | ‘ Close Report Setup

Figure 48: Report Setup: Change L ocation Areas
To add a new location, complete the following steps:
1. Select Add New L ocation.
The system displays an Add New Location Area dialog box.

2. Enter the name of the new location.
3. Select OK to save the new location, or select Cancel to close the dialog box without saving.

To edit an existing location, compl ete the following steps:

1. Highlight the name of the location you want to edit from the Location Areas.
2. Edit the location name, if desired.
3. To update the location, select Update. To delete the location, select Delete.

When you have finished working with Location Areas, select Close L ocation Areas.

Define Weather Conditions
1. Select Weather Conditions under Report Options.
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The system displays the Change Weather Condition List information.

Point05 Professionak: Manager Tools

File Edit Setup Menu-Inventory  Activities  Reports  Sales Reports Maintenance  Help

| Report Setup @ |
Change Weather Condition List Report Options
L e ‘ Location Areas ‘
Weather Conditions Weather Condition
Cloudy I ‘ Weather Conditions ‘
' |
ailing

Heavy Rain | Delete ‘ ‘ Update | ‘ No ID Reasons ‘
High Wind
Humid
Iéllgegtti\':gnd | Add New Condition |
Snowing [¥ Prompt For Daily Conditions
Sunny On Cashier In
Thunderstorm ‘ Save Setfing

There Is A Maximum Of
12 Weather Conditions For
The Daily Weather Report

Close Weather Conditions | ‘ Close Report Setup

Figure 49: Report Setup: Change Weather Condition List
To add a new weather condition, complete the following steps.

NOTE: Thereis amaximum of 12 Weather Conditions. If you have already added weather condi-
tions, you cannot add more than 12. You must delete or update other conditions instead.

1. Select Add New Condition.
The system displays an Add New Weather Condition dialog box.

2. Enter the name of the new weather condition.

3. Select OK to savethe new weather condition, or select Cancel to close the dialog box without
saving.

To edit an existing weather condition, complete the following steps:

1. Highlight the name of the weather condition you want to edit from the Weather Conditions.

2. Edit the weather condition name, if desired.

3. To update the weather condition, select Update. To delete the weather condition, select
Delete.

When you have finished working with Weather Conditions, select Close Weather Conditions.
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Define No ID Reasons

The No ID Reasons are the options that are displayed when atab is started without scanning an
ID.

NOTE: You can turn off the No ID Reasons prompt under the Main Setup. Refer to “ Other Set-
tings and Receipt Message” on page 11 for more information.

1. Select No ID Reasons under Report Options.
The system displays the No ID Reason Setup information.

File Edit Setup Menu-Inventory  Activities  Reports  Sales Reports Maintenance  Help

| Report Setup C) |
No |D Reason Setup Report Options
‘ Location Areas ‘
No ID Reasons No |D Reason
Bracelet ) I ‘ Weather Conditions ‘
Damaged License
Owver 35
Passport | Delete ‘ ‘ Update | H No ID Reasons I
Visually Seen

| Add New Reason |

: ¥ Prompt For Daily Conditions
There Is A Maximum o nier|
Of 5 No 1D Reasons n Cashier In

‘ Save Setting

Close Ho ID Reasons | ‘ Close Report Setup

Figure 50: Report Setup: Change Weather Condition List

To add a new reason, compl ete the following steps:

NOTE: Thereisamaximum of 5 No ID Reasons. You must delete one of the existing reasons
before you can add anew one.

1. Select Add New Reason.
The system displays an Add New No ID Reason dialog box.

2. Enter the name of the new reason.
3. Select OK to save the new reason, or select Cancel to close the dialog box without saving.

To edit an existing reason, complete the following steps:
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1. Highlight the name of the reason you want to edit from the No ID Reasons area.
2. Edit the reason name, if desired.
3. To update the reason, select Update. To delete the reason, select Delete.

When you have finished working with No ID Reasons, select Close No ID Reasons.

Weather Reporting
1. Check the Prompt for Daily Conditionson Cashier In box to track weather conditions.
2. Select Save Setting.

Close Report Setup
When you have finished setting up reports, select Close Report Setup.

Room Setup

The Room Setup screen allows you to define the layout of your establishment. Thisis used instead
of or in addition to the Tabs screen to give avisual representation of the table layout. Once you
have set up your rooms, you can start or edit atab by clicking on that table in the Orders screen.

1. To open the Room Setup screen, select Room Setup from the Setup menu.
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The system displays the Room Builder screen.

Point05 Professionak: Room Setup

Room Builder C) |

Room Build Options

Rooms Room Setup
Dining Room ‘ Create New Room |
Room Name
Room 2 Edit R
Banquet | it Room
| Edit Room Name | ¥ Show Hidden Rooms
| Hide Room |

‘ B Move Room Up ‘
| Delete Room |

‘ Move Room Down L ‘

You Can Have A Maximum
Of 5 Non-Hidden Rooms

" Prompt For Number Of Table Guests

‘ Close Room Builder

Figure 51: Room Builder: Room Setup

Define Rooms
1. Select Create New Room under Room Build Options.

The system adds a room to the Rooms list with a default name.
NOTE: There is amaximum of 5 visible rooms.

Edit Room Names

1. Highlight the name of the room you want to edit from the Rooms area.
2. Edit theroom name, if desired.

3. Select Update Room Name. To delete the room, select Delete Room.

Control Room Appearance on Orders Screen
The rooms appear on the Orders screen from left to right.

1. Highlight the name of the room you want to move from the Rooms area.
2. Select Move Room Up to move the room to the left on the Orders screen.
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3. Select Move Room Down to move the room to the right on the Orders screen.

Hide Rooms
1. Highlight the name of the room you want to hide from the Rooms area.
2. Select Hide Room to remove the room from the Orders screen without deleting it.

If you have the Show Hidden Rooms box checked, the Rooms list includes the hidden room with
anote indicating that it is hidden. If the box is unchecked, the hidden room is not shown on the
Rooms list.

To un-hide aroom, complete the following steps:

1. Highlight the name of the room you want to un-hide from the Rooms area.
2. Select Un-Hide Room.

Define Tables

You can define the shape, size, and orientation of tables in your rooms.

1. Highlight the name of the room for which you want to create tables from the Rooms area.
2. Select Edit Room.
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The system displays the Room Builder screen for the selected room.

Point05 Professionak: Room Setup

Room Builder ":) |

Room 4

Build Options
Table Type
‘Shape j‘
Table Size
Size M

Table Qrientation

‘Ori entation j‘

| Create New Table |

Drag Table
To Move It

Table Name

Table Number

Table Size Move Table | Cancel |

Delete 52
weees]||[#] [ o) B9 4 e

Figure 52: Room Builder: Table Setup

For each table you want to position, complete the following steps:

= [ecrease

1. Choosethe Table Type by selecting an option from the Shape drop down list.
2. Select the Table Size.

3. Select an option for the Table Orientation.

4. Select Create New Table.

The system displays a new table in the room.

5. To change the Table Size, select Decrease or I ncrease or the plus and minus signs next to
Width and Height.

6. To move thetable, select one of the directional arrows under Move Table. You can also just
drag the table to moveit.

7. To modify the table name, highlight the table.

* Update the Table Name.
» Update the Table Number.
» Select Update.

8. To delete the table, highlight the table and select Delete Table.
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9. When you have finished with the room setup, select Save Room. If you want to close the
Room Builder screen without saving changes, select Cancel.

The system displays a message notifying you that the settings have been saved. Then it returns to
the Room Setup screen.

Security Settings

The Security Settings screen allows you to control how your employees access different areas of
PointOS. It sets the minimum security level required for an employee to do each feature.

NOTE: You can set each employee’s security level from the Employee Setup screen. Refer to
“Employee Setup” on page 13 for more information.

1. To open the Security Settings screen, select Security Settings from the Setup menu.
The system displays the Security Settings screen.
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Exit Program Sales Report From Main Menu |Genera| Manager

L
L

|Level 3: Bartender =l || |revel 4: General Manager |
Level 5 - Highest Security
Tax Exempt ltem Set Customer Pricing
ILeveI 3 Bartender j ILeveI 4: General Manager j IOWHEF
Incident Report Time Clock ‘ e |
|Leve| 1: Employee j ILeveI 1: Employee j
Manager Transfer Cash Drawer ‘ save Level Names |
ILeveI & Owner j ILeveI 4: General Manager j
Mail Center Void Order
|Level 1: Employee =l || |revel 4: General Manager |
No Sale From Main Menu Void/Reduce ltem
ILeveI 3 Bartender j ILeveI 3 Bartender j
‘ Close Security Setup ‘
‘ Restore Default Levels ‘ ‘ Save Secure Area Levels ‘

Figure 53: Security Settings
First, define the Security Level Names (right side of the screen). Complete the following steps:

1. Update each name for the five levels of security available in PointOS.

2. If you have changed the security level names and want to restore the default names, select
Restore Default Names.
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3. When you have finished updating the namesto reflect your establishment, select Save L evel
Names.

Next, you define a security setting for each type of activity in PointOS.

1. Select asecurity level from each activity’s drop down list.

2. If you have changed security levelsfor activities, and want to restore the default security
settings, select Restore Default Levels.

3. When you have finished updating the security levelsto reflect your needs, select Save Secure
ArealLevels.

When you have finished defining security levels, select Close Security Setup.

Server Mode Setup

The Server Mode screen allows you to control how the POS works when in server mode. You can
put a station into server mode from the Sation Settings area of the Manager Dashboard.

1. To open the Server Mode Setup screen, select Server M ode Setup from the Setup menu.
The system displays the Server Mode Setup screen.

Point05 Professionak Manager Tools

File Edit Setup  Menu - Inventory  Activities  Reports  Sales Reports  Maintenance  Help

| Server Mode Setup C) |
Auto Lock Options Print Options Server Mode Options
Auto Lock Station In Print All Items To Printer
‘1 Minute j‘ ‘Use Menu ltem Printers j‘
¥ Go To Screen Saver
Other Options

¥ Prompt For Table Number
[ Custom Modifier Seat Numbers
[~ Allow Server Out With Open Tables

| Save Server Mode Options ‘

| Close Server Mode Setup ‘

Figure 54: Server Mode Setup
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4,
S.

Select the amount of time to allow before locking the screen automatically from the Auto
Lock Sation In drop down list.

Check the Go To Screen Saver box to start the screen saver at that time. You can change your
screen saver from the Windows Display Control Panel.

Select which printer to automatically send items ordered on a server mode station from the
Print All Itemsdrop down list. Refer to “ Setting Up a Generic Driver for Receipt Printing”
on page 164 for more information about setting up printers on the server station.

Check the Prompt For Table Number box to enable a prompt for the table number.
When you have finished with the server mode options, select Save Server M ode Options.

The system displays a message notifying you that the settings have been saved. Then it returns to
the Manager Dashboard.

If you want to close the Server Mode Setup screen without saving changes, select Close Server
Mode Setup.
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PROFESSIONAL

Overview

The Menu-Inventory Menu includes options to allow you to take advantage of the powerful
inventory control features of PointOS.

Your first step will be to create Inventory Items. These are the goods you purchase by the case,
bottle, keg, or item. Refer to “Inventory Item Setup” on page 88 for more information on setting
up inventory items.

Once you have your inventory established, you can create your Order Entry menu by creating
menu items. Menu items are the items that the server rings on the register for an order. Refer to
“Menu Setup” on page 74 for more information on setting up your menu items.

Inventory items can be menu items, but they can also be one ingredient in arecipe. Recipes are
what link inventory items with menu items. For example, you may have one vodka menu item,
but vodka may also be an ingredient in other menu items, like Long Island Ice Tea. Refer to “Item
Recipes’ on page 95 for more information on creating recipes.

Once you have linked your inventory with menu items using recipes, the appropriate inventory
count is automatically deducted when amenu item is sold. Thisinformation allows you to keep
track of your inventory counts, as well as costs for menu items. You can even print order lists.

Menu Setup

The Menu Setup screen allows you to make your own Order Entry screen. You can set prices,
modifiers, and other menu item settings. You also use this screen to navigate to the Change Menu
Item Options screen.

1. To open the Menu Setup screen, select Menu Setup from the Menu - I nventory menu.
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The system displays the Menu Setup screen.

Point05 Professionak: Manager Tools

File Edit Setup Menu-Inventory  Activities  Reports  Sales Reports Maintenance  Help

| Menu Setup ’:) |
Categories Menu ltems Change Options
Category Name
‘ Fast ‘ | Tequila ‘ I
Domestic | Whiske: ‘
v y
‘ Buttls ‘ Rename Category |
Import Bottle Cocktails ‘
‘ Move Category Up |
Sandwiches Martinis
‘ Entrees | Shots ‘ Category #3
Move Category Down |
‘ Draft Beer | Wine ‘ ‘ el
‘ Liquor ‘ | Frozen ‘ ‘ Delete Category |
‘ Vodka ‘ Non Liguor

‘ Create New Category |

‘ 1. UpP ‘ ‘[}OWN ‘ | All Stations Need To Be Restarted ‘

To Activate Menu Changes Close Category Setup |

Figure 55: Menu Setup

Categories

The |eft side of the screen lists all of your categories. You can use the UP and DOWN arrows to
navigate through along list of categories.

Define a New Category

To define a new category, complete the following steps:

1. Select Create New Category from the Change Options area.
The system displays the Add New Category dialog box.

2. Enter the Category Name.
3. Select OK.

The system displays a message notifying you that the category has been added.
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Change or Delete a Category
To change the categories, complete the following steps:

1. Highlight the name of the category you want to edit in the Categories area.
2. Edit the Category Name, if desired, and select Rename Category.

3. Toreorganizethelist of Categories, use the Move Category Up and Move Category Down
selections until the highlighted category isin the desired position in the list.

4. To delete the category, select Delete Category.

Menu ltems

When you highlight a category in the Categories area, the Menu Items associated with that
category are shown in the Menu Items area.

You can add new menu items, create shortcuts to items in other categories, or hide menu items.
Once a menu item has been created, it cannot be del eted.

Add a New Menu Item

1. From the Categories area, highlight the category in which you want the new menu item to

appear.
2. Sdlect ablank icon in the Menu ltems area.

The system displays the Add New Menu Item dialog box.

Point0S Professional: Add New Menu Item

Add New Menu ltem,
Create Shortcut,
Or Unhide A Hidden

Menu ltem
[No Menu ltem Selected = “-::hoos.e Hidden Item I
‘ Create Shortcut ‘ | Add New Item ‘ | Cancel |

Figure 56: Add New Menu Item

3. Select Add New Item.

4. The system displays the Change Menu Item Options screen. Refer to “Change Menu Item
Options’ on page 78 for more information on entering the information for the new menu item.

Create or Deletea Shortcut

Shortcuts are used when you want to include a menu item in more than one category. For
example, you may have your most used items in a category called Fast Items. Each of those items
can also appear in other categories using shortcuts.

1. From the Categories area, highlight the category in which you want the new shortcut to
appear.
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2. Sdlect ablank icon in the Menu ltems area.

The system displays the Add New Menu Item dialog box.
3. Select Create Shortcut.

The system displays another dialog box.

Point0S Professional: Add New Menu Item

Create Shortcut
To Menu Item

|No Menu ltem Selected j

‘ Create Shortcut

Figure57: Create Shortcut To Menu Item

4. Select one of your menu items from the drop down list.

5. Select Create Shortcut to include the selected menu item in this category. Select Cancel to
close the dialog box without creating a shortcut.

To delete a shortcut, compl ete the following steps:

1. From the Categories area, highlight the category in which you want to delete a shortcui.
2. Select the shortcut you want to delete.

The system displays a dialog box asking whether you want to remove the shortcut or edit the

original item.

Point0S Professional: Add New Menu Item

Shortcut To
Hamburger

Remove Shortcut | ‘ Edit Original Item ‘ ‘ Cancel |

Figure 58: Shortcut

3. Select Remove Shortcut. Select Cancel to close the dialog box without removing the

shortcut.
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Show a Hidden Menu Item

Items may be hidden from the Change Menu Item Options screen. Refer to “Change Menu Item
Options’ on page 78 for more information.

NOTE: You can use the Hide Menu Item option (on the Change Menu Item Options screen) to
rearrange the order of the menu items. After you have hidden the item, select a blank but-
ton in Menu Items area where you would like to reposition the menu item.

To unhide the item (so you can change it, moveit, or reinstate it to the Order Entry screen),
complete the following steps:

1. From the Categories area, highlight the category in which you want the hidden item to appear.
2. Select ablank button in the Menu Items area.

The system displays the Add New Menu Item dialog box.

3. Thedrop down list includes any itemsin your system that are currently hidden. Select the
desired item.

4. Select Choose Hidden Item.

Change Menu Item Options

1. From the Categories area, highlight the category in which the item you want to change
appears.

2. Select the menu item you want to change in the Menu Items area.

The system displays the Change Menu Item Options screen. Refer to “ Change Menu Item” on
page 84 for more information on changing the information for the menu item.

If the item you selected is actually a shortcut, the system displays a a dialog box asking whether
you want to remove the shortcut or edit the original item. Select Edit Original Item to open the
Change Menu Item Options screen for that item.

NOTE: You cannot delete amenu item, because if they item has previously been ordered, thiswill
negatively affect reporting.
Change Menu ltem Options

The Change Menu Item Options screen allows you to add a new menu item, course separator, or
gift card, or change or hide existing menu items. You can also use this screen to navigate to the
Modifier Setup screen or the Menu Item Recipe Setup screen for a selected menu item.

New Menu Item

To enter anew menu item, complete the following steps:

1. Open aChange Menu Item Options screen for a new item from the Menu Setup screen. Refer
to “Add aNew Menu Item” on page 76 for the steps to open the Change Menu Item Options
screen.
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The system displays the Change Menu Item Options screen for the new item.

File Edit Setup Menu-Inventory  Activities  Reports  Sales Reports Maintenance  Help

| Menu Setup O |
Categories Change Menu Item Options
Same Features As  Item Type ltem Prices
Entrees Shots Mothin «| [Menu Item - Full Price
I g J I J ¥ Discountable
Draft Beer Ving Menu Item Name Select Graphic ITE Happy Hour Price
E Employee Price Special Price
A Non Liabor Minimum Age Button Color I I
IND Age Min j [E— " User Enters ltem Price
. . Apply Taxes Auto Prices
Fruit Soups I Tax 1(3%) I~ Tax 2 (0%) Day Of The Week
[~ Tax 3 (0%) [ Tax 4 (0%) Sun  Mon Tues Wed Thur Fri | Sat
Printing Start Time End Time
tiskey | | Sandwich Additional Printer [12:00:00AM -] [12:15:00 AM -
| IND Additional Printer j Special Price Special Name
|| Desserts I Print To This Additional Printer | |
Martinis Appetizers Modifiers I" Ko Day Selected
Modifier Group -
- Edit ‘ Add UPC Bar Code ‘ ‘ Create ltem Recipe
IND Madifiers j Modifiers
I” Force Modifiers | Cancel | ‘ Hide Item | | Save ‘

Figure 59: Change Menu Item Options- New Menu Item

2. To save dataentry time, select an item from the Same Features As drop down list. Select an
item similar to the one you are entering to automatically fill in many of the required fields.

3. Toenter aregular menu item, leave the Item TypeasMenu Item.
4. Enter the Menu Item Name.
5. To associate a graphic with the menu item, complete the following steps:

» Make surethe graphic you want isin the Buttonsfolder of the PointOS Database. Many
graphics are available when you load PointOS. If you want to use a custom graphic, make
sureitisaBMP format graphic sized at 33 x 70 pixels.

e On the Change Menu Item Options screen, select Graphic.

* The system displays an aert reminding you of the size and format requirements. Select
OK.

» The system opens a Choose Button Graphic dialog box open to the Buttons folder of the
PointOS Database. Select the appropriate graphic and select Open.

» Theselected graphicisdisplayed in the Select Graphic area. It will aso show on the Menu
Setup screen for that item and the Order Entry screen for that item.
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6. If the menu item has age requirements, select the age from the Minimum Age drop down list.
By choosing aminimum age, the item will only show up for customers who have met that age
requirement.

7. To use abutton color instead of or in addition to the graphic, select a color from the Button
Color drop down list.

8. Check one or more of the appropriate boxesto Apply Taxes. These options control the sales
tax collection for the item. Refer to “ Taxes Setup” on page 38 for more information on setting
up sales tax.

9. ThePrinting area allows you to choose an additional printer. Thisis useful when afood item
is printed to the kitchen or you are using a service bar. To print the selected menu item to an
additional printer, select the desired printer from the Additional Printer drop down list and
check the Print To This Additional Printer box. Refer to “ Setup Additional Printers’ on
page 23 for more information on setting up additional printers.

10. Select an item from the M odifier Group drop down list to include a defined Modifier with
the menu item. The modifiers are setup on the Modifier Setup screen. Refer to “Modifier
Setup” on page 85 for more information.

11. Check the Force M odifier s box to open the Choose Item Modifiers dialog each time the
selected menu item is chosen during Order Entry. If you leave the box unchecked, modifiers
are still available on the Order Entry screen, but the Choose Item Modifiers dialog box does
not come up when the item is ordered.

12. Select Edit M odifier sto open the Menu Modifier Setup screen. Refer to “Modifier Setup” on
page 85 for more information.

13. Enter the [tem Prices:

» Enter the Full Price.

» Enter the price for customersidentified as your Special Discount defined on the Discount
Setup screen. Refer to “Discount Setup” on page 47 for more information.

Enter the Happy Hour price.

Enter the price for Employees.

Enter the Special Price (to be used with Auto Pricing specias).

Check the Discountable box to indicate that the item can be discounted.

To have the server or wait staff set pricing, check the User EntersItem Price box. The
price fields become the minimum price for that menu item and that type of pricing.

14. To use Auto Pricing:

First select the day of the week to use the automatic specia pricing.

Select the time to start the automatic pricing special from the Start Time drop down list.
Select the time to end the automatic pricing special from the End Time drop down list.
Enter the name of the specia in the Special Name field.

Check the Auto Price box.

Repeat for other days and times, as desired.

NOTE:If many items are on special, we recommend that you use the Happy Hour Setup instead.
Refer to “Happy Hour Setup” on page 51 for more information.
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15. To add the UPC code from a product’s packaging to the menu item, select Add UPC Bar
Code. The system displays an Add UPC Bar Code dialog box. Scan the bar code to add it to
the menu item. Using this option will allow you to scan an item to add it to a customer’s order.

16. Select Create | tem Recipe to open the Menu Item Recipe Setup screen. Refer to “Item
Recipes’ on page 95 for more information.

17. Select Hide Item to remove the item from the current position in the menu. The system
displays a warning message to confirm that you want to hide the menu item. All Shortcutsto
that menu item are also deleted. Select Yes to confirm that you want to hide the item.

18. Select Save to save the menu item or Cancel to close the Change Menu Item Options screen
without saving the item. After you save the item, the system returns to the Menu Setup screen.

Cour se Separ ator

Course Separators provide a separation between parts of ameal like appetizers, entree and
desserts. These are only seen on the kitchen prints and do not appear on the customer’s check.
They do not have any prices attached.

To use course separators, you must add them as a menu item. Complete the following steps:

1. Open aChange Menu Item Options screen for a new item from the Menu Setup screen. Refer
to “Add aNew Menu Item” on page 76 for the steps to open the Change Menu Item Options
screen.

2. Select Course Separator from the Item Type drop down list.
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The Change Menu Item Options screen displays the options relevant to a course separator.

Point05 Professionak: Manager Tools
File Edit Setup Menu-Inventory  Activities  Reports  Sales Reports Maintenance  Help

| Menu Setup C) |
Categories Change Menu Item Options
Same Features As  Item Type
Vhiske) Ithing j Course Separatorjihe Use A Course Separator To
— Split Courses On Checks
R C Menu ltem Name Select Graphic _ )
Will Show Up On ltems Printed
| E To The Kitchen But Will Not

Appear On The Guest Printed Check
Button Color

[ =]

up
| Cancel | ‘ Hide [tem | | Save ‘

3.
4.

Figure 60: Course Separator Change Menu Item Options

Enter the Menu Item Name.
To associate a graphic with the menu item, compl ete the following steps:

» Make surethe graphic you want isin the Buttonsfolder of the PointOS Database. Many
graphics are available when you load PointOS. If you want to use a custom graphic, make
sureitisaBMP format graphic sized at 33 x 70 pixels.

*  On the Change Menu Item Options screen, select Graphic.

* The system displays an aert reminding you of the size and format requirements. Select
OK.

* The system opens a Choose Button Graphic dialog box open to the Buttons folder of the
PointOS Database. Select the appropriate graphic and select Open.

* Theselected graphicisdisplayed in the Select Graphic area. It will aso show on the Menu
Setup screen for that item and the Order Entry screen for that item.

To use abutton color instead of or in addition to the graphic, select a color from the Button
Color drop down list.

Select Hide Item to remove the item from the current position in the menu. The system
displays a warning message to confirm that you want to hide the menu item. All Shortcuts to
that menu item are also deleted. Select Yes to confirm that you want to hide the item.
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7. Select Save to save the menu item or Cancel to close the Change Menu Item Options screen
without saving the item. After you save the item, the system returns to the Menu Setup screen.
Gift Card

A Merchant Warehouse account is required for using gift cards. You must acquire the gift cards
through Merchant Warehouse.

To sell gift cards, you must also add them as a menu item. Compl ete the following steps:

1. Open aChange Menu Item Options screen for a new item from the Menu Setup screen. Refer
to “Add aNew Menu Item” on page 76 for the steps to open the Change Menu Item Options
screen.

2. Select Gift Card from the Item Type drop down list.
The Change Menu Item Options screen displays the options relevant to a gift card.

Point05 Professionak: Manager Tools

File Edit Setup Menu-Inventory  Activities  Reports  Sales Reports Maintenance  Help

o

| Menu Setup

Categories Change Menu Item Options

Same Features As  Item Type
ke [Mothing | |cift card = You Can Order Gift Cards

Through Your Representative
Menu Item Name Select Graphic At Merchant Warehouse

|525 Gift Card $25 Gift Card

Or Call (800) 749-2173

Button Color

[ =]

Gift Card Price
|525

[~ Gift Card Is Discountable

up
| Cancel | ‘ Hide [tem | | Save ‘

Figure 61: Gift Card Change Menu Item Options

3. Enter the Menu Item Name.
4. To associate a graphic with the menu item, complete the following steps:

» Make surethe graphic you want isin the Buttonsfolder of the PointOS Database. Many
graphics are available when you load PointOS. If you want to use a custom graphic, make
sureitisaBMP format graphic sized at 33 x 70 pixels.
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*  On the Change Menu Item Options screen, select Graphic.

* The system displays an aert reminding you of the size and format requirements. Select
OK.

* The system opens a Choose Button Graphic dialog box open to the Buttons folder of the
PointOS Database. Select the appropriate graphic and select Open.

» Theselected graphicisdisplayed in the Select Graphic area. It will aso show on the Menu
Setup screen for that item and the Order Entry screen for that item.

5. Touseabutton color instead of or in addition to the graphic, select a color from the Button
Color drop down list.

6. Enter the Gift Card Price of the selected gift card.

7. Select Hide Item to remove the item from the current position in the menu. The system
displays a warning message to confirm that you want to hide the menu item. All Shortcuts to
that menu item are also deleted. Select Yes to confirm that you want to hide the item.

8. Select Save to save the menu item or Cancel to close the Change Menu Item Options screen
without saving the item. After you save the item, the system returns to the Menu Setup screen.

Change Menu Item

1. Open the Change Menu Item Options screen for a selected item from the Menu Setup screen.
Refer to “Change Menu Item Options” on page 78 for the steps to open the Change Menu Item
Options screen.
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The system displays the Change Menu Item Options screen for that item.

Point05 Professionak: Manager Tools
File Edit Setup Menu - Inventory  Activities  Reports

Sales Reports  Maintenance  Help
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I J I J 57.95

Vhiske Menu Item Name

Select Graphic ITE

v Discountable

Happy Hour Price
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Sandwiches Martinis Minimum Age

=

Employee Price Special Price

[s5.00

Button Color |$5.UU

IND Min Age j

. Apply Taxes

[l

[~ User Enters Item Price

[s5.00

Auto Prices
Draft Bee . M Tax 1(3%) I~ Tax 2 (0%) Day Of The Week
[~ Tax 3 (0%) [ Tax 4 (0%) Sun  Mon Tues Wed Thur Fri | Sat

- e Printing Start Time End Time

) Additional Printer [12:00:00AM -] [12:15:00 AM -
: - IND Additional Printer j Special Price Special Name
) . [~ Print To This Additional Printer I I

I” No Day Selected

Gin Fruit Soups Modifiers

Modifier Group

IEmree
¥ Force Modifiers

up DOWWN

Edit ‘ Add UPC Bar Code ‘ ‘ Create ltem Recipe ‘
j Modifiers

[cance | |

Hide Item | | Save ‘

Figure 62: Change Menu Item Options - Existing Menu Item

2. Update the menu item information as necessary. Refer to “New Menu Item” on page 78 for
more information on each part of the Change Menu Item Options screen.

Modifier Setup

Modifier groups are a collection of modifiersthat can be applied to asingle menu item or multiple
menu items. Modifiers are used to make changes to a menu item during ordering and are printed
on the customer’s receipt. Modifiers can have an additional cost associated with them, a discount
associated with them (or negative price), or no price, which would be used for the service or
kitchen staff to prepare the item. Modifiers can also change inventory depletion amountsfor items

on your menu.

1. To open the Menu Modifier Setup screen, select Modifier Setup from the M enu-Inventory

menu.
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The system displays the Menu Modifier Setup screen.

Point05 Professionak: Manager Tools

File Edit Setup Menu-Inventory  Activities  Reports  Sales Reports Maintenance  Help

| Menu Modifier Setup ’:) |
Modifier Groups Modifiers Change Options
Modifer Name
e Shetl ‘ || H || ‘ IDDmestic Beer
S ‘ || H || ‘ ‘ Rename Modifier Group ‘
I Delete Modifier Group I

Widioauon Modifier Order Does Not Matter
Modifiers Are Shown In Alphabetical Order

‘ Create New Modifier Group |

‘1, Up ‘ [ ‘| All Stations Need To Be Restarted ‘

To Activate Modifier Changes Close Modifier Setup |

Figure 63: Menu Modifier Setup

Modifier Groups

The |eft side of the screen lists all of your modifier groups. You can use the UP and DOWN
arrows to navigate through along list of groups.

Define a New Modifier Group

To define a new modifier group, complete the following steps:

1. Select Create New Modifier Group from the Change Options area.

The system displays the Add New Modifier Group dialog box.

2. Enter the Modifier Group Name. A modifier group can be named anything, but this name
must be unique. The customer does not see these names.

3. Select OK.
The system displays a message notifying you that the modifier group has been added.
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Change or Delete a Modifier Group

To change the modifier groups, complete the following steps:

1. Highlight the name of the modifier group you want to edit in the Modifier Groups area.
2. Edit the Modifier Name, if desired, and select Rename M odifier Group.

3. To delete the modifier group, select Delete M odifier Group.

Modifiers

When you highlight a modifier group in the Modifier Groups area, the Modifiers associated with
that group are shown in the Modifiers area.

You can add, change, or delete modifiers. Each group can have a maximum of 11 modifiers.

NOTE:A Custom Modifier isautomatically included in al modifier groups. The Customer Modi-
fier will allow the server to enter instructionsin the Order Entry screen.

Change M odifier Options
1. From the Modifier Groups area, highlight the group in which you want the new modifier to
appear.

2. Toadd anew modifier, select ablank icon in the Modifiers area. To change or delete an
existing modifier, select the icon for that modifier.
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The system displays the Change Modifier Options screen.

File Edit Setup Menu-Inventory  Activities  Reports  Sales Reports Maintenance  Help
| Menu Modifier Setup C) |
Modifier Groups Change Modifier Options

‘ Seer Specal ‘ Same Price As

‘ CRAFT BREW ‘ |N0thlﬂg j|

‘ Domestic Beer ‘ Modifier Name Modifier Price

‘ Entrees ‘ Name Price

| - || !

‘ Fruit ‘

Forced Sub Medifier Group _ _
‘ I ‘ Modifer Prices Can Be Bath
eor e Modifier Group Negative And Positive Amounts
Al Mo Sub Modifier Grou A
‘ Mid-Liquor ‘ | P =l Example: Half -$2.00
‘ Premium Beer ‘ Sub Modifiers Will Only
Update Inventory Of Modifers
‘ Top Shelf Liguor ‘ Set Up As Inventory ltems
‘ 1. Up ‘ Lo ‘ | | Cancel | ‘ Delete | | Save ‘

Figure 64: Change M odifier Options

3. If the modifier has the same pricing as another item, select the item from the Same Price As

drop down list to automatically fill the price field.

4. Enter or update the M odifier Name. Use something descriptive. Modifiers are shown in
alphabetical order. Modifier names are seen by servers and customers.

5. Enter or update the M odifier Price.

6. Select anitem from the Forced Sub Modifier Group drop down list to update inventory of
modifiers set up asinventory items.

7. To delete the modifier, select Delete.

8. Select Saveto savethe changes and return to the previous screen or Cancel to close the screen
without saving changes.

Inventory ltem Setup

The Inventory Item Setup screen allows you to set up your inventory control. You also use this
screen to navigate to the Change Inventory Item screen.

1. To open the Inventory Item Setup screen, select Inventory Item Setup from the Menu -

I nventory menu.
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The system displays the Inventory Item Setup screen.

Point05 Professionak: Manager Tools

File Edit Setup Menu-Inventory  Activities  Reports  Sales Reports Maintenance  Help

| Inventory ltem Setup Q |
Inventory Groups Inventory ltems Inventory Options
Budweiser Botle Inventory Group Name

IEIeer

‘ Rename Inventory Group ‘

‘ Create New Inventory Group ‘

‘ New Inventory Item ‘

‘ Edit Vendor List ‘

Open Group ‘ | Edit Inventory Item |

‘ Close Inventory Setup

Figure 65: Inventory Item Setup

Inventory Groups

The |eft side of the screen lists all of your inventory groups. Inventory Groups are used to keep
inventory items together. Inventory items must be part of an inventory group.

Define a New | nventory Group
To define a new category, complete the following steps:

1. Enter the Inventory Group Name.
2. Select Create New Inventory Group from the Inventory Options area.

The system displays a message notifying you that the inventory group has been added.

NOTE: You can also define Inventory Groups on the fly as you create new inventory items. Refer
to “Change Inventory Item” on page 90 for more information.

Change or Delete an Inventory Group
To change or delete an inventory group, complete the following steps:

1. Highlight the name of the inventory group you want to edit in the Inventory Groups area.
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2. Select Open Group.

3. Edit the Inventory Group Name, if desired.

4. To rename the group, select Rename Inventory Group. To delete the category, select Delete
Category.

Inventory Items

When you highlight an inventory group in the Inventory Groups area, the Inventory ltems
associated with that group are shown in the Inventory Items area.

To add anew Inventory Item, select New Inventory Item.

To change an existing Inventory Item, highlight it in the Inventory Items area and select Edit
Inventory Item.

Whether you are adding a new Inventory Item, or changing an existing item, the system opensthe
Change Inventory Item screen. Refer to “ Change Inventory Item” on page 90 for more
information.

Vendor List

Inventory Items must also have vendors associated with them. Select Edit Vendor List to open
the Vendor Setup screen. Refer to “Vendor Setup” on page 93 for more information about the
Vendor List.

Close Inventory Setup
When you have finished setting up your inventory, select Close Inventory Setup.

Change Inventory ltem

The Change Inventory Item screen alows you to enter the item information and specifics of each
inventory item. It also allows you to link your inventory item to menu items with single item
recipes. If you set Par Amounts, the system can make recommendations on how much of an item
you should purchase.

1. From the Inventory Item Setup screen, select New Inventory Item, or highlight the inventory
item you want to change and select Edit Inventory Item.
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The system displays the Change Inventory Item screen.

Point05 Professionak: Manager Tools

File Edit Setup Menu-Inventory  Activities  Reports  Sales Reports Maintenance  Help

| Inventory Item Setup Q |
Change Inventory Iltem Inventory Opticns
Item Infomation Inventory Specifics Inventory Group Name
Item Name Bottles Per Case I
Location Cost Per Case Rename Inventory Group
|Se|eu:1 Location I
Create New Inventory Group
Item Description Volume Per Bottle
Add UPC
| : ——
Item Inventory Group Cost Per Bottle Par Amount
Select Grou - Add Group I I
Iltem T i J I—I calculated cases New Inventory Item
ype Starting Cases
IElDttIes j
Vendor Name Loose Bottles On Hand
Select Vendor - | | Add Vendor
I J I—/ I ‘&I Edit Vendor, List

Add Single Item Reci
E 5 Starting Value On Hand
Item Name I

|Chc|nse A Menu ltem j calculated

Make [tem Inactive ‘ Cancel | ‘ Save ‘ ‘ Close Inventory Setup

Figure 66: Change Inventory Item
2. Enter or edit the Item Name.
3. Select an option from the L ocation drop down list to indicate where the item is stored.

4. To add the UPC code from a product’s packaging to the inventory item, select Add UPC Bar
Code. The system displays an Add UPC Bar Code dialog box. Scan the bar code to add it to
the inventory item. The Item Description area displays the description associated with the
UPC Bar Code.

NOTE:A UPC Bar Code isrequired to use this feature.

5. Select the appropriate Item Inventory Group from the drop down list. If you would like to
add anew group, select Add Group. The system displays adialog box. Enter the name for the
new Inventory Group and select OK.

6. Select an option from the Item Type drop down list. You can select bottles, cans, liquor, keg
beer, wine, food by case, food by item, or merchandise. The type of item influences the other
inventory specifics you will enter in a moment.

7. Select an option from the Vendor drop down list. If you would like to add a new group, select
Add Vendor. The system opens the Vendor Setup screen. Refer to “Vendor Setup” on
page 93 for more information.
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8. Inventory items should be associated with at least one menu item. Thisis done using recipes.
To add asingle item recipe association, select the appropriate menu item from the Item Name
drop down list. Refer to “Item Recipes’ on page 95 for more information on creating recipes
to link your inventory with menu items.

9. Select Make Item Inactive to remove the item from your current inventory lists.
10. Enter or update the I nventory Specifics according to the following chart:

If theltem

Typeis.. Then completethe following Inventory Specifics

Bottles, Cans, | « Enter the number of bottles, cans, or servingsin the BottlessCang/

Food by Case Servings per Casefield.

» Enter the appropriate cost in the Cost Per Case field.

» Enter the Volume per Bottle/Can. (Not applicable for Food by
Case)

» Select the Volume Measurement type from the drop down list. (Not
applicable for Food by Case)

» Thesystem calculates and displays the Cost Per Bottle/Can/Serv-
ing based on the bottles/cans/servings per case and the cost per case
amounts.

* Enter the amount you want to always have on hand in the Par
Amount field.

» Enter the amount you have now in the Starting (Full) Casesfield, if
desired.

» Enter the number of L oose Bottles/Cang/Servingson Hand, if
desired.

» Select Update to update the calculations with any new data.

The system displays the calculated Starting Value On Hand.

Liquor, Keg,
Wine

Enter the Cost Per Bottle/K eg.

Enter the Volume Per Bottle/K eg.

Select the Volume M easurement type from the drop down list.

The system calculates and displaysthe Cost Per Ounce based on the

bottle/keg volume and cost.

» Enter the amount you want to always have on hand in the Par
Amount field.

* Enter the number of full Bottles’K egs on Hand, if desired.

» For partia bottles’kegs on hand, select an amount from the Starting
Part Bottle/Keg drop down list.

» Select Update to update the calculations with any new data.

* The system displays the calculated Starting Value On Hand.
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If theltem

Typeis.. Then complete the following Inventory Specifics

Food by Item, | « Enter the number of Itemson Hand, if desired.

Merchandise |+ Select Update to update the calculations with any new data.

* Enter the Cost per Item.

* Enter the amount you want to always have on hand in the Par
Amount field.

» The system displays the calculated Value On Hand.

11. Select Saveto save your changes or Cancel to close the Change Inventory Item Setup without
saving your changes.

Vendor Setup

The Vendor Setup screen alows you to set up your vendors. You can keep track of the people you
buy from and use this information to print order sheets by vendor.

1. To open the Vendor Setup screen, select Vendor Setup from the Menu - I nventory menu.

The system displays the Vendor Setup screen.

File Edit Setup Menu - Inventory  Activities Reports  Sales Reports  Maintenance  Help
| Vendor Setup C) |
Vendors Vendor Options
Beer Distributor
Test New Vendor ‘
Open Vendor
Close Vendor Setup

Figure 67: Vendor Setup
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The |eft side of the screen lists al of your vendors.

To define anew vendor, Select New Vendor. The system opens a blank Vendor Information

screen.

To change vendor information, complete the following steps:

1. Highlight the name of the vendor you want to edit in the Vendors area.

2. Select Open Vendor.

The system opens the Vlendor Information screen for that vendor.

Close Vendor Setup

When you have finished setting up your vendors, select Close Vendor Setup.

Vendor Information

To enter anew vendor or update existing vendor information, you compl ete the Viendor

I nformation screen.

Point05 Professionak Manager Tools

File  Edit Setup  Menu - Inventory  Activities  Reports  Sales Reports  Maintenance

Help

Vendor Setup

0

Vendors

Beer Distributor

LSl

Open Vendor,

Vendor Information

Vendor Name

Account Number

Vendor Address

Vendor Phone Extension

Sales Person

Notes

‘ Cancel ‘ ‘ Save |

Vendor Options

New Vendor

Close Vendor Setup

Figure 68: Vendor Information

1. Enter the Vendor Name. Thisfield isrequired.

2. Enter your Account Number with the vendor, if desired.
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N o o b~ w

Enter the Vendor Address.

Enter the Vendor Phone Number and Extension.
Enter the name of the Sales Per son.

Enter any Notes about the vendor.

Sdlect Save to save the vendor reference information or select Cancel to close the Viendor
Infor mation without saving.

Item Recipes

The Menu Item Recipe Setup screen alows you to set up the ingredients that go into a menu item.
The system then deducts these ingredients from inventory when you sell that menu item.

1.

To open the Menu Item Recipe Setup screen, select Item Recipes from the Menu - Inventory
menul.

The system displays the Menu Item Recipe Setup screen.

Point05 Professionak: Manager Tools

File Edit Setup Menu-Inventory  Activities  Reports  Sales Reports Maintenance  Help

| Menu ltem Recipe Setup © |
Menu ltems Recipe Options
525 Gift Card -
3 OLIVES (Has Recipe) Show Menu ltem Category
3 OLIVES CHERRY (Has Re =
3 OLIVES GRAPE |Show Al =l

Absolut
Absolut Citron
Absolut Kurant |

Absolut Mandarin

Amstel Light

Anchor Steam

And Red Bull

and RedBull .

Appetizer [~ Show Hidden Menu ltems
Apple Martini
Appleton Rum
Bacardi

Bacardi 151
Bacardi Angjo
Bacardi Big Apple
Bacardi Grand Melon Set Recipe Standards
Bacardi Limon

Bacardi O

Bacardi Peach

Bacardi Razz

Bacardi Select =l

Search Menu ltems

Open ltem

Close Recipe Setup

Figure 69: Menu Item Recipe Setup

Menu Items

The |eft side of the screen lists your Menu Items. Menu items that are currently hidden are not
listed. To include hidden itemsin the list, check the Show Hidden M enu Items box.
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To narrow the list of menu items to one Menu Item Category, select a category from the Show
Menu Item Category drop down list.

To search for a specific menu item, enter one or more lettersin the Search Menu Itemsfield and
select Sear ch. The system returns the Menu Items list that include any matches of those characters
in that Menu Item Category.

To open the Item Recipe Infor mation screen for amenu item, highlight the menu item in the Menu
Items list and select Open Item. The system displays the Item Recipe Information for that menu
item.

Recipe Standards

Recipe Sandards help save time when entering recipes. Select Set Recipe Sandar ds from the
Menu Item Recipe Setup screen to open the Recipe Sandards area.

Point05 Professionak Manager Tools

File Edit Setup  Menu - Inventory  Activities  Reports  Sales Reports  Maintenance  Help

| Menu Item Recipe Setup @ |

Recipe Options
Recipe Standards

Show Menu Item Category
Standard Shot Size IShOW All j
1.25

Search Menu ltems
ounces Il

Standard Draught

ounces

|12

¥ Show Hidden Menu Items

| Save Recipe Standards

| Close Recipe Standards ‘ T

Close Recipe Setup

Figure 70: Recipe Standards
1. Enter the standard number of ouncesin the Sandard Shot Sizefield.
2. Enter the Sandard Draught Cup Size in ounces.

3. Select Save Recipe Standar dsto save the standards and return to the Menu Item Recipe Setup
screen or select Close Recipe Standar ds to close the area without saving changes.
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|tem Recipe I nformation

The Item Recipe Information screen allows you to select up to five inventory items as ingredients
in arecipe for the selected menu item. It also alows you to save serving directions and displays
the calculated cost per serving.

1. To open the Item Recipe Information screen for a menu item, highlight the menu item in the
Menu Items list on the Menu Item Recipe Setup screen and select Open Item.

The system displays the Item Recipe Information for that menu item.

File Edit Setup Menu-Inventory  Activities  Reports  Sales Reports Maintenance  Help
| Menu ltem Recipe Setup Q |
Menu ltems ltem Recipe Information ltem Recipe Directions
Jim Beam -] Ingredient 1 Serving Directions
':El;”__”_',-' - |ND Ingredient j|
Jose Cuer Ingredient 1 Amount
Kahul | ounces
Kalik
Famkaz Ingredient 2
fetel one |ND Ingredient j|
Ingredient 2 Amount
I ounces
Ingredient 3
J |ND Ingredient j|
Ingredient 3 Amount
I ounces Item Name
Ingredient 4 Meat Loaf
|ND Ingredient j| Cost Per ltem
Ingredient 4 Amount |$D.UD
I ounces calculated
PP - Ingredient 5
—AE J |ND Ingredient j| Save |ltem Recipe ‘
Open Item Ingredient 5 Amount
I ounces | Close Item Recipe ‘

Figure 71: Item Recipe Setup

2. For upto fiveingredients, select the inventory item from the I ngredient drop down lists.

3. For each selected ingredient, enter the I ngredient Amount.

4. Enter any mixing or serving directionsin the Serving Directions area. Thisinformation will be
printed along with the recipe from the Order Entry screen.

The system displays the calculated Cost Per 1tem based on the ingredients selected and the
information stored on the inventory item for each ingredient.

5. Select Save Item Recipe to save the recipe information.
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Close Recipe Setup

When you have finished setting up your recipes, select Close Recipe Setup.

Modifier Recipes

The Modifier Recipe Setup screen allows you to set up the ingredients that go into amodifier. The

system then deducts these ingredients from inventory when you sell a menu item using that

modifier. You can use modifiers to change a menu item by volume, percent, or add a new

ingredient.

1. To open the Modifier Recipe Setup screen, select Modifier Recipesfrom the Menu -

I nventory menu.

The system displays the Modifier Recipe Setup screen.

File  Edit Setup

Menu - Inventory  Activities

Reports  Sales Reports

Point0S Professionak Manager Tools

Maintenance

Help

Modifier Recipe Setup

Q|

Modifier Group

Modifiers

Beer Special
CRAFT BREW
Domestic Beer
Entrees

Food

Fruit

Import Beer
Mid-Liguar
Premium Beer
Top Shelf Liquor
Well Liquar
Wine

Open Group

Open Medifier

Modifier Recipe Options

Close Modifier Recipes

The left side of the screen lists your Modifier Groups.

Figure 72: Modifier Recipe Setup

To open the Modifier Recipe Information screen for a modifier, complete the following steps:

1. Highlight the modifier group in the Modifier Group list.

2. Select Open Group.

The system displays the modifiersin that group in the Modifiers area.
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3. Highlight the modifier you want to change in the Modifiers area.
4. Select Open Modifier.

The system displays the Modifier Options for that menu item.

Point05 Professionak Manager Tools

File Edit Setup  Menu - Inventory  Activities  Reports  Sales Reports  Maintenance  Help

| Modifier Recipe Setup O |
Modifier Group Modifier Options
CR SRE Meodifier Type Modifier Name
- Extra Cheese

Add Ingredient

on She Modifier Ingredient
\ ' . e |Test j|

Ingredient Amount

|6 ounces

| Save Modifier Recipe |

Open Group

| Close Modifier Recipes |

Figure 73: Modifier Options

The Modifier Options screen alows you to choose from several options on how the selected

modifier affectsinventory. You can change the selected menu item by increasing or decreasing the

volume (such as for ahalf drink or atall drink). You can change the menu item by having it

decrease or increase an item by a percent. You can also select to add another ingredient to a menu

item.

1. If the modifier does not affect inventory, select No Change To I nventory from the M odifier
Type drop down list.

2. To change amenu item by a percentage, complete the following steps:

» Select Change Item By Percent from the Modifier Type drop down list.
» Select Increase or Decrease from the Increase or Decrease drop down list.
» Enter the percent change in the Percent Change field.

3. To change a menu item by volume, complete the following steps:

» Select Change Item By Volume from the M odifier Type drop down list.
» Select Increase or Decrease from the Increase or Decrease drop down list.
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» Enter the percent change in the Volume Change field.
4. To change amenu item by adding an ingredient, complete the following steps:

» Select Add Ingredient from the M odifier Type drop down list.
» Select theinventory item from the M odifier Ingredient drop down list.
* Enter the amount in the I ngredient Amount field.

5. Select Save Modifier Recipe to save the recipe information.

Close M odifier Recipes
When you have finished setting up your modifier recipes, select Close Modifier Recipes.

Menu Item List

The Menu Item List shows al menu items currently in the system, including the item category,
minimum age requirements, whether there is arecipe for that item, and the cost of the item.

1. Toopenthe Menu Item List screen, select Menu Item List from the Menu - Inventory menu.
The system displays the Menu Item List screen.

Point05S Professional: Reports

Menu ltems O |

Report Options
o Select Category

|AII Categories j‘

‘ Generate Report |

‘ = Export Report To Excel |

‘ﬂ Email Report As Attachment |

‘ = | Print Report |

[

BT

Figure 74: Menu ltems

PointOS Manager Manual Menu-Inventory Menu « 100



Inventory Count

2. Tonarrow thelist of menu itemsto one Menu Item Category, select a category from the Select
Category drop down list.

3. Select Generate Report.

The system displays the menu items. Use the Up and Down arrows to navigate through the list of
menu items.

4. Toexport the report to Excel format, select Export Report to Excel. The system opens a Save
As dialog box. Enter a name for the report and select Save. The report opens in Excel format.

5. Toemail thereport, select Email Report as Attachment. The system opens the Email Report
screen. Refer to “Email Report” on page 141 for more information.

6. To print the report, select Print Report.
7. When you have finished viewing the Menu Item List, select Close Report.

Inventory Count

The Inventory Item Counts screen shows inventory items and allows you to enter physical counts
of items. You can print an inventory report and use this information to figure out your inventory
shrinkage.

You can sort the list by vendor, type, group, and/or location.

1. To open the Inventory Item Counts screen, select | nventory Count from the Menu -
I nventory menu.
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The system displays the Inventory Item Counts screen.

File  Edit Setup

Menu - Inventory  Activities

Reports

Point05 Professionak: Manager Tools

Sales Reports  Maintenance

Inventory ltem Counts

Inventory ltems

Iterm Hame Type

Group

Vendor

Budweiser Bottle Bottles

Beer

Beer Distributor

Help
@,
Inventory Count Setup
Sort By Vendor
‘AII Vendors j‘
Sort By Type
‘Bottles j‘
Sort By Group
All Groups M

Sort By Location

‘AII Locations j‘

Show Sorted Items I

Starting Inventory

Add/Remove Inventory

Full Cases

Full Cases

Last Updated |

| Find By UPC Bar Code Scan ‘

| Zero All Inventory Amounts ‘

‘ Save Inventory ltem

Close Inventory Item Counts |

To sort the Inventory Items List:

» Select avendor from the Sort by Vendor drop down list, if desired.

» Select ainventory type from the Sort By Type drop down list, if desired.

» Select agroup from the Sort By Group drop down list, if desired.

» Select alocation from the Sort By L ocation drop down list, if desired.

» Select Show Sorted Items.

» Alternatively, you can use your UPC scanner to find an item. Select Find By UPC Bar
Code Scan and scan the item’s barcode.

Figure 75: Inventory Item Counts

The system displays the Inventory Items that match your sorting requirements.

3. Highlight the Inventory Item you want to update in the Inventory Items list.

The Sarting Inventory area lists the full and partial amounts on hand for that item as of the Last
Updated date.

4. To add inventory, enter anumber in the Full and L oose fields. To remove inventory, enter a
minus sign followed by the number in the Full and L oose fields.

5. Select SaveInventory Item. Changes made to inventory from the Manager areaare available
in the Inventory Change Report.
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NOTE:To start your inventory over, select Zero All Inventory Amounts. Warning! This cannot
be undone and will reset al inventory itemsto zero.

When you have finished your inventory update, select Close Inventory Item Counts.

Print Count Sheet

Count sheets are blank worksheets that include all inventory items. Thisis useful for doing a
physical inventory count of your location.

To print the inventory count sheets, select Print Count Sheet from the Menu - Inventory menu.

NOTE: Your report printer must be setup. Refer to “Report Printer Setup” on page 30 for more
information.

The system prints the count sheets on your report printer.
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PROFESSIONAL

Overview

The Activities Menu includes options to many of the functions that you will use to schedule and
manage your bar, club, or restaurant. You can create schedules for employees and entertainment.
You can aso manage your customer information.

Adjust Time Cards

The Adjust Time Cards screen allows you to adjust, correct, or delete an employee’s time card.
1. To open the Adjust Time Cards screen, select Adjust Time Cards from the Activities menu.
The system displays the Adjust Time Cards screen.

Point05 Professionak Manager Tools

File Edit Setup  Menu - Inventory  Activities  Reports  Sales Reports  Maintenance  Help

| Adjust Time Cards O |
Clock Ins Time Card Search Time Cards
Monday 7/13/2009 - Jane Doe Employee Name
Wednesday 7/1/2009 - Jane Doe I Employee Names
|Select An Employee Name ~ ~|
Job Description/Salary I” Show Inactive Employees
| = Search By Clock In Date
Clock In I
| B
Time I j
Clock Qut
Date I j
Time I j
Total Hours

Modify Times

Modify Time Card | |Delete Time Card ‘ it o AT Eari

Figure 76: Adjust Time Cards

Find a Time Card to Adjust

The left side of the Adjust Time Cards screen lists your employees' clock in times. To search for a
particular time card in the list, complete the following steps:
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1. Select an employee name from the Employee Names drop down list. To include inactive
employeesin thelist, check the Show I nactive Employees box.

2. Select the drop down list next to Search by Clock in Date to find atime card on a specific
date. Select the appropriate date from the calendar.

3. Select Search.
The system displays any time cards that match the search criteriain the Clock Ins area.

Adjust aTime Card
To correct a past time card, complete the following steps:

1. Highlight the time card you want to adjust in the Clock Ins area.
2. Select Modify Times.

The system displays the time card details in the middle of the Adjust Time Cards screen.

3. If the employee uses more than one job description/salary, you can select a new salary from
the Job Description/Salary drop down list.

4. Changethe Clock In Time by selecting a new options from the Clock In Date and/or Clock
In Time drop down lists.

5. Changethe Clock Out Time by selecting a new options from the Clock Out Date and/or
Clock Out Time drop down lists.

The system displays the total number of hours worked.
6. Select Modify Time Card.
The system displays a message aerting you that the time card has been updated.

Deletea Time Card
To delete a past time card, compl ete the following steps:

1. Highlight the time card you want to delete in the Clock Ins area.
2. Select Delete Time Card.

The system displays a warning message to verify that you want to delete this time card.
3. Select Yesto continue or No to close the warning without deleting the time card.
The system displays a message aerting you that the time card has been deleted.

Closethe Time Cards
When you have finished adjusting time cards, select Close Adjust Time Cards.
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Employee Schedule

The Employee Schedul e screen allows you to set up the weekly schedule for employees.
Employees can view this schedule from the Time Clock area of PointOS.

1. To open the Employee Schedule screen, select Employee Schedule from the Activities menu.

The system displays the Employee Schedul e screen.

File Edit Setup Menu - Inventory  Activities Reports  Sales Reports  Maintenance  Help
| Employee Schedule O |
| 4 BackOne Week | Week Starting Sunday, July 19, 2009 Forward One Week |
Sunday Monday Tuesday Wednesday Thursday Friday Saturday
1119/09 7120109 1121/09 1122109 1123109 7124109 1125109
‘ Add | ‘ Add | | Add ‘ ‘ Add | | Add ‘ ‘ Add ‘ ‘ Add ‘
Add To Schedule
Time In Time Out Employee
Copy PreviousWeek | | 12.00 pm  ~| [12:00pm ~ ‘Select Employee Name j‘ ‘ LCrpyJusmt biss ‘
=7 Email Schedule To All Employees ‘ | Go To Current Week ‘ ‘ Save ‘ ‘ Done |

Figure 77: Employee Schedule

Navigate the Employee Schedule

1. Select Back One Week to go to the previous week’s schedule.

2. Select Forward One Week to go to the next week’s schedule.

3. Select Go To Current Week to return to the schedule for the current week.

Create an Employee Schedule
Complete the following steps to create an employee schedule.

1. Select the employee from the Employee drop down list.
2. Select the starting time from the Time I n drop down list.
3. Select the ending time from the Time Out drop down list.
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4. Select Add on the day(s) to add that employee at the selected time.

5. Repeat for al the days that employee works, selecting anew Time In and Time Out for
different days as necessary.

6. Repeat for al of the employees.

7. Select Save to save the schedule information.

You can also speed scheduling up by copying a schedule.

1. Select Copy Previous Week to copy the previous week’s schedul e to the current week.
2. Select Copy To Next Week to copy the current schedul e to the next week.

Email the Schedule to Employees

You can email the employee schedule to all employees that have an email addresses in the
employee profile.

NOTE: You must have set up email on your system. Refer to “Email Setup” on page 49 for more
information.

1. Select Email Scheduleto All Employees.

Close the Employee Schedule
When you have finished creating the employee schedule, select Done.

View Schedule Requests

If employees want to change their schedules, they can make schedul e requests from the Time
Clock area. The View Schedule Requests screen allows you to review, approve, or decline
employee scheduling requests to help in creating your employee work schedule. The system
notifies employees about the status of their requests.

1. To open the View Schedule Requests screen, select View Schedule Requests from the
Activities menu.
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The system displays the View Schedule Requests screen.

Point05 Professionak: Manager Tools

File Edit Setup Menu-Inventory  Activities  Reports  Sales Reports Maintenance  Help

| Schedule Requests
Requests

Pointos Administrator (Declinec
Pointos Administrator (Mot Rea
Jane Doe (Mot Read)

o

Open Request

Close Schedule Requests

Figure 78: Schedule Requests

The system displays alist of any schedule requests, including the status of the request, in the
Requests area.

1. Highlight the request you want to review.
2. Select Open Request.
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The system displays the Request I nformation.

File  Edit

Point05 Professionak: Manager Tools

\dministrator (Mot Rea

Open Reguest

Setup  Menu - Inventory  Activities  Reports  5ales Reports  Maintenance  Help
| Schedule Requests © |
Requests Request Information Manager Response
Pointos Administrator (Decling

Employee Name

IJane Doe

Requested Start Date

[Monday 7/20/09
Requested End Date

[Monday 7/20/09
Description

OFF BY THREE FOR DR

Request Made On

Manday 7/20/09

Response Description

Response Made On

Decline Request [x] ‘

Approve Request v ‘

Close Schedule Request ‘

Figure 79: Request I nformation

The Request Information includes the employee's name, the start date of the request, the end date
of the request, a description of the request, and the date the employee made the request. To

respond to the request, complete the following steps:

1. Enter amessage to describe your response, if desired, in the Response Description.
2. To decline the request, select Decline Request. To approve the request, select Approve

Request.
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When the employee goes to the Time Clock area, the system displays a message indicating
whether the request is approved or declined, with any description you provided in the Response
Description. The employee can reply if necessary.

Point0S: Read Message

Recieved Message 1: From Pointos Administrator

Your Schedule Request For
Monday 7/20/09 To Monday 7/20/09
Has Been Approved

Manager Comment:

‘Ol Reply ‘J Done

Figure 80: Schedule Request M essage

Close the View Schedule Requests Screen
When you have finished viewing arequest, select Close Schedule Request.
Select Close Schedule Requests to close the screen.

Customer Activities

The Customer Activities screen allows you to see alist of customers, search for an existing
customer, or add a new customer.

1. To open the Customer Activities screen, select Add/Edit Customer s from the Activities
menu.

PointOS Manager Manual Activities Menu « 110



Customer Activities

The system displays the Customer Activities screen.

Point05 Professionak: Manager Tools

File Edit Setup Menu-Inventory  Activities  Reports  Sales Reports Maintenance  Help

| Customer Activities O |

Customers Customer Options

‘ Add New Customer ‘
Mary Blue

Plck Customer
Rodger Green |Se|ect Customer Name j

Search Customers
Steve White I

First Name j

| Search |

Quick Search First Name

ABCDEFGHI JKELMNOPQRETUVWIYZ

Quick Search Last Name

ABCDEFGHI JKLMNOPQRSTUVWXYZ

‘ Close Customer Maintenance

All Stations Need To Be Restarted To Activate Customer Changes

Figure 81: Customer Activities

The Customers area lists the customersin your system. Use the Up or Down arrows to navigate
through the list.

To find a specific customer, you can select the customer’s name from the Pick Customer drop
down list. Or complete the following steps to search for a customer.

1. Enter one or more lettersin the Search Customersfield.

2. Select whether those letters are from the customer’s first name or last name from the drop
down list.

3. Select Search.
The system displays the customer record(s) that match your search criteriain the Customers area.

You can also select aletter from the Quick Search First Name or Quick Search Last Nameto
narrow the list to customers whose name starts with the selected letter.

To open the Change Customer Options screen, select the customer you want to update or select
Add New Customer. Refer to “ Change Customer Options’ on page 112 for more information.

When you have finished viewing the customer list, select Close Customer M aintenance.
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Change Customer Options

The Change Customer Options screen allows you to maintain several details about your
customers, including a scanned driver’s license and setting special customer pricing. If you want
to scan the customer’s driver’s license, you must have a compatible scanner. Add the customer
from the front end Order Entry - Sart New Tab - New Customer screen. The New Customer
screen on the front end isthe only entry point for photos. Then you can view the data on this

screen.

NOTE:Make sure to get the customer’s permission before collecting his or her data. You must
follow all local and federal privacy laws.

1. To open the Change Customer Options screen, go to the Customer Activities screen and select
the desired customer or select Add New Customer.

The system displays the Change Customer Options screen.

Point05 Professionak: Manager Tools

Banned Reason

[~ Customer |s Banned

Cell Phone Number

Email Address

¥ Subscribed To Newsletter

File Edit Setup Menu-Inventory  Activities  Reports  Sales Reports Maintenance  Help
| Customer Activities Q |
Change Customer Opticns
Customer Information Customer Address Customer Photo
First Name Last Name Street Address
Ir'u"lary Blue |250 SW 3RD AV E APT 2 View
No Photo Customer
Date Of Birth Apartment Number Scanned Driver's
License
18/26/1971 | ]
Driver's License Number City
Customer Price Level
I IHD”WDDEI
IEmpIDyee j

Customer Since State Zip Code
|9/6/2007 | || [Frorida | [33312 Customer Notes

N Causes Problems ;I
Banned Date Employee Contact Infomation -
| | Home Phone Number Custom Field 1
Banned By I I

Custom Field 2

Delete Customer ‘

Cancel

‘ | Save ‘

Figure 82: Change Customer Options
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Enter New Customer or Update Existing Customer

1.

10.

Enter or update the Customer I nformation:

e Enter the customer’s First Name.

» Enter the customer’s Last Name.

* Enter the day/month/year of the customer’s Date of Birth or select the drop down arrow
to use the calendar.

» Enter the customer’s Driver’s License Number.

Enter or update the Customer Address:

» Enter the customer’s Sreet Address.

» Enter the customer’s Apartment Number, if applicable.
» Enter the customer’s City.

o Select the customer’s Sate from the drop down list.

» Enter the customer’s Zip Code.

Enter or update the Employee Contact I nfor mation:

* Enter the customer’s Home Phone Number.
e Enter the customer’s Cell Phone Number.
* Enter the customer’s Email Address.

Check the Subscribed to Newsletter box to put the customer on the newsdletter mailing list. If
the customer wants to unsubscribe, uncheck the box to remove the customer from the
newsletter mailing list.

If you have added the customer from the front end Order Entry - Start New Tab - New
Customer screen, the photo is displayed here.

If the customer’s driver’s license has been scanned, select View Customer’sDriver’s
License to see the Driver’s License Photo screen. Select Close when you have finished
viewing the license.

To give the customer special pricing, select apricing option from Customer Price Level drop
down list.

Enter any notes you’'d like to keep about the customer in the Customer Notesfield.

To include additional information about the customer, you can enter it in Custom Field 1 or
Customer Field 2.

Select Save button to complete the Change Customer Options screen or select Cancel to close
the Change Customer Options screen without saving.

Ban Customer

To ban a customer, compl ete the following steps:

1.

Check the Customer is Banned box.

The system enters the date and the name of the employee who banned the customer.

2.

Enter areason for banning the customer in the Banned Reason field.

To unban the customer, uncheck the Customer is Banned box.
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3. Select Save button to complete the Change Customer Options screen or select Cancel to close
the Change Customer Options screen without saving.

Delete Customer

1. Select Delete Customer.

The system displays awarning to verify that you want to delete this customer.

2. Select Yesto continue or No to close the warning without deleting the customer.

Customer Mail List

The Customer Mail List screen allowsyou to view amailing list of all customersin your database.
Thislist can be exported to several different formats or used to create mailing address |abels.

1. To open the Customer Mail List screen, select Customer Mail List from the Activities menu.

The system displays the Customer Mail List screen.

File  Edit Setup

Menu - Inventory  Activities

Reports  Sales Reports

Point0S Professionak Manager Tools

Maintenance

Help

View Customer List

Customer Mailing List

Mary Blue
250 5W IRD AVEAPT 2

Holywaod, Flod3di2

Steve Whits
123 ZND STREET

Fort Lasderdale, FL 33212

Back Page

Rodger Green

2500 E 45TH AVE

MNewington, Cofsdticut

Page 1 Of1

0

-

Ad

Hext Page

Customer List Options

Print Customer List ‘

Export Customer List

Export To HTML ‘

Export To PDF ‘

Export To RTF ‘

Zoom Customer List

%
‘ Zoom In ‘ ‘ Zoom Out ‘
Zoom To Fit Page ‘
‘ First Page ‘ ‘ Last Page ‘

Close Customer List |

Figure 83: View Customer List
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Customer Mailing List

The |eft side of the screen shows the customer mailing list. You can use the Back Page and Next
Page arrows to navigate through several pages of customer labels. Select First Page to go to the
first page of the list. Select L ast Page to go to the last page of thelist.

To print the customer mailing list on Avery Mailing Labels, select Print Customer List.
To change the view of the customer mailing list, you can use the Zoom features:

» Select Zoom In one or more times to enlarge the view of the customer mailing list.
» Select Zoom Out one or more times to reduce the view of the customer mailing list.
» Select Zoom to Fit Pageto return the view of the customer mailing list to one page width.

Export Customer List

You can export your customer list to three different formats:

» To open the customer list in HTML (in your default web browser), select Export toHTML.

* To open the customer list in Adobe PDFO, select Export to PDF.

» To open the customer list in your default word processor in the RTF format, select Export to
RTF.

Close Customer List
When you have finished viewing the customer list, select Close Customer List.

Send Email Newsletter

You can easily add a customer’s email address on the New Customer screen of the front end of
PointOS. With customers email addresses, you can send an html newsletter. Using the send
newsletter feature of PointOS is an easy way to increase your sales, by staying in touch with your
customers. Let them know your entertainment schedule, news, specias, or other information.

The Send Newsletter screen allows you to write, format, and send an html newsletter to your
customers.

1. To open the Send Newsletter screen, select Send Newsletter from the Activities menu.
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The system displays the Send Newsletter screen.

PointDS Professionak Send Newsletter

Send Newsletter Q |

;I Newsletter Options

. Main Options
2120 58th Avenue Abc Bar And Grill NEWSLETTER P
Suite 218 1123109
Body Colors
Font Colors
REMOVE
If you '.\.':}lul::l like to Newsletter Content
be removed please
click here and
f:}II'T}'.\.'thE!'Em:wal Calendar
instructions.
Generated By Point0S Professional Copyright @ 2009, All Rights Reserved Main Body

Preview
Newsletter
=
= Recipient List ‘ ‘ B Save Options ‘ ‘3 Send Newsletter Now‘ ‘ Close Send Newsletter

Figure 84: Send Newsdletter
You can preview your newsletter from any newsl etter screen by selecting Preview Newsletter.

Overview of Newsletter

You can save atemplate for your newd etters to use the same options and colors every time you

send anewsletter. Once you have set the look of the newsdl etter, you save those options. Then you
can add content, including a preset entertainment calendar, for a specific newsdl etter. After creating
your content, you select the recipients to receive the newsletter. Then you can send the newsdl etter.

Before you can send newsd etters, make sure you have set your SMTP address on the Email Setup
screen. Refer to “Email Setup” on page 49 for more information.
Main Options

You will need to set your Main Newsletter Options first. These include the name of your
company, address, logo, etc.

To open the Main Newsletter Options, go to the Send Newsletter screen and select Main Options.
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The system displays the Main Newsletter Options screen.

PointDS Professionak Send Newsletter

Send Newsletter ’:) |
Main Newsletter Options Newsletter Options
Company Information ———
Company Name Main Options
|Abc Bar And Grill No Logo
Choose Logo Selected
Address 1 =EEE Body Colors
2120 58th Avenue
Address 2 logo size must be 140 x 90 Eont Colors
|Suite 218 and be in .jpeg or .jpg format
" Newsletter Content
Newsletter Tagline Website URL {optional)
! |www._pointos.com Calendar
Email Information ) ) )
Newsletter Return Email Address I Link To Map Website (optional) Main Body
Newsletter Unsubscribe Email Address examples: Google Maps, Yahoo Maps
I ‘ Reset Defaults |

Preview

‘ Close Main Options

Newsletter

‘ = Recipient List ‘ ‘ B Save Options ‘ ‘3 Send Newsletter Now‘ ‘ Close Send Newsletter

Figure 85: Main Newsletter Options

The system displays the Company Information stored in PointOS.

1. If you wish your Company Information to appear differently on your newdetter, you can

changeit:

» Update the Company Name.
e Updatethe Address (line 1 and 2).

Enter aNewsletter Tagline, which will appear at the bottom of the newsletter. You may wish
to use your company slogan.

Customers will be able to see the email addresses on your newsletter, so you may not want to
use the same address that you use for reporting. To change the addresses:

* Update the return email address for customer email commentsin the Newsletter Return
Email Address.

» Update the customer unsubscribe email address to allow customers on your list to
unsubscribe from your newsletter in the Newsletter Unsubscribe Email Address.
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4. Toinclude acompany logo on the newsletter, complete the following steps:

* Makesureyou have saved your graphic in jpg format with an image size of 140 x 90 in the
Backgrounds folder of your database.

» Select Choose L ogo.

» Thesystem displays an alert notifying you to make sure your graphic isin the right format
and in the correct location. Select OK.

* The system opens the Choose Newsdletter Logo Graphic dialog box, open to the correct
location. Choose your graphic and select Open or select Cancel to return to the Main
Newsletter Options screen.

» The system displays the selected logo on the Main Newsletter Options screen.

5. If you want to include alink to your website on the newsdl etter, enter the Website URL .
6. If youwant to include alink to a map on the newdletter, complete the following steps:

* Find your location using a map service like Google or Yahoo.

* Copy theaddresslink into the Link to Map Website field of the Main Newsletter Options
screen.

7. To reset the Main Options to the defaults, select Reset Defaults.
8. When you have finished selecting the Main Options, select Close Main Options.
Body Colors

Next, you can select the look for your newsletter by selecting the body colors.

1.

To open the Newdletter Body Colors, go to the Send Newsletter screen and select Body
Colors.
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The system displays the Newsletter Body Colors screen.

Point05s Professionak Send Newsletter
Send Newsletter C) |
Newsletter Body Colors Newsletter Options
Body Colors Preview
Main Background Main Options
| |=
Header Background Body Colors
. Font Colors
Side Background
I ~
I J Newsletter Content
Side Background Squares Eallan i
[ =]
footer
Center Background ) Main Body
|| 5 Link Color
Active Link Color Visited Link Color
Center Background Squares
‘ Reset Defaults |
[ = .
Preview
‘ Close Body Colors Newsletter
= Recipient List ‘ ‘ B Save Options ‘ ‘ =7 Send Newsletter Now ‘ ‘ Close Send Newsletter

Figure 86: Newsletter Body Colors

2. Usethe drop down arrows to select a color choice for each option. The Preview area shows
how the newsdletter colors will appear.

3. Toreset the colorsto the defaults, select Reset Defaults.
4. When you have finished selecting the Body Colors, select Close Body Colors.

Font Options
Next, you can continue refining the look for your newsletter by selecting the font colors.
1. To open the Newsletter Font Colors, go to the Send Newsletter screen and select Font Colors.
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The system displays the Newsletter Font Colors screen.

Point05 Professionak: Send Newsletter
Send Newsletter ’:) |
Newsletter Font Colors Newsletter Options
Font Colors Preview
Header Font Main Options
| | =
I J header color
Side Header Font Body Colors
| I - |
. Font Colors
Side Square Font
I
I J Newsletter Content
Center Square Font Eallan i
| I - |
footer
Link Font . Main Body
S - Link Color
Active Link Color Visited Link Color
Active Link Font
- | | ResetDofauts_|
Preview
PCELE UTr iy ‘ Close Font Colors Newsletter
|_ 'l
= Recipient List ‘ ‘ B Save Options ‘ ‘ =7 Send Newsletter Now ‘ ‘ Close Send Newsletter

Figure 87: Newsletter Font Colors

2. Usethe drop down arrows to select a color choice for each option. The Preview area shows
how the newsdletter colors will appear.

3. Toreset the colorsto the defaults, select Reset Defaults.
4. When you have finished selecting the Font Colors, select Close Font Colors.

Save Options

After you have set your Main Options, your Body Colors, and your Font Colorsfor the newsletter,
select Save Optionsto keep your selections for future newsl etters.

NOTE: The Calendar and Main Body content cannot be saved using the Save Options button.

Calendar

Use the Calendar feature to add your Entertainment Schedule to your newsletter. Make sure you
have completed your Entertainment Schedule for the week you want to include in the newsl etter
first. Refer to “ Entertainment Schedule” on page 127 for more information.

1. To open the Newsletter Calendar, go to the Send Newsletter screen and select Calendar.
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The system displays the Newsletter Calendar screen.

Send Newsletter ":) |
Newsletter Calendar Newsletter Options
Sunday Monday Tuesday Wednesday Thursday
Main Options
Body Colors
Font Colors
Newsletter Content
| Clear | | Clear | | Clear | | Clear | | Clear
X Calendar
Friday Saturday
\Add A Calendar Week M
Main Body
‘ Update Newsletter Calendar ‘
| Clear All ‘
Preview
‘ Close Calendar ‘ Newsletter
| Clear | Clear |
= Recipient List ‘ ‘ B Save Options ‘ ‘ =7 Send Newsletter Now ‘ ‘ Close Send Newsletter

Figure 88: Newsletter Calendar

2. Select aweek to include in the newdetter from the Add A Calendar Week drop down list.

3. Select Update Newdletter Calendar to add the entire entertainment schedul e for the selected
week to the newsletter.

4. To manually enter itemsto the calendar, enter the desired text under that day.

5. To clear aselected day from the calendar, select Clear under that day. To clear the entire
calendar, select Clear All.

6. When you have finished updating the entertainment schedule calendar, select Close
Calendar.

Main Body

Use the Main Body feature to write your newsletter content.

1. To open the Newsletter Content, go to the Send Newsletter screen and select Main Body.
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The system displays the Newsletter Content screen.

Send Newsletter ":) |
Newsletter Content Newsletter Options
Content Box 1 Content Box 2 _—
IADOUT Us Clear INEWS Clear Main Options
Body Colors
Font Colors
Content Box 3 Content Box 4 Newsletter Content
Everts Clear | |Other Information Clear Calendar
Main Body
You can use html in ‘ Clear All ‘ Preview
the content boxes ‘ Close Content ‘ Newsletter
Use <BR> for line breaks
= Recipient List ‘ ‘ B Save Options ‘ ‘ =7 Send Newsletter Now ‘ ‘ Close Send Newsletter

Figure 89: Newdletter Content
There are four boxes available for the newsd etter.

2. You can use the default header names of “About Us,” “News,” “Events,” and “ Other
Information,” or you can give each header a custom name by replacing the name with new
text.

3. For each box, enter the text in the content box. You can use html coding to enhance your
content, including links to websites or graphics (must be posted on the web). Use <BR> for
line breaks. Select Clear from each box to remove the text from that box.

4. Select Clear All to remove all text from content boxes.
5. When you have finished updating the content, select Close Content.

Send to Recipients
Use the Recipient List feature to manage your customer email list.

1. To open the Choose Newsletter Recipients, go to the Send Newsletter screen and select
Recipient List.
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The system displays the Choose Newsletter Recipients screen.

Send Newsletter C) |
Choose Newsletter Recipients
Customers Recipients
Mary Blue - maryblue123@yahoo.com Add New Recipient
Rodger Green - green5678@sbcaglobal.net Full Name
Email Address
‘ Add Email = |
‘ Add Selected = |
‘ Add All = |
‘ 4= Remove Selected |
‘ &= Remove All |
Hold Down Shift To Mutli Select Customers ‘ Close Choose Recipients

Figure 90: Choose Newsdletter Recipients
The left side lists your customer names and email addresses.

2. To add customersindividually to the newdletter recipient list, highlight the customer namein
the Customers area. You can hold down the SHIFT or CTRL keys to select more than one
customer. Select Add Selected. To remove one or more customers from the newsl etter
recipient list, highlight the customer name(s) in the Recipients area and select Remove
Selected.

NOTE: Customers who have unsubscribed will not appear on thislist.

3. To add all customersto the newdletter recipient list, select Add All. To remove all customers
from the newsletter recipient list, select Remove All.

4. To manually add a customer email address that does not appear in the Customers area,
complete the following steps:

* Enter the customer’s Full Name.
e Enter the customer’s Email Address.
¢  Sdect Add Email.

5. When you have finished selecting the newsletter recipients, select Close Choose Recipients.
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6. Select Send Newsletter Now on the Send Newsd etter screen to send the newsd etter to the
selected recipients.

Unsubscribe Newsletter Customers

NOTE:This screenisonly available if you are using PointOS DoorMan as one of your licensed
stations.

The Unsubscribe Newsl etter Customers screen allows you to subscribe or unsubscribe your
customersto your HTML newsletter. Email Settings must be correctly setup for this to work.
Refer to “Email Setup” on page 49 for more information.

1. To open the Unsubscribe Newsl etter Customers screen, select Unsubscribe Customer s from
the Activities menu.

The system displays the Unsubscribe Newsletter Customers screen.

Point05 DoorMan: Manager Tools

File Edit Setup Menu-Inventory  Activities  Reports  Sales Reports Maintenance  Help

Unsubscibe Newsletter Customers O
Customers Customer Options
- Mary Blue - maryblue123@yahoo.com (Not Subscribed) Search Customers
- Rodger Green - green5678@sbcglobal.net (Not Subscribed) I |First Name j
IUnsubscribed Customers j

[ Filter Customer Search |

Unsubscribe Selected X | | Subscribe Selected ' |

Hold Down Shift To Mutli Select Customers ‘ Close Unsubscribe Customers

Figure 91: Unsubscribe Newdletter Customers

Find Customer
The Customers area lists the customersin your system for whom you have email addresses.
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2. Tofind a specific customer, use the Customer Options.

» Enter one or more letters of the customers name in the Search Customer sfield and select
which name it is from the drop down list.

» Tofilter thelist of names, select an option from the Unsubscribed Customer sdrop down
list.

o Select Filter Customer Search. The system displays the customers that match your
search criteriain the Customers area.

Subscribe or Unsubscribe Customer

1. Highlight the customer whose subscription status you want to change in the Customers area.
To select more than one customer, hold down the Shift key while selecting the customers.

2. To unsubscribe the selected customers from the email newsletter list, select Unsubscribe
Sdlected. To add the selected customers to the email newsletter list, select Subscribe
Sdlected.

Close Unsubscribe Customers

When you have finished working with customer newsletter subscriptions, select Close
Unsubscribe Customers.

Manage Memberships

NOTE: This screen isonly available if you are using PointOS DoorMan as one of your licensed
stations.

The Manage Member ships screen allows you to manage your customer memberships.

1. To open the Manage Member ships screen, select Manage M ember ships from the Activities
menul.
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The system displays the Manage Member ships screen.

Point05 DoorMan: Manager Tools

File  Edit Setup  Menu - Inventory  Activities  Reports  Sales Reports  Maintenance

Help

| Select A Customer

Select Customer ‘

‘ =) Print Membership Card ‘

| B Update Member Information ‘

| Manage Memberships Q |
Customers Customer Information Search Customers
Mary Blue Customer Name
Rodger Green Customer Names
Steve White I j
Michele Wiedemer
Membership Information I Show Non Members
Membership T
| S J Search By Membership Date
Number Of Allowed Guests
| 3
Membership Begins - Ends
Begin I j
Expires I j

‘ Close Manage Memberships

Find Customer

The Customers area lists the customers in your system.

2. Tofind aspecific customer, use the Search Customers.

» Select the Customer Name from the drop down list.
»  Check the Show Non M ember s box to include al customersin thelist.
» To search by Member ship Date, select the drop down arrow to choose the date from the

caendar.

Figure 92: Manage M ember ships

» Select Search. The system displays the customers that match your search criteriain the

Customers area.

Update M ember ship I nformation

1. Highlight the customer you want to update in the Customers area.
2. Choose Select Customer.

The Customer Information area displays the membership information for that customer, including
anotation if the customer is not a member.
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3. To change the membership type or create a membership for the selected customer, select a
Member ship Type from the drop down list. If you are creating a new membership, the
system displays awarning to verify you want to create a new membership. Select Yesto
continue, or No to close the warning without creating a new membership.

4. Select the Number of Allowed Guests from the drop down list.

5. Enter the M ember ship Begin Date. You can use the drop down list to select the date from the
calendar.

6. Enter the Membership End Date. You can use the drop down list to select the date from the
calendar.

7. Select Update M ember ship I nformation to save the changes.

Print Member ship Card
NOTE: To print membership cards, you must have a compatible id card printer.

1. Highlight the customer for whom you want to print a membership card in the Customers area.
2. Choose Select Customer.
3. Select Print Membership Card.

The system displays the Print Membership Card screen.

Point0S DoorMan: Print Membership Card

Member Name
| Mary Blue |

Membership Started
| 7/30/2008 |

Membership Expiration
| 713112010 |

‘ =3 Print Membership Card ‘

Figure 93: Print Membership Card
4. Select Print Membership Card to print the card or Cancel to close the screen without
printing the card.
Close M anage M ember ships
When you have finished working with memberships, select Close M anage M ember ships.

Entertainment Schedule

The Entertainment Schedule screen alows you to set up the weekly entertainment schedule.
Employees can view (or print for customers) this schedule from the Time Card area.

1. To open the Entertainment Schedule screen, select Entertainment Schedule from the
Activities menu.
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The system displays the Entertainment Schedule screen.

Point05 Professionak: Manager Tools

File Edit Setup Menu-Inventory  Activiies Reports  Sales Reports  Maintenance  Help

| Entertainment Schedule O |
| 4  BackOne Week | Week Starting Sunday, July 19, 2009 Forward One Week |
Sunday Monday Tuesday Wednesday Thursday Friday Saturday
1119/09 7120109 1121/09 1122109 1123109 7124109 1125109
‘ Add | ‘ Add | | Add ‘ ‘ Add | | Add ‘ ‘ Add ‘ ‘ Add ‘

Add To Schedule

Category Pay Out Message
|Type Or Select Category j‘
Entertainment Name
‘ Copy Previous Week | j‘ Pay Out Amount ‘ Copy To Next Week ‘
Start Time End Time I
12200 pm - |1 2200 pm -~ | Update Entertainment Info |
‘ Go To Current Week | ‘ Save | ‘ Done |

Figure 94: Entertainment Schedule

Navigate the Entertainment Schedule

1. Select Back One Week to go to the previous week’s schedule.

2. Select Forward One Week to go to the next week’s schedule.

3. Select Go To Current Week to return to the schedule for the current week.

Create an Entertainment Schedule

Complete the following steps to create an entertainment schedule.

1.

Select the category from the Category drop down list or create anew category by entering the
name.

Select the entertainment name from the Entertainment Name drop down list or create a new
item in the selected category by entering the name.

Select the starting time in the Start Time field.
Select the ending time in the End Timefield.

To include a pay out message for this entertainment, enter the message in the Pay Out
Message field.
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6. To indicate the pay out amount for this entertainment, enter the amount in the Pay Out
Amount field.

7. Select Update Entertainment Info to save the entertainment.
8. Select Add on the day(s) to add that entertainment at the selected time.

9. Repeat for multiple days, selecting anew Sart Time and End Time for different days as
necessary.

10. Repeat for all of the entertainment you have scheduled for the week.
11. Select Save to save the schedule information.

You can also speed scheduling up by copying a schedule.
1. Select Copy Previous Week to copy the previous week’s schedule to the current week.
2. Select Copy To Next Week to copy the current schedule to the next week.

Close the Employee Schedule
When you have finished creating the employee schedule, select Done.

View Song List

The View Song List screen alows you to view alist of all songsin your database. Thislist can be
printed or exported to several different formats.

1. To open the View Song List screen, select View Song List from the Activities menu.
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The system displays the View Song List screen.

Point05 Professionak: Manager Tools

File Edit Setup Menu-Inventory  Activiies Reports  Sales Reports  Maintenance  Help
| View Song List O |
= Song List Options

‘ Print Song List ‘

PointOS Song List

Export Song List
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1 Cam's Blues Agnon Goldoerg

3 Amada Alsra Cug ‘ Export To HTIML ‘
H Desperiar Alsna Duo

H i D Yo (LI Chikd) ¥a0l Kuhe And Bamata

4 Ka Barra [Your Work) Hailo Koké And Bamada

[ Distance Karsn Kale ‘ Export To PDF ‘
7 Cne Step Bepond Karsn Kale

3 Wiz Bodelra Luglana Souza

] Sympnony_No_3 Nioulaus Estermazy Sifnia

] Gus No Artist ‘ Export To RTF ‘
10 Guess You're Right The Paskes
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Zoom Song List

61%
[t ‘ Zoom In ‘ ‘ Zoom Out ‘
‘ Zoom To Fit Page ‘
First Page ‘ ‘ Last Page ‘

Back Page Page 1 Of 1 Hext Page ‘ Close View Song List |

Figure 95: View Song List

PointOS List

The left side of the screen shows the song list. You can use the Back Page and Next Page arrows
to navigate through several pages of your song list. Select Fir st Page to go to the first page of the
list. Select Last Page to go to the last page of thelist.

To print the song list, select Print Song List. You must have set up your report printer. Refer to
“Report Printer Setup” on page 30 for more information.

To change the view of the song list, you can use the Zoom features:

» Select Zoom In one or more times to enlarge the view of the song list.

» Select Zoom Out one or more times to reduce the view of the song list.

» Select Zoom to Fit Pageto return the view of the song list to one page width.
Export Song List

You can export your song list to three different formats:

» Toopenthesonglistin HTML (in your default web browser), select Export to HTML.
» To open the song list in Adobe PDFO, select Export to PDF.
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* Toopenthesong list in your default word processor in the RTF format, select Export to RTF.

Close Song List
When you have finished viewing the customer list, select Close View Song List.

Manage Payouts

Pay outs are the system’s way of keeping track of the amount of money you should have on hand
after you have paid someone cash. Pay outs can be done in two ways: by a manager in the back
end, or by a manager or server from a cash drawer.

The Manage Pay Outs screen allows you to create, manage, change, or void pay outs made in the
system. Unlike the Delete Pay Out area on the Manager Dashboard, you can edit pay outs from
any drawer, even if it has been closed.

1. To open the Manage Pay Outs screen, select Manage Pay Outs from the Activities menu.
The system displays the Manage Pay Outs screen.

Point05 Professionak Manager Tools

File  Edit Setup Menu-Inventory  Activies FReports SalesReports  Maintenance  Help

| Manage Pay Outs C) |
Pay Outs Pay Out Categories
Date Time: Category Pay Out To Anmount
T123/08 11:48AM  Band Pencils With Lead $1.00 Band
DJ
Misc
Security
Supplies
IF"ewr Out To Description Pay Out Category
Amount .
| [ Entertainment Category
Comment For Future Pay QOuts
Payout By | New | | Delete ‘ ‘ Update ‘
I~ Pay Out Voided ‘ Save Pay Out ‘ Done |

Figure 96: Manage Pay Outs
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Pay Outs

The Pay Outs area lists any pay outs that have been made. You can edit the pay out description or
comment for future pay outs to a selected payee. You can aso void apay out made from any cash
drawer.

1. Highlight the selected pay out in the Pay Outs area.

2. To edit the pay out, including areason for voiding the pay out, update the Description or the
Comment for Future Pay Outs.

3. Tovoidthe pay out, select Pay Out Voided.
4. Select Save Pay Out. The system displays three messages:

» Thesystem verifies that you want to save changesto the pay out. Select Yesto save or No
to close the box without saving.

» Thesystem asksif you want to save the pay out to the Payees list for making future pay
outs. Select Yesto include the item in the Payees list or No to close the box without
including the item on the list.

» The system verifies that the pay out has been saved.

Pay Out Categories

Pay outs can be put into several different categories for the purpose of reporting and accounting.
These categories appear on the front end Pay Out screen. Entertainment categories appear in the
Entertainment Schedule screen.

1. To create apay out category:

» Enter the category name in the Pay Out Category field. Check the Entertainment
Category box if applicable.

» Select New.

» The system notifies you that the category is added. Select OK to close the dialog box.

2. Torename apay out category:

» Highlight the selected category in the Pay Out Categories list.

» Updatethe nameinthe Pay Out Category field. Check the Entertainment Category box
if applicable.

» Select Update.

3. To delete a pay out category:

» Highlight the selected category in the Pay Out Categories list.

* Select Delete.

» Thesystem verifiesthat you want to save the pay out category. Select Yesto save or No to
close the box without saving.

Setting Up A Payout
You can set up a pay out for future use. Compl ete the following steps:

1. Highlight the selected category in the Pay Out Categorieslist.
2. Enter the name in the Pay Out To field.
3. Enter the description in the Description field.
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4. Enter more information in the Comment for Future Pay Outsfield.
5. Select Save Pay Out.

The system verifies that you want to save the pay out category.
6. Select Yesto save or No to close the box without saving.

Close M anage Pay Outs
When you have finished working with Pay Outs, select Done.

Batch Credit Cards

The Batch Credit Card screen allows you to manually batch credit cards and clear pre
authorizations. Refer to “Payment Setup” on page 36 for more information about automatically
batching credit cards.

1. To open the Batch Credit Cards screen, select Batch Credit Cards from the Activities menu.

The system displays the Batch Credit Cards screen and begins the process of batching credit
cards.

Batch Credit Cards

Batch Results:
|7 Resultt Response Meszage

| ! |
7123109 12:11 PM

| Status: Cleaning Up All Preauthorizations

Large Batches Can Take Several Minutes Hide
Press Hide To Close This Window

Figure 97: Batch Credit Cards
The system displays the Batch Results, Responses, Message, and current status of the batch.
2. To hide the Batch Credit Cards screen while it continues batching, select Hide.

Credit Card Refund

NOTE:This optionisonly available if you have credit cards enabled on your system.
The Credit Card Refund screen allows you to issue arefund to a customer’s credit card.

1. To open the Credit Card Refund screen, select Credit Card Refund from the Activities
menul.
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Credit Card Refund

The system displays the Credit Card Refund screen.

Point05 Professionak: Manager Tools

File Edit Setup  Menu-Inventory  Activites Reporis  Sales Reports

Maintenance  Help

| Credit Card Refund

o

Credit Card Information

Refund Results

Card Num I Enter Result |
Card #
Issuer | Response |
Enter Exp
Exp Date | pate Message
Refund Amount RefNumber |
Enter
Amount Refund

Amount

Refunds Will Be Given After

Refund Reason The Daily Batch Has Completed

To Void This Refund
Please Use The Merchant Warehouse
Online Application

‘ % Process Refund To Credit Card Close Card Refund

Figure 98: Credit Card Refund
To process a credit card refund, compl ete the following steps:

1. Enter the Credit card Information:

» Select Enter Card #to enter the Card Number.
» Select Enter Exp Date to enter the Expiration Date.

2. Sdect Enter Refund Amount to enter the Amount.
3. Sedlect Process Refund to Credit Card.

The Refund Results area displays the Result, Response, Message, and Reference Number for the

refund.
NOTE: The refund will not be available until you batch your credit cards.

Close Credit Card Refund
When you have finished the refund, select Close Card Refund.
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Merchant Warehouse

The Merchant Warehouse screen allows you to access the Merchant Warehouse online reporting
website. From here you can also charge cards, add tips, and batch. However, any transactions
made from here, will not be reflected in any of the PointOS reporting.

NOTE:Thisisonly availableif you have credit cards enabled on your system.

1. To open the Merchant Warehouse screen, select Go To Merchant Warehouse from the
Activities menu.

The system displays the Merchant Warehouse screen.

Point0S Professionak Manager Tools

File Edit Setup Menu-Inventory  Activies FReports SalesReports  Maintenance  Help

| Merchant Warehouse O |

7 MerchantWARE

[PAYMENT
GATEWAY

Click here if you forgaot your password.
Click here if you need help.

Username:l

Password: I

Reset

@ Showr In Full Browser |

Figure 99: Merchant Warehouse

2. Select Show In Full Browser to open the Merchant Warehouse website in your default web
browser.

Enter your Merchant Warehouse user name in the User name field.
Enter your Password.

Select Login.

Select Done to close the website.

o g bk~ w
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PointOS to QuickBooks®

NOTE: PointOS To QuickBooks is not compatible with QuickBooks POS, but it works with all
other version of QuickBooks, including QuickBooks Pro.

The PointOS To QuickBooks® screen allows you to send sales and payment data directly to
QuickBooks®. This connection automatically creates accounts in QuickBooks®.

NOTE: You cannot rename these accounts. Do not modify these accounts in QuickBooks®.
These are the accounts created:

Account Name Account Type Parent Name

On Premise Cash Bank

Credit Card Refunds Income

Visa Income Credit Card
Refunds

Master Card Income Credit Card
Refunds

Discover Income Credit Card
Refunds

American Express Income Credit Card
Refunds

Main Bank Account Bank

Gift Cards Payable OtherCurrentLiability

Visa Bank Main Bank
Account

Master Card Bank Main Bank
Account

Discover Bank Main Bank
Account

American Express Bank Main Bank
Account

Debit Bank Main Bank
Account

Gift Cards I ssued Income

Checks To Deposit Bank

PointOS Manager Manual

Activities Menu ¢« 136



PointOS to QuickBooks©

Account Name Account Type Parent Name
POS Payouts Expense
Employee Tips Payable OtherCurrentLiability
PayOutCegories Expense POS Payouts
POS Sales Income
Sales Tax Payable OtherCurrentLiability
Cash Drawer Discrepancies OtherExpense

1. To open the PointOS To QuickBooks® screen, select PointOS to QuickBooks® from the

Activities menu.

The system displays the PointOS To QuickBooks® screen.

Point05 Professionak Quickbooks

PointOS To QuickBooks®©

0]

Connect To Quickbooks

First Time Setup To Use PointOS To QuickBooks
To Setuo QuickBooks For The Firet Ti You MUST Grant Permission
o Setup QuickBooks For The First Time :
Launch QuickBooks, Then Click The B
Check QuickBooks Connection Button Your Company's QuickBooks File
This Will Bring Up A Dialog In QuickBooks Connection Mode:
From Here Grant Rights To PointOS Professional -
To Be Able To Edit Within QuickBaoks. Single User M
| understand that PointOS to QuickBooks does not substitute, in any way for the =
expert advice of a certified accountant or other bookkeeping expert.

| understand that, due to unforeseen computer issues, my data may not be 100%

QuickBooks® Options

Setup
QuickBooks@

Connection

Need QuickBooks?
QuickBooks
Click Here

Save Up To 20%
+ Free Shipping

accurate and ShakenSoft, LLC is in no way responsible for any and all bugs, software PointOS To QuickBooks®

defects, or computer problems that result in accounting inaccuracies. w:t?lr(;o"clfmnsgsos
uic

[” | Have Read, Understand, And Agree To The Above Terms Of Senice
PointOS To
Connect To QuickBooks sl
QuickBooks and the QuickBooks logo are trademarks of Intuit Inc., displayed with permission. = .
Intuit has not endorsed or reviewed this product or statements about this product contained in this document. Close FointD5 To QuickBooks®

Figure 100: PointOS To Quick Books®

2. Launch QuickBooks® with your company file loaded.
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PointOS to QuickBooks©

3. To set up your connection, complete the following steps:

* Read the Terms of Service and check the box indicating that you understand them.
» Select the Connection M ode from the drop down list.

«  Select Connect To QuickBooks®.

«  QuickBooks® will prompt you to allow the connection from PointOS Professional. Select
Yesto allow the connection.

4. Select Setup QuickBooks® Connection.
The system displays the Send To QuickBooks® screen.

Point05 Professionak Quickbooks

PointOS To QuickBooks© @ |

Send To QuickBooks®© QuickBooks® Options
Information To Update Update Progress
Setup
™ Orders And Payments QuickBooks®

[~ Pay Outs Connection
[~ Cash Drawer Qvers

[~ Cash Drawer Unders*®
*If Mot Paid By The Employee

Need QuickBooks?

™ Credit Card Refunds QuickBooks
[ Gift Cards Issued Click Here
[~ Employee Information Save Up To 20%
I Vendor Information +Free Shipping
| ¥ CheckAll ltems_|
Point0S To QuickBooks®
Transfer Date Range Update Status Is Not Compatiable
- With QuickBooks® POS
Start Date [Mon 772712009 -] Waiting
End Date |Mon 7/27/2009  ~|
. Point0S To |
Send Information To QuickBooks : QuickBooks® |
IBIHEJ% — K Cancel QuickBooks® Transfer
QuickBooks and the QuickBooks logo are trademarks of Intuit Inc., displayed with permission. Close Point05 To QuickBooks®

Intuit has not endorsed or reviewed this product or statements about this product contained in this document.

Figure 101: Send to QuickBooks®

5. Check one or more boxes to indicate which areas of information you would like to send to
QuickBooks®. To check all boxes, select Check All Items.

NOTE: PointOS does not send inventory information to QuickBooks.

PointOS works directly with QuickBooks Payroll Service.

6. Select the Start Date to indicate which items to send to QuickBooks®.
7. Select the End Date to indicate which items to send to QuickBooks®.
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8. Select Send Information To QuickBooks.

The Update Progress area shows information about the transfer.
9. Select Detail to view more information.

The Update Satus area indicates the status of your transfer.

10. Select Cancel QuickBooks® Transfer to stop the transfer before it has finished.
11. Select Close PointOS to QuickBooks® when you have finished.

Disable UAC

When using Windows Vista, PointOS to QuickBooks may not operate correctly when User
Access Control (UAC) is enabled.

To disable UAC, complete the following steps:

Open the Control Panel.

Under User Account and Family settings, select Add or remove user accounts.
Select one of the user accounts.

Select User Accountsfrom the heading.

Select Turn User Account Control On or Off.

Uncheck the Use User Account Control (UAC) to help protect your computer box. Select
OK.

The system will prompt you to reboot your computer. Do so when ready.

o g bk~ wbdrE
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Reports Menu [Bint)d

PROFESSIONAL

Overview

The Reports and Sales Reports menus offer an in-depth view at different activities within
PointOS. The screens for each report have similar options and the steps for generating, exporting,
or printing the reports are the same.

This chapter explains the basic process for report options, and generating, exporting, and printing
the reports. Then it provides a brief description of each report.
Date Range

Most reportsinclude the Sart Date and End Date in the Report Options. For reports that show a
specific date range, you must select the Start Date and the End Date. Refer to “ Setting the Date”
on page 166 for more information.

NOTE:If astart date or end date fallsin the middle of areport period, you will get the entire
report period. For example, if you ask for aMonthly report but only set the start date half-
way through amonth, you will get the entire month. Reports also begin and end at the day
start time set in Main Settings. Refer to “Main Setup” on page 9 for more information
about setting the day start time.

Show Report Detail

Many reports have extra detail that you may want to see.

1. To get more detail on these reports, check the Show Report Detail box.

Generate Report
To generate areport, complete the following steps.

1. Select the report you want to generate from the Reports menu or the Sales Reports menu.

2. Inthe Report Options area, use the drop down arrows to select the options appropriate to the
data you want to view for the selected report.

3. Select Generate Report. Some reports are very database intensive and may take from 1 to 10
minutes to run. Please be patient.

The system displays the report details in the left side of the screen. Use the Up and Down arrows
to navigate within the report.

Export Report
NOTE: You must have Microsoft® Excel installed on the computer generating the report.

To export areport to Microsoft® Excel, complete the following steps:
1. After you have generated the report, select Export Report to Excel.
The system opens a Save As dial og box.
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2. Indicate the directory location to save the report and change the file name from the default, if
desired.

3. Select Save.
The system opens Microsoft® Excel with the selected report data.

Email Report

NOTE: You must have Microsoft® Excel installed on the computer sending the report.
To send areport as an Email attachment, compl ete the following steps:

1. After you have generated the report, select Email Report as Attachment.

The system opens the Email Report screen.

Email Report
Sort By Position Additional Recipients
Show All |

To Employee
1 Jane Doe +
Up

Check

> Do Not Send Report ‘ H =1 Send Report To Recipients I

Figure 102: Email Report

2. Tonarrow the list of employees, select a position from the Sort By Position drop down list.

3. Check the box next to the employee(s) to whom you want to send the report. Use the Up and
Down arrows to navigate through the list of employees. Select Check All to send the report to
al of the employeesin the current list.

4. To send the report to up to four additional recipients, enter the recipient’s email addressin the
Additional Recipientsfields.

5. Select Send Report To Recipients to send the report. Select Do Not Send Report to close
the Email Report screen without sending emails.

Print Report
To print areport, complete the following steps:
1. After you have generated the report, select Export Report to Excel.
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Manager Inventory Change Report

2. Select Print Report.

Manager Inventory Change Report

The Inventory Change Report gives you areport of any changes made to inventory from the
Manager’s area.

Current Inventory

The Current Inventory Report givesyou areport of what goods you currently have on hand to
sell, sorted by Vendor, Type, Group, and/or Location. Your inventory is depleted when using
Inventory Control.

Item Purchase Report

The Item Purchase Report givesyou alist of goods that it istime to purchase. Thereport is
broken down by vendors. Recommendations for these purchases come from the Par amount
indicated in Inventory Setup. Refer to “Inventory Item Setup” on page 88 for more information.
Item Cost/Price

The Item Cost/Price Report provides alist of al of the menu items you have available for sale.
It shows the different prices charged for each item.

Gift Cards Issued

The Gift Cards|Issued Report providesalist of all gift cards sold during the selected time
period. It will also alow you to see your outstanding gift card liability.

Closing Reports

When an employee performs the cashier out function in PointOS, he or she creates a Closing
Report to let the manager know if anything was broken or if an item has run out of stock.
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Closing Reports

When you select Closing Reports from the Reports menu, the system displays the Closing
Reports screen.

Closing Reports
7/27/09 - (Mot Read) Damaged Area
‘ Bar
Damage Description
Test
Reorder Inventory ltems
Test

Other Information

|Report By: PointOS Administrator |
- v Done
View Report ‘ |Report Date: 7/27/2009 4:28:31 PM |

Figure 103: Closing Reports

1. Highlight the report you want to view from the left side of the screen.
2. Select View Report.

The system displays the report information in the Damaged Area, Damage Description, Reorder
Inventory Items, and Other Information areas.

3. Select Done when you have finished viewing the Closing Reports.
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Incident Reports

Employees can file areport for any type of incident that happens at the location, such asan
accident or fight.

When you select Incident Reports from the Reports menu, the system displays the Incident
Reports screen.

Point05: Incident Reports

Incident Reports
6/27/09 - (Mot Read) Incident Time

6/27/09 12:00 PM

Employees Involved
Jane Doe

Customers Involved

What Happened
Injuries Who Responded
Fire Police
Mone
Rescue

| Report By: Pointos Administrator |
. v Done
View Report ‘ | Report Date: 6/27/2009 |

Figure 104: Incident Reports

1. Highlight the report you want to view from the left side of the screen.
2. Select View Report.
Theright side of the screen displays the following information:

* Incident time

* Employeesinvolved

* Customersinvolved

* A description of what happened

* Anyinjuries

»  Whether the Fire, Police, or Rescue services responded
* Who generated the report

* Thereport date

3. Select Done when you have finished viewing the Incident Report.
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Today’s Conditions

When a cashier cashesin for the day in PointOS, he or she can indicate the weather conditions.
The Today’s Conditions Reports displays this information, which you can use to evaluate unusual
sales conditions.

When you select Today’s Conditions from the Reports menu, the system displays the Today’s
Conditions screen.

Point05: Today's Conditions

Today's Conditions

- (Mot Read)
6/27/09 _ .
7/27/09 - (Not Read) ‘90 to 899° F
6/28/09

Temperature

Weather Conditions

Sunny

Today's Events

Other Information

|Report By: PointOS Administrator |
: v Done
View Report ‘ |Report Date: 6/28/2009 |

Figure 105: Today’s Conditions

1. Highlight the report you want to view from the left side of the screen.
2. Select View Report.

The system displays the report information in the Temperature, Weather Conditions, Today's
Events, and Other Information areas.

3. Select Done when you have finished viewing the Today’s Conditions reports.

Cashier In/Out

The Cashier 1n/Out Report provides details about when each cashier started and ended his or
her cash drawer. It also shows if the cash drawers were off and how much a server might owe.

Cash Out Report
The Cash Out Report provides details about each cash out for the selected date(s).
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Drawer Reverts

If aserver mistakenly closes out a cash drawer, it can be reopened. The Drawer Reverts Report
indicates you if this has happened and why.

Employee Clock In/Out
The Employee Clock In/Out Report indicates what time each server clocked in and out.

Employee Hours

The Employee Hour s Report provides the time card and reported tips for each employee for the
selected time period to use for completing your payroll.

NOTE: PointOS to Qui ckBooks® does not send any payroll information or support QuickBooks©
payroll service.

Item Discounts

The Item Discounts Report indicates if menu items were sold at a reduced price and why.
However, this report will not reflect modifiers that affect a menu item with negative dollar
amounts.

Order Discounts

The Order Discounts Report indicatesif an order’s total amount was reduced and why.
However, this report will not show sales reduced by special pricing set for employees and good
customers.

Pay Outs

The Pay Outs Report indicates the amount and recipient of any pay outs. Pay outs are a good
way of tracking cash payments to entertainment, employees, or vendors. These pay outs are also
reflected in the cashier out reports.

Pay Outs By Category

The Pay Outs By Category is similar to the Pay Outs Report, but it provides additional detail
about the transactions broken down into categories.

Item Voids
The Item Voids Report indicates any items that were removed from a sales check and why.

Order Voids

The Order Voids Report indicates any customer orders that were voided and why. Only open
orders can be voided by a server.
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Access Denied

The Access Denied Report providesalist of all unsuccessful attempts to try and access a secure
area. Thisisagood report to run to see if a someoneistrying to get into an area that they are not
authorized to access.

No Sales

The No Sales Report shows you when the cash drawer was popped at the times when no sale
transaction was made. This occurs most frequently when a server is making change, but could
indicate some sort of fraud. The report also will show you who popped the drawer and at what
time.

Door Report

NOTE: Thisreport isonly available if you are using PointOS DoorMan as one of your licensed
stations.

The Door Report providesalisting and total of members through the door on the selected date. It
also shows the time the member arrived.

Member Report

NOTE: Thisreport isonly available if you are using PointOS DoorMan as one of your licensed
stations.

The Member Report provides alisting of members, with the membership type and dates, the last
visit, and the amount spent.
Active Customer List

The Active Customer List Report provides alisting of any changes to the Customer Mailing
List for the selected date range. You can use this to ensure that your Customer Mailing List isup
to date before doing promotional mailings.

Customers Report

The Customers Report indicates al of the customers who have been added to the system during
the selected date range. It also indicates how much the new customers spent as well as how often
they have visited.

Guest Report
The Guest Report indicates all orders with guests entered, including number of items ordered
and average sale per guest. It does not include discounts or refunds.

Cost Of Goods

The Cost of Goods Report showswhat you have spent on ingredients for the thingsyou sell. You
can compare that to how much revenue each item generates. Thiswill return a percentage that will
give you your overal item cost.
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Orders

The OrdersReport givesyou alist of all orders both open and closed. When you select an order
in thislist, the system displays a copy of the check.

Open Orders
The Open Orders Report indicates the orders on the system have not yet been paid.

Payments
The Payments Report shows all the payments made during the selected time frame.

Gift Cards

The Gift Cards Report indicates the gift cards that have been redeemed as payment during the
selected time frame.

Personal Checks

The Per sonal Checks Report indicates the personal checks that have been used as payment
during the selected time frame.

Taxes

The Taxes Report provides a breakdown of your sales and how much you have collected in taxes.
This report will show both add on tax and tax that is included in a menu item price.

Credit Batches

If you are using PointOS to batch your credit cards, the Credit Batches Report indicates the credit
card batch amounts and result for the selected time frame.

Credit Card Refunds

The Credit Card Refunds Report indicates any credit card refunds that have been processed for
the selected time frame.

Daily Report

The Daily Report provides detailed information about all days in the selected time frame. This
information includes pay outs, drawer over/unders, tips, discounts, voids, cash sales, credit card
sales, total orders, items sold, taxes collected, net sales, gross sales, and total cash on hand.

Weekly Report

The Weekly Report provides detailed information about all the weeksin the selected time frame.
Thisinformation includes pay outs, drawer over/unders, tips, discounts, voids, cash sales, credit
card sales, total orders, items sold, taxes collected, net sales, gross sales, and total cash on hand.
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Monthly Report

The entire week isincluded in the report, regardless of whether the start date or end date are in the
middle of aweek.

Monthly Report

The Monthly Report provides detailed information about all months in the chosen time frame.
This information includes pay outs, drawer over/unders, tips, discounts, voids, cash sales, credit
card sales, total orders, items sold, taxes collected, net sales, gross sales, and total cash on hand.

The entire month isincluded in the report, regardless of whether the start date or end date arein
the middle of a month.

Sales By Day

The Sales By Day Report provides all of the sales for the days included in the selected date
range. However, it will not provide as much detail as the daily report.

Sales By Hour

The Sales By Hour Report provides all the sales broken down into 24 hours. It also indicates the
total items sold.

Sales By Week

The Sales By Week Report provides al of the sales broken down into one week blocks.
However, it will not provide as much detail as the weekly report.

The entire week isincluded in the report, regardless of whether the start date or end date are in the
middle of aweek.

Sales By Month

The SalesBy Month Report providesall of the sales group in one month blocks. However, it will
not provide as much detail as the monthly report, but will run much more quickly.

The entire month isincluded in the report, regardless of whether the start date or end date arein
the middle of a month.

Sales By Item

The Sales By Item Report indicates all of the items sold during a specific period of time. It will
group the items by type, giving you atotal count. To view associated modifiers, check the Show
Report Detail box.

Thisreport is very database intensive and may take quite a while to execute.

Item Sales By Hour

The ltem Sales By Hour Report indicates all of the items sold during a specific period of time
broken down into 24 hour increments. It will group the items by type, giving you atotal count. To
view associated modifiers, check the Show Report Detail box.

PointOS Manager Manual Reports Menu « 149



Item Sales By Server

Thisreport is very database intensive and may take quite awhile to execute.

Item Sales By Server
The Item Sales By Server Report indicates the sales by server. It also shows what items each
server sold during the selected date range.

Item Sales By Server Ring
The Item Sales By Server Ring indicates the sales by server on each transaction.

Sales By Category
The Sales By Category Report indicates items sold in specific categories.

Sales By Payment Type

The Sales By Payment Type Report breaks down sales for a selected time period into the
different kinds of payments, including cash and credit cards.

Sales By Delivery
The Sales By Délivery Report indicates the sales made for delivery for a specific period of time.

Sales By Server

The Sales By Server Report indicates sales for a selected time period broken down into the
different servers that were active during this period.

Sales By Station
The Sales By Station Report indicates sales for a sel ected time period broken down into the
different stations that were active during this period.

Item Sales By Room

The Item Sales By Room Report breaks down the sales by room. It also indicates what items
were sold from that room, during the selected date range.

Thisreport is very database intensive and may take quite a while to execute.
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PROFESSIONAL

Overview

The maintenance area allows you to keep your system running fast and efficiently. You can
archive sales, speed up and back up the database, and del ete unnecessary or sensitive data such as
credit cards.

Stations Manager

The Sations Manager screen alows you to shut down or force arestart of all connected stations.
Thisisrequired for backing up or compacting the database, or when making some changes to the
system.

1. To open the Sations Manager screen, select Stations Manager from the M aintenance menu.
The system displays the Sations Manager screen.

Point0S Professionak Manager Tools

File Edit Setup Menu - Inventory  Activities Reports  Sales Reports  Maintenance  Help

| Station Manager ’:) |

Station Maintenance Station Opticns

| Disconnect All Stations ‘

| Shut Down Selected Stations ‘

| Shut Down All Stations ‘

| Restart Selected Stations ‘

| Restart All Stations ‘

| Re-Number Stations ‘

UnCheck All Stations

| Check All Stations ‘ | Close Station Manager ‘

Figure 106: Stations M anager
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Stations Manager

The Sation Maintenance area lists the stations that are currently connected to your database.
Select a station by checking the box next to the listing. You can select Uncheck All Sations or
Check All Sationsto quickly indicate the stations with which you want to work.

2. Todisconnect al stations, select Disconnect All Sations.

3. To shut down the selected stations, select Shut Down Selected Sations. To shut down all
stations, select Shut Down All Sations.

4. To restart the selected stations, select Shut Down Selected Sations. To restart all stations,
select Shut Down All Sations.
Re-number Sations

NOTE: To renumber stations, all stations must be disconnected and you cannot have any cash
drawerslogged in.

1. Tore-number the stations, select Re-Number Stations.
The system displays the Re-Number Sations screen.

Point05 Professionak Manager Tools

File Edit Setup  Menu - Inventory  Activities  Reports  Sales Reports  Maintenance  Help

| Station Manager @ |
Re-Number Stations Station Options
Station #1 - MY STATION (MICHELE) | Wsconnect Al Stations ‘

| Shut Down Selected Stations ‘

| Shut Down All Stations ‘

| Restart Selected Stations ‘

| Restart All Stations ‘

Change Station Numbers |

Re-Number Stations ‘

‘ 4+ Move Station Up ‘ | Move Station Down & |

‘ Close Re-Number Stations | | Close Station Manager ‘

Figure 107: Re-Number Sations

2. Highlight the station you want to re-number.
3. Usethe Move Sation Up and Move Sation Down arrows to reorder your list of stations.
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Disconnect Stations

4. When you have finished re-numbering the stations, select Close Re-Number Stations.

Close Sation Manager
When you have finished managing the stations, select Close Sation M anager.

Disconnect Stations

The Disconnect Stations option forces all stations to stop receiving or sending information to or
from the database. Thisis required when backing up or compacting the database. It may take up to
aminute to disconnect all stations.

1. Toquickly disconnect al stations, select Disconnect Stations from the M aintenance menu.
The system displays a Manager Alert reminding you that the process takes a few moments.
2. Select OK.

Shut Down All Stations

The Shut Down All Stations option forces all stations to disconnect. Thisis useful when
upgrading the system. This function may take up to two minutes to complete.

1. To shut down all stations, select Shut Down All Sations from the M aintenance menu.
The system displays a warning message.

Point0S: Shutdown All Stations

Are You Sure You Want
To Shutdown All Stations?
Active Station Transactions May Be Lost

Figure 108: Shutdown All Sations

2. Select Yesto continue, or select No to close the warning without shutting down the stations.

Backup Database

The Backup Database option allows you to create a copy of your database. This protects you if
your computer ever becomes broken or corrupted. We recommend that you backup at least once a
week.

NOTE: You can also set the system to backup automatically. Refer to “Database Setup” on
page 40 for more information.

You can back up to aremote device. Refer to http://support.microsoft.com/kb/207187 for
more information.
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1. To perform a database backup, select Backup Database from the M aintenance menu.
NOTE: You must use the computer running the server portion of PointOS to back up the database.
The system displays a dialog box to confirm that you want to backup the database.

2. Select Yesto continue, or select No to close the dialog box without performing a backup.
The system displays a Create Database Backup dialog box to save the database backup.

3. You can change the name of the database if necessary, but the file should be saved in the
default Backup directory. Select Save to save the backup, or select Cancel to close the dialog
box without saving a backup.

The system displays aManager Alert notifying you that the backup was saved successfully. It also
displays the location of the saved backup.

Database Cleanup

The Database Cleanup screen alows you to remove old or unnecessary information from your
system to help reduce the size of the database and improve performance. We recommend that you
clean the database every 6 to 12 months.

NOTE: Thiswill not delete any settings, menu items, modifiers, employees, or customers.

DELETED DATA CANNOT BE RECOVERED. MAKE SURE YOU NO LONGER NEED THE DATA BEFORE
DELETING.

NOTE: You should always make a backup of your database prior to running database cleanup.

1. To open the Database Cleanup screen, select Database Cleanup from the M aintenance
menul.
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The system displays the Database Cleanup screen.

File Edit Setup Menu-Inventory  Activities  Reports  Sales Reports Maintenance  Help
| Database Cleanup Q |
Logs Register Activites Database Opticns
[~ Access Denied [ Orders Cleanup Date
[" No Sales [ Payments | v|
[ Discounts [~ Credit Card Pre Auths
™~ Voids ™ Credit Card Batches | w' Delete Checked From Before Date
[~ Pay Outs |
7 Delete All Data From Before Date ‘
Lajpalis [~ Cash In/Outs
[~ Daily Conditions
[~ Close Outs Messages
[” Incidents I Employee Mail | v Delete Checked Data ‘
Schedule [~ Schedule Requests | x T b T ‘
[” Time Clock
[~ Weekly Schedule Check All ‘
All Data Deleted Will Be Permanently Lost | Backup Database ‘
And May Adversely Effect Reporting
Please Backup Before Proceeding
| Close Database Cleanup ‘

Figure 109: Database Cleanup

To backup the database, select Backup Database.

Indicate the type of data you want to remove from the database by checking one or more
boxes next to the selected data type. You can select Check All to quickly check all of the
boxes. If you check al boxes and want to remove them, select Uncheck All.

NOTE:It isagood ideato remove Logs because they will not affect any of the most vital report-

4.

ing.
To remove data prior to a specific date, select a Cleanup Date from the drop down list. Select
one of the following options to remove data:

» Select Delete Checked From Before Date to remove the data corresponding to the items
you checked prior to the selected date.
» Select Delete All Data From Before Date to remove al data prior to the selected date.

To remove data up to the current date, select one of the following options:

» Select Delete Checked Data to remove the data corresponding to the items you checked.
» Select Delete All Data to remove all data.

The system displays a warning message to verify that you want to del ete the selected data.
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5. Select Yesto continue, or select No to close the warning without cleaning the database.
The system displays a warning message to notify you that this cannot be undone.
6. Select Yesto continue, or select No to close the warning without cleaning the database.

Close Database Cleanup
When you have finished cleaning the database, select Close Database Cleanup.

Calibrate Scanner
NOTE: This option isonly available if you have a compatible scanner attached.
The Calibrate Scanner options alows you to calibrate your new 1D scanner.

1. Select Calibrate Scanner from the M aintenance menu.

2. Usethe calibration paper that came with your scanner. You can also download and print out a
new calibration sheet from the manufacturer’s website.

Clean Scanner

The Clean Scanner option allows you to clean your ID scanner if you are experiencing any
problems with it.

1. Select Clean Scanner from the M aintenance menu.
2. Usethe cleaning paper that came with your scanner, and follow the manufacturer’s directions.

Archive ltems

The Archive Items option allows you to move old itemsto the archive part of the database to help
speed up the system. Doing this along with compacting the database can greatly increase system
speed. It does not delete information or affect reporting. You should archive itemsregularly as
part of routine database maintenance. You can set items to archive automatically when
compacting the database. Archive items is done automatically when using auto system
maintenance. Refer to “ Database Setup” on page 40 for more information.

1. Select Archive ltemsfrom the M aintenance menu.
The system displays a warning message asking if you want to archive all closed items.
2. Select Yesto continue, or select No to close the warning without archiving old items.

Archive Orders

The Archive Order s option allows you to move old orders to the archive part of the database to
help speed up the system. It does not delete information or affect reporting. You should archive
ordersregularly as part of routine database maintenance. You can set old ordersto archive
automatically when compacting the database. Refer to “ Database Setup” on page 40 for more
information.

1. Select Archive Ordersfrom the M aintenance menu.
The system displays a warning message asking if you want to archive al closed orders.

PointOS Manager Manual Maintenance Menu ¢ 156



Delete PreAuths

2. Select Yesto continue, or select No to close the warning without archiving old orders.

Delete PreAuths

The Delete PreAuths command credits back the $.01 on all preauths that have not been batched
yet. Thisis done automatically when compacting the database. Refer to “ Database Setup” on
page 40 for more information. If you are not using compact database, you should delete pre-
authorizations frequently.

1. Select Delete PreAuths from the M aintenance menu.
The system displays a warning message asking if you want to delete all pre-authorizations.

2. Select Yesto continue, or select No to close the warning without deleting the pre-
authorizations,

Update All Music

When you add new songs to Windows Media Player, you should update all music to add the songs
to the PointOS database.

NOTE:Thisis aso done usually at startup.

1. Select Update All Music from the M aintenance menu.

The system displays a warning message asking if you want to update the music.

2. Select Yesto continue, or select No to close the warning without updating the music.

Reset Damaged Songs

If asong failsto play, the PointOS database tags it as damaged. The Reset Damaged Songs option
allows you to restore the damaged songs.

1. Select Reset Damaged Songs from the M aintenance menu.
The system displays a warning message asking if you want to reset the songs.
2. Select Yesto continue, or select No to close the warning without resetting the songs.

Delete All Music

The Delete All Music option allows you to start over with new music. This function removes all
music information from the database, and may have adverse effects on customer song lists.

NOTE: This DOES NOT delete any music files from your computer, just from the PointOS data-
base. This selection is completely safe.

1. Select Delete All Music from the M aintenance menu.
The system displays a warning message asking if you want to delete the music.
2. Select Yesto continue, or select No to close the warning without deleting the music.
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PROFESSIONAL

Overview

The Help menu provides additional resources and support.

Online Manual
The Online Manual provides online support for using the manager functions of PointOS.
1. Select Online Manual from the Help menu.

The system displays the PointOS Professional Manager Help in anew tab of your browser
window.

Check for Update

The Check for Update option opens the PointOS Updater.

NOTE: Updating PointOS will not uninstall SQL. You wiLL NOT lose any data.
1. Select Check for Update from the Help menu.

The system displays the PointOS Professional: Update Available screen.

Point05 Professionak Update Available x|

Choose Point0S To Update Go To Website Exit

You Have The Newest Version
Of PointOS Professional

Version Information

| Current Version: 3 |

PeintQ5 Professional: Version 3.0 ;I
| Newest Version: 3 | Integrates With Point0S Doorian
Added Smaller Bar Tables

Other Bug Fixes

Some |nterface Improvements

It Is Recommended That
You Update To The
Newest Version | |

‘ Re-Install Latest Version ‘ ‘ Quit Updater

Figure 110: PointOS Updater

The Updater displays the status of your software and information about the latest version of
PointOS.

To re-install the software, select Re-install L atest Version.

Select the software to update from the Choose PointOS To Update drop down list.
To go to the website to get more information about the current version, select Go To Website.
When you have finished, select Quit Updater or Exit.

a b~ DN
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Remote Support

Remote Support

The Remote Support option allows PointOS technical support staff to access your system for
assistance with troubleshooting.

1. Select Remote Support from the Help menu.
The system opens your web browser to the PointOS Professional Remote Support page.

oINtOD

PROFESSIONAL
REMOTE SUPPORT

Just enter your 6 Digit Pin and someone will be with you shortly.

Enter your 6-digit PIN code

Connect To PointOS Support

1 z 3

4 5 6

7 8 9
Back 0 Clear

Figure 111: Remote Support

2. Enter the six-digit PIN provided by PointOS technical support and select Connect To
PointOS Support.
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Upgrade PointOS

The system opens the Rescue Gateway screen, which provides alog of activities during the
remote support session.

f‘ Discannected,
EX)

Connecting to Rescue Gateway:

Figure 112: Rescue Gateway

During Remote Support, PointOS technical support will have control of your computer for
troubleshooting. When the session ends, you can close the Rescue Gateway screen.

Upgrade PointOS
The Upgrade PointOS option allows you to purchase or enter an upgrade in your PointOS license.

1. Select Upgrade PointOS from the Help menu.
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The system displays the Upgrade screen.

Please Enter Your PointOS Professional
Upgrade Code Below And
Press Enter Upgrade Number

Current License

1 Station
Upgrade Number
Cancel Purchase Enter Upgrade
Upgrade Upgrade Number

Figure 113: Upgrade

2. To purchase an upgrade, select Purchase Upgrade. The system opens the PointOS purchase
website in your browser. You can purchase up to 9 additional stations (for atotal of 10

stations).

3. When you have your code, enter the Upgrade Number and select Enter Upgrade Number.
Or select Cancel Upgrade to close the Upgrade screen without entering an upgrade.

Contact Us

The Contact Us option allows you to send an email to PointOS.
1. Select Contact Usfrom the Help menu.
The system displays the Contact Us screen.

PointDS Professionak Contact Us

Contact Us ‘ Bint)S

Subject

General Comment j

Your Email Address

Itest@yahou_cnm

Message X Cancel
=1 Send

Figure 114: Contact Us

2. Select a Subject for your email from the drop down list.
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License Agreement

3. Update or enter Your Email Address.
4. Enter your M essage.

5. Select Send to deliver the email or Cancel to close the Contact Us screen without sending the

email.

License Agreement

The License Agreement option displays the license agreement under which you installed

PointOS.
1. Select License Agreement from the Help menu.
The system displays the License Agreement.

Point0S Professionalk: License Agreement

Software License Agreement ‘

[BintdS

END-USER LICENSE AGREEMENT FOR FointD5 Professional.

IMPORTANT PLEASE READ THE TERMS AND COWDITIONS OF THIS LICENSE
AGREEMENT CAREFULLY BEFORE CONTINUIMG TO LUSE THIS PROGR&M:

Paint05 Professional End-User License Agreement ["EULA") iz a legal agreement between
wou [either an individual or a single entity) and ShakenSoft, LLC for the ShakenSoft, LLC
zoftware product(z) identified abowe which may include associated software components,
media, printed materialz, and "onling or electionic documentation ["SOFTWARE
FRODUCT"). By instaling, copying, or othenwize using the SOFTWARE PRODUCT, you
agree to be bound by the terms of thig EULA. Thiz license agreement reprezents the entire
agreement concerning the program between vou and ShakenSoft, LLC [referred to as
“licenser'), and it supersedes any prior proposal, representation, or understanding between
the parties. If you do not agree to the berms of this EULA, do not install or uze the
SOFTWARE PRODUCT.

Paointd5 Professional
is owned by ShakenSoft, LLC
Copyright 2009
All Bights Reserved

The lSDFTWAFEE PHDD_UET iz protected by copyright Iaw_s and interational copyright

Figure 115: License Agreement

2. Select Close when you have finished viewing the license agreement.

About PointOS

The About PointOS option displays the PointOS company information, as well asthe

registration, version, and build date information.
1. Select About PointOS from the Help menu.
The system displays the About PointOS screen.

2. Select Close when you have finished viewing the information.
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This chapter includes instructions on completing tasks that are not specific to an individual
screen.

Setting Up Multiple Stations

You can connect multiple clients to one central database computer. Keep the following in mind
when selecting the computers for the server and the client(s).

* The central database computer cannot be running Windows XP Home Edition or Windows
VistaHome Basic.

» Theclient computers may be any Windows XP or Windows Vista machine.

To set up multiple stations, complete the following steps:

3. Make surethat all of the computers are on the same workgroup. Refer to Windows help for
more information on setting up a workgroup.

4. Install PointOS Client and Server on the computer that will serve as the central database
computer. Refer to “Installation” on page 4 for more information about installing PointOS
Client and Server.

5. Setup your database on the server computer. Refer to “New Database” on page 7 for more
information on setting up a new database.

6. Install PointOS Client Only on the client computer(s) that connect to the central database
server. Refer to “Installation” on page 4 for more information about installing PointOS Client
only.

7. Whileinstalling PointOS Client Only on the client computers, select the computer name of the
central database server and the database you created. If the computer does not show up on the
list, your workgroup or firewall are not set up correctly.

Setting Up XP Server Rights Manually

The PointOS Installer should grant access rights to the SQL server on the database computer.
However, the operating system protection sometimes interferes. In this case, you must set the
rights manually.

To set rights manually for an XP computer used as the central database server, complete the
following steps:

1. Select Control Panel from the Windows Start menu.

2. Select Administrative Tools.

Select Computer M anagement.

From the Computer Management screen, select Local Users And Groups.
Select Groups.

o b~ w
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Setting Up a Generic Driver for Receipt Printing

The 3 SQL server groups for PointOS are:

*  SOQLServer2005M SSQL ServerADHel perUser$SHAK ENSOFT
«  SQL Server2005M SSQL ServerADHel perUser$SHAK ENSOFT
«  SQL Server2005SQL BrowserUser$SHAK ENSOFT

6. You will need to add everyone in your network to all three SQL server groups. Complete the
following steps:

» Select the group name.

» Select Add to add a user.

» The system displays adialog box to select the users. Enter the object name everyone.
* Select OK.

* Repeat for the other two SQL server groups.

To setup rights manually for a Vista computer used as the central database server, complete the
following steps:

1. Find your computer name by going to Control Panels— System — Advanced System
Settings. Select the Computer Name tab.

2. Select Run from the Start Menu

3. Enter cmd.

4. Right click on cmd when it comes up in the search results. Select Run as Administrator.
(This step isonly necessary if you have UAC enabled.)

5. Inthe command window, enter the instructions indicated below, substituting your computer’s
name found in step one for each instance of “computername”. Press ENTER after each line.

e net localgroup SQL Server2005SQL BrowserUser$computer name Everyone /add

* net localgroup SQL Server2005M SSQL User$computer name$SHAKENSOFT Everyone
/add

» netlocalgroup SQL Server2005M SSQL ServerADHel perUser$computer name$ Everyone
/add

Setting Up a Generic Driver for Receipt Printing

Windows must recognize your receipt printer before it will work with PointOS Professional. You
may install the printer using the provided drivers from the manufacturer, but sometimes these
drivers are hard to find. Instead, you may use the Generic - Text Only driver included with
Windows.

NOTE: The generic driver may not work for al receipt printers.

Compl ete the following steps to set up your receipt printer with a generic driver.
1. Select Control Panel from the Windows Sart menu.
2. Select Add Printer.

The system displays the Add Printer Wizard.
3. Sdlect Next to continue.
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Setting the Time

© o N o

11.
12.

13.
14.
15.

On the Local or Network screen, select Add a Local Printer attached to this computer. If
you are using Windows XP, uncheck the Automatically detect and install my Plug and Play
printer.

On the Select a Printer Port screen, select USB001(Virtual printer port for USB) from the
Use the Following Port drop down list. Select Next to continue.

On the Install Printer Software screen, select Generic in the Manufacturer area.
Select Generic/Text Only in the Printers area.
Sdlect Next to continue.

On the Name Your Printer screen, keep the Generic/Text Only namein the Printer Name
field.

. For Do you want to use this printer asthe default printer, select No. In Windows XP,

uncheck the Set asthe default printer box.
On the Printer Sharing screen, select Do not share thisprinter. Select Next to continue.

On the Print Test Page screen, select No for Do you want to print atest page. Select Next to
continue.

Select Finish to finish adding your printer.
If Windows XP displays the Print to File screen, select Cancel.
Restart PointOS to load the new printer into the system.

Setting the Time

You can use the system clock to set times in many of the PointOS screens.

1. For atimefield, select the drop down arrow to display the system clock.
The system displays the clock.
12:00 AM |
P TN
10 2"
‘9 3
. .
76 5
(OISl Set |
Figure 116: Set Day Sart Time
2. Using the mouse, left click to set the hour.

Right click to set the minutes. Hold down the Control key while you click to constrain the
minutes to five minute increments.

Select AM or PM.
Salect Set.

PointOS Manager Manual Technical Setup + 165



Setting the Date

Setting the Date

You can use a calendar to set dates in many of the PointOS screens.

1. For adatefields, select the drop down arrow to display the calendar.
The system displays the calendar.

[ < | July, 2009 ]

Sun Mon Tue Wed Thu Fri Sat
28 29 30 1 2 3 4

5§ 6 7 8 9 10 1N
12 13 14 15 16 17 18
19 20 23 24 25
26 27 [

Figure 117: Calendar

2. Using the mouse, click the date you want to select. You can select the left or right arrowsto
move back or forward one month at atime.

Setting Up a Merchant Warehouse Account

Getting a Merchant Warehouse account and using them is completely FREE. Once you get an
account, setup in PointOS takes just minutes. Compl ete the following steps to obtain a Merchant
Warehouse Account.

1. From the Payment Setup screen, select Get a M erchant Warehouse Account.
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The system displays the PointOS website showing the form where you can get a Merchant

Warehouse Account.

Figure 118: Merchant Warehouse Form to Get an Account

* Plesse Mote: Required fields have been denoted by 8 red asterisk.
Company:
Company Mame

Contact:
First Mame & Last Name

Email:
Email Address

Phone:
Phone Number Extension

Products Sold / Services Provided:
-
a

Desoription of Products or Services Served

Comments:

-
[~

2. Fill out the required information and follow the instructions to complete the process. Make

sure to mention PointOS Professional to get proper pricing and setup.

You will receive an email from Merchant Warehouse containing information about your account,
including the Site Name, Site ID, and Site Key.

3. Onceyou have a Merchant Warehouse Account, you must enter the correct information and
options on the Payment Setup screen. Refer to “ Payment Setup” on page 36 for more

information.

4. Make sureto enable credit cards for EACH station that will accept credit cards. Refer to
“Station Settings’ on page 22 for more information.

5. Restart PointOS to finalize the new settings.

Setting Up Music

PointOS integrates with Windows Media Player to allow you easy control over your music from
within the Media Player environment.

Importing Music

All music in PointOS comes from Windows Media Player. PointOS works with either Windows
Media Player 10 or 11. Any audio file Windows Media Player will play, can be also be played by

PointOS.
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NOTE: Because Windows Media Player will not play songs downloaded from iTunes, PointOS
will also not play songs from iTunes.

1. You can rip songs from compact discs that you own, or you can download songs legally from
the Internet using sites or services like Napster or Yahoo!

NOTE:In addition to having alegal copy of this song, all locations are also responsible, as with
any entertainment, of having the appropriate music licenses (ASCAP, BMI, etc.).

2. Usethe Windows Media Player interface to add or delete songsto your library. You can have
WMP automatically search for new music by choosing File—Add To Library.

3. You can create aplaylist using Windows Media Player. You must start all playlists to be used
in PointOS with aplus sign (i.e., +Happy Hour Music, +Great Mix, +Guitar Rock, etc.).

Once asong isin Windows Media Player, PointOS will automatically add all songs on startup.
You can also add songs manually. Refer to “Update All Music” on page 157 for more
information.

Printing Song Lists

You can print alist of songsto allow your customers to make requests. Refer to “View Song List”
on page 129 for more information.

Hooking Up To Your Stereo
You can hook the PointOS music system up to your stereo in two ways.

» Thefirstisto simply run awire from the sound output of your computer to the input of your
stereo. You can get these wires inexpensively at any electronics store.

» Thesecond way isto use amusic bridge. Thisis a hardware device that sends your music dig-
itally to your stereo. There are severa optionsto choose from, but agreat one for the money is
the Linksys Music Bridge. This uses Wi-Fi or Ethernet cable to send adigital music signal
directly to your stereo. It isavailable online or at many electronics retailers.

Setting Up A Port

Online reporting requires you to set up a port. Complete the following steps:
Select the Windows Start Menu.

Select Microsoft SQL Server 2005.

Select Configuration Tools.

Select SQL Server Configuration Manager.

Expand SQL Server Network Configuration.

Select Protocols for SHAKENSOFT.

o g bk~ wbdrE
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Setting Up A Port

The system displays the Protocols in the window on the right.

?‘,’ SQL Server Configuration Manager

File Action View Help

e ||EHa= | H

@ SQL Server Configuration Manager {Local)

SQL Server 2005 Services
=] E_ SQL Server 2005 Network Configuration {32bit)
Protocols for SHAKENSOFT.
.. SQL Mative Client Configuration (32bit)

Protocol Mame | Status

% Shared Memory Enabled
% Mamed Pipes Enabled
3 TCPP Enabled
S VIa Disabled

Figure 119: SQL Server Configuration Manager

7. Make surethe TCP/IP protocol is Enabled. If not, right click TCP/IP and select Enable.
8. Right click TCP/IP and select Properties.
The system opens the TCP/IP Properties dialog box.

TCP/IP Properties 2l
Protocol IIP Addresses I
B General
Enabled Yes =l
Keep alive 30000
Listen Al Yes
Mo Delay Mo
Enabled
Enable or disable TCP/IP protocol for this server instance
CK I Cancel | Apply Help

Figure 120: TCP/IP Properties

9. Sedlect the IP Addressestab.
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10. Scroll down to the end of the list of properties.

"Protocol IP Addresses I
B 1ps o
Active Yes
Enabled Mo
I[P Address fed0::284e: 27db: 3f57: febb %10
TCP Dynamic Ports o]
TCP Port
B 1pe
Active Yes
Enabled Mo
IP Address fed0::5efer 192, 168, 1.68%15
TCP Dynamic Ports o]
TCP Port
B 1pall
TCP Dynamic Ports
TCP Port o
-
TCP Dynamic Ports
Blank, if dynamic ports are not enabled. To use dynamic ports, set to 0.

CK I Cancel | Anply | Help

Figure 121: IP Addresses
11. Change the value next to TCP Dynamic Portsto 1433.
12. Select OK.
13. You must restart the SQL Server for the changes to take effect.

Setting Up Your Firewall for Online Reporting

To use online reporting you have to make sure that your firewall is allowing connectionsin or out
of your computer. You will only want to allow accessto SQL Server on port 1433.

These steps apply to the version of Windows Firewall that isincluded in Windows XP Service
Pack 2 (SP2) and in Windows Server 2003. If you are using a different firewall system, see your
firewall documentation for more information.

If you are running afirewall on the computer that is running SQL Server 2005, external
connections to SQL Server 2005 will be blocked unless SQL Server 2005 and the SQL Server
Browser service can communicate through the firewall. You must create an exception for each
instance of SQL Server 2005 that you want to accept remote connections and an exception for the
SQL Server Browser service.

SQL Server 2005 uses an instance ID as part of the path when you install its program files. To
create an exception for each instance of SQL Server, you must know the correct instance ID. The
instance ID is SHAKENSOFT.

To create an exception for SQL Server 2005 in Windows Firewall, complete the following steps:

1. InWindows Firewall, select the Exceptions tab.
2. Select Add Program.
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3. Inthe Add a Programwindow, select Browse.

4. Select the C:\Program Files\Microsoft SQL Server\M SSQL .1\M SSQL \Binn\sglservr.exe
executable program.

5. Select Open.
6. Select OK.

To create an exception for the SQL Server Browser service in Windows Firewall, complete the
following steps:

1. InWindows Firewall, select the Exceptions tab.

2. Select Add Program.

3. Inthe Add a Program window, select Browse.

4

. Select the C:\Program Files\Microsoft SQL Server\90\Shared\sglbrowser.exe executable
program.

Select Open.
6. Select OK.

o

Setting Up Your Router

To setup your router for online reporting, you will need to use port forwarding. You will need to
allow your router to send all commands from the PointOS server to the computer that hosts your
database. The solution isto open up adoor, or port, in your router for the information to come
through.

Most applications have specific ports that need to be opened for them to work, for your PointOS
database that port is 1433.

Updating PointOS

You can use the PointOS Updater to check for the latest version of PointOS. Refer to “Check for
Update” on page 158 for more information.

If the Updater fails, you can download the latest version from the PointOS website and reinstall
the software. The reinstall will not uninstall SQL. You wiLL NOT lose any data.
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The following table outlines some common problems with PointOS and some possible solutions.

Problem Possible Solution
The system appearsto be | When the system isrunning slow there are several thingsyou can
running slow. do to speed it up.

» Compact the database. Refer to “ Compact Database” on
page 21 for more information.

» Archivecloseditemsand orders. Refer to “ Archive ltems’ on
page 156 and “ Archive Orders’ on page 156 for more infor-
mation.

» Cleanup unnecessary data. If your databaseisvery large, you
can remove data with the Database Cleanup tool. “ Database
Cleanup” on page 154 for more information.

* Reboot your computer

The system can be setup with auto maintenance to prevent future
slowdowns from happening. “ Database Setup” on page 40 for
more information.

Some of the pictureson the
screen do not appear to line

up.

If you are using Windows Vista, make sure your font DPI is set
to 96 DPI.

PointOSis only taking up
part of the screen.

The screen resolution must be set to 800 x 600. Refer to Win-
dows Help for more information.

Thetask bar is covering
some of the controls, like
music.

The Windows Task Bar should be set to auto hide. Refer to Win-
dows Help for more information.

| cannot back up the data-
base.

To run abackup of the database, you must be running the Server
portion of PointOS Professional. The backup can only be done
from the computer that holds the database you are trying to
backup. Refer to “Backup Database” on page 153 for more infor-
mation.

The cash drawer won't
pop.

First check your cables and then make sure your printer isturned
on, has paper, and aribbon or ink.

If the cash drawer still doesn’'t pop, the printer may not be setup
with the correct model. Refer to “ Station Settings’ on page 22
for more information on setting up the printer.
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Problem

Possible Solution

Thereceipt is not printing
correctly; the text is break-
ing to another line.

The print width might not be set correctly. Refer to “ Station Set-
tings’ on page 22 for more information.

Reports are taking avery
long time to run.

Some reports are going through alot of data, and do take avery
long time. This may be normal. However, you can speed this up
by archiving orders and items prior to running these reports.
Refer to “ Database Cleanup” on page 154, “ Archive Items’ on
page 156, and “Archive Orders’ on page 156 for more informa-
tion.

| need to recover from a
backup database.

To recover a backup database, go to the Manager Dashboard,
and choose Select Database.

When the system displays the database sel ection window, you
can choose the appropriate backup file. PointOS database files
end in .bak. Refer to “ Restore Database” on page 28 for more
information.

| want to move my data-
base to a new computer.

To move your database to a new computer, you will need to first
perform a database backup from the computer where the
database is located.

Then copy the .bak and .Idf files that are usually located in the
PointOS Database/Backup folder to your new computer using a
shared network driver, cd, or flash drive.

Once the database has been copied to the new computer, you will
use the Restore Database feature. Refer to “ Restore Database” on
page 28 for more information.

| have multiple stations
sharing one database, and |
cannot get them to recog-
nize the database when |
select it.

To setup a Windows network to be able to share a PointOS
database:

» Make sure all computers are on the same workgroup.

» Setup all the computers with the same login name and pass-
word and make sure those accounts have administrative
rights.

» Make sureyour antivirus program or firewall is not blocking
your computers from seeing SQL Server on the shared data-
base computer.

Refer to Windows Help for more information on setting up a
Windows network.
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